ROLL CALL

VERSION 12
# Table of Contents

## INSTALLING ROLL CALL
- Single User Installation ................................................................. 12
- Mac users from the CD ................................................................. 12
- Windows users from the CD ......................................................... 12
- Network Installation? ................................................................. 12
- Installing the Server ................................................................. 12
- Installing the Client ............................................................... 13
- Single User System ............................................................... 13
- Network Multi-User System .................................................... 14
- Single User System ............................................................... 15
- Network Multi-User System .................................................... 15

## GETTING STARTED
- Navigator ................................................................. 17
- Navigator Menu ............................................................... 17
- Top Menu ................................................................. 17
- To Do List ................................................................. 17
- Birthdays ................................................................. 17
- Visitors ................................................................. 18
- Icons ................................................................. 19
- Search/Summary Screens ....................................................... 20
- Customize ............................................................... 20
- Find By ................................................................. 21
- Add or Delete Records .......................................................... 21
- Print ................................................................. 21
- Organization Info ............................................................. 22
- License Number ............................................................. 22
- Preferences ............................................................. 22

## MAINTAINING PEOPLE INFORMATION
- Import People Information ......................................................... 26
- One Row per Family (standard) ................................................ 26
- One Row per Family (custom) ............................................... 27
- One Row per Person (standard) ............................................... 27
- One Row per Person (custom) ............................................... 27
- Import Process ............................................................... 27
- Enter a new Family ............................................................ 29
- Contact Information .......................................................... 30
- Address ................................................................. 30
- Pictures ................................................................. 31
- Phones ................................................................. 32
- Contributions .............................................................. 33
- Custom Fields ............................................................. 34
- Dates ................................................................. 35
- Groups ................................................................. 35
- Keywords .............................................................. 36
- Visit ................................................................. 37
- Comments ............................................................. 38
- Background Check .......................................................... 39
Letters .................................................................................................................................41
Attendance ..........................................................................................................................41
Add the Next Family Member ..........................................................................................42
Modify Family Relationships ..........................................................................................42
Marriage ..............................................................................................................................43
Divorce .................................................................................................................................46
Change HOF .........................................................................................................................47
Death ......................................................................................................................................47
To change the association: .................................................................................................47
To transfer the donations: .................................................................................................47
To move the deceased into a separate family: ...................................................................47
Delete People from the Database ....................................................................................48
Delete a person who has not made contributions .........................................................48
Delete a person who has made contributions ..................................................................49
Background Checks ..........................................................................................................50
Enter the Request & Results ............................................................................................50
Find/Research Background Checks ..................................................................................52
Visitations ............................................................................................................................52
Enter Visitations ................................................................................................................52
Find/Research Visitations .................................................................................................53
Confidential Comments ...................................................................................................54
Enter Confidential Comments .........................................................................................54
Find/Research Confidential Comments ............................................................................55
Look up Comments ...........................................................................................................55
FINDING PEOPLE
Search Profile Window .......................................................................................................56
Icon Bar ...............................................................................................................................56
Find By ...............................................................................................................................56
Results ...............................................................................................................................57
Add/Delete ..........................................................................................................................57
Customize Search Window ..............................................................................................57
Find Specific Records .......................................................................................................58
Find By Criteria ..................................................................................................................58
Search Window ................................................................................................................58
Query Editor .......................................................................................................................59
Tag People .........................................................................................................................60
RUNNING REPORTS
Report Selection Window .................................................................................................62
Criteria ...............................................................................................................................63
Who .................................................................................................................................63
What ...............................................................................................................................64
When ...............................................................................................................................64
View Records ....................................................................................................................64
Run the Report ..................................................................................................................65
Report Output ...................................................................................................................65
REPORTING ON PEOPLE
Report Window ..................................................................................................................67
Envelope Number Report .................................................................................................69
Family Report ...................................................................................................................70
Birthday Report .......................................................................................................................71
Anniversary Report ....................................................................................................................72
Significant Dates Report ............................................................................................................73
Confirm Data Report ..................................................................................................................75
Uninvolved Families Report ......................................................................................................76
Background Check Report .......................................................................................................77
Visitation Log ............................................................................................................................78
Visitation History .......................................................................................................................79
My Reports ..................................................................................................................................80

RECORDING ATTENDANCE
Worship Attendance ..................................................................................................................82
Create Service .............................................................................................................................82
Record Attendance .....................................................................................................................83
Find/Modify Attendance .............................................................................................................85
Group Attendance ......................................................................................................................85
Create Group ..............................................................................................................................85
Record Attendance .....................................................................................................................86
Find/Modify Attendance .............................................................................................................87
Attendance Reports ...................................................................................................................88
Attendance Summary ................................................................................................................88
Attendance by Person ................................................................................................................90
Attendance by Type ...................................................................................................................94
Attendance by Session ...............................................................................................................95
Absent/Present Report ...............................................................................................................96
Visitor Report .............................................................................................................................98

ENTERING CONTRIBUTIONS
Giving Funds ..............................................................................................................................99
Batches .......................................................................................................................................100
Check/Cash Contributions .......................................................................................................101
  Basic .......................................................................................................................................101
  Split .......................................................................................................................................103
  Connect to Pledge ................................................................................................................103
  Quid Pro Quo ........................................................................................................................104
Non-Cash/Property Gift Contributions .....................................................................................105
  Donation Type ....................................................................................................................105
  In Kind tab ........................................................................................................................106
  Non-Cash screen ................................................................................................................107
Check Reader ............................................................................................................................107
Import Contributions ...............................................................................................................108
Post a Batch ...............................................................................................................................109
Import deposit to QB or MYOB ..............................................................................................110
Batch Reports ..........................................................................................................................110
Deposit Slip ...............................................................................................................................111

LOOKING UP CONTRIBUTIONS
Search by Person .......................................................................................................................112
Find By ....................................................................................................................................112
  Query Editor ........................................................................................................................113
  Results ..................................................................................................................................113
Search by Batch .........................................................................................................................115
MODIFYING CONTRIBUTIONS
Open Batches .........................................................................................................................119
Add Contributions to Existing Batch ......................................................................................119
Correct a Contribution ............................................................................................................119
Posted Batches ........................................................................................................................120
Reverse the Batch ....................................................................................................................120
Correct the Contribution .........................................................................................................121
Re-post the Batch ....................................................................................................................121
Transfer Contributions .............................................................................................................121
A single contribution ................................................................................................................122
Multiple contributions ............................................................................................................122
Delete Contributions ................................................................................................................123

RECURRING DONATIONS
Recurring Donation Process ....................................................................................................125
Recurring Donation Preferences .............................................................................................125
Defaults ..................................................................................................................................125
Email notification ....................................................................................................................125
Find By ..................................................................................................................................126
Query ....................................................................................................................................126
Create Recurring Donation Profile ........................................................................................127
Posting the Recurring Donations .............................................................................................128
Automatically ........................................................................................................................128
Manual ..................................................................................................................................129
Stopping the Recurring Donation ............................................................................................129

CREATING CONTRIBUTION RECEIPTS (STATEMENTS)
Contribution Receipt Process ....................................................................................................130
Contribution Statement Formats ...............................................................................................130
Quarterly ..................................................................................................................................130
Quarterly Tabular ....................................................................................................................131
Annual ....................................................................................................................................131
Canadian .................................................................................................................................132
Individual Gift .......................................................................................................................132
Quarterly Statements ...............................................................................................................133
Criteria ..................................................................................................................................133
Details ....................................................................................................................................133
Print Options ..........................................................................................................................133
Customize ...............................................................................................................................134
Receipt Text .............................................................................................................................134
View People .............................................................................................................................134
Printing/emailing your receipt .................................................................................................136
Quarterly Tabular Statements ..................................................................................................137
Criteria ..................................................................................................................................137
Text .......................................................................................................................................137
Custom Options .....................................................................................................................137
View People .............................................................................................................................138
CREATING CONTRIBUTION REPORTS

Donor Detail Report ................................................................. 151
Donor Summary Report .............................................................. 154
Donor Summary by Fund ............................................................. 157
Donor Giving by Week, Month or Year ......................................... 158
Top Donors ............................................................................. 161
Donors over X Amount ............................................................... 163
Given X Times ......................................................................... 165
Given 0 Times ........................................................................... 166
First Time Givers ............................................................... 167
Fund Summary ....................................................................... 168
Fund Giving by Week, Month or Year ......................................... 169
Contribution Detail ................................................................. 171
Contribution Statistics .............................................................. 173
Batch Summary Report .............................................................. 174
Batch Detail Report ................................................................. 175

MAINTAINING PLEDGES

Pledge Fund ............................................................................. 177
Individual Pledges ................................................................... 178
Finding Pledges.................................................................179
Modify Pledge Information..................................................180
Changing the pledge information........................................180
Deleting a pledge fund.......................................................180
Deleting pledges...............................................................180
Pledge Progress Letter ........................................................181
Criteria ............................................................................181
Details ..............................................................................182
Print Options ....................................................................182
View People .....................................................................184
Letter Text ........................................................................184
Pledge Reports .................................................................185
Criteria ............................................................................185
Output window ..................................................................185
Pledge Status report ..........................................................186
Pledge Comparison report .................................................187
Pledge Fund Comparison report .........................................188
Pledge Giving report ........................................................189

MANAGING GROUPS
Group Hierarchy ...............................................................190
Group Custom Fields .......................................................190
Group custom fields .........................................................190
Group membership custom fields .......................................191
Add a Group .....................................................................191
Enter general information .................................................191
Add Members ....................................................................192
Create sessions ..................................................................193
Enter values for group custom information .........................193
Preferences ........................................................................194
Copy a Group ....................................................................194
Mass Enrollment ..................................................................195
Transfer members to a new group .......................................197
Graduation ........................................................................198
Graduation Profile ............................................................198
On Birthday ........................................................................198
Graduate Now .....................................................................199
Modify Group Information ...............................................200
Delete Groups ....................................................................200

Group Reports
Attendance Summary ........................................................202
Absent/Present Report .......................................................204
Attendance by Group .........................................................205
Attendance by Session ......................................................207
Check In Roster ...............................................................208
Attendance Roster ............................................................208
Sign In Roster .....................................................................208
Check In Log .......................................................................211
Group Members ..............................................................212
Background Checks for Groups ..........................................215
Determine your Audience .................................................................221
   People ............................................................................................221
   Donors ..........................................................................................221
   Pledgers .......................................................................................223
   Group Members ...........................................................................224
   Attendees .....................................................................................224
Letters .............................................................................................225
   Addressing Options ......................................................................226
   Word Processor ............................................................................226
   Add Date/Subject (without creating a letter) .................................227
   Insert Data ...................................................................................228
   Templates .....................................................................................228
Email ...............................................................................................229
   My Email .....................................................................................229
   Compose Email ..........................................................................230
Text .................................................................................................232
   My Email .....................................................................................232
   Phone information .......................................................................233
   Sending the Text ..........................................................................233
Labels ..............................................................................................234
   Criteria ........................................................................................234
   Options .......................................................................................235
   Customize ....................................................................................235
   View People ...............................................................................236
Envelopes .......................................................................................236
PRINTING DIRECTORIES
Custom Directory ...........................................................................238
   Options .......................................................................................238
   General .......................................................................................238
   Custom .......................................................................................239
   Cover ..........................................................................................239
   Font .............................................................................................239
   Output ........................................................................................240
Standard Directory ..........................................................................241
   Select the people using associations ............................................241
   Options .......................................................................................241
   General: Selecting the fields and format that will be displayed ....242
   Custom .......................................................................................243
   Cover ..........................................................................................243
   Font .............................................................................................243
   Output ........................................................................................243
Classic Directory ............................................................................244
   Select the people using associations ............................................244
   Select the people using associations ............................................246
Group Directory ..............................................................................248
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Picture Directory</td>
<td>250</td>
</tr>
<tr>
<td>Working with Lifetouch</td>
<td>251</td>
</tr>
<tr>
<td>Exporting to Lifetouch</td>
<td>251</td>
</tr>
<tr>
<td>Importing from Lifetouch</td>
<td>254</td>
</tr>
<tr>
<td><strong>USING THE QUERY EDITOR</strong></td>
<td></td>
</tr>
<tr>
<td>Query Editor uses</td>
<td>255</td>
</tr>
<tr>
<td>Table Layouts</td>
<td>255</td>
</tr>
<tr>
<td>Address</td>
<td>255</td>
</tr>
<tr>
<td>People</td>
<td>255</td>
</tr>
<tr>
<td>Donations</td>
<td>255</td>
</tr>
<tr>
<td>Designation</td>
<td>255</td>
</tr>
<tr>
<td>Non-Cash Gift</td>
<td>255</td>
</tr>
<tr>
<td>Recurring Donation</td>
<td>255</td>
</tr>
<tr>
<td>Pledge</td>
<td>256</td>
</tr>
<tr>
<td>Groups</td>
<td>256</td>
</tr>
<tr>
<td>Group Members</td>
<td>256</td>
</tr>
<tr>
<td>Sessions</td>
<td>256</td>
</tr>
<tr>
<td>Attendance Summary</td>
<td>256</td>
</tr>
<tr>
<td>Attendance</td>
<td>256</td>
</tr>
<tr>
<td>Current selection</td>
<td>257</td>
</tr>
<tr>
<td><strong>Basic Query</strong></td>
<td>257</td>
</tr>
<tr>
<td>Multiple criteria query</td>
<td>258</td>
</tr>
<tr>
<td>Associations query</td>
<td>259</td>
</tr>
<tr>
<td>Groups query</td>
<td>259</td>
</tr>
<tr>
<td>An either/or criteria</td>
<td>260</td>
</tr>
<tr>
<td>Date range criteria</td>
<td>260</td>
</tr>
<tr>
<td><strong>Complex Queries</strong></td>
<td>262</td>
</tr>
<tr>
<td>Association plus other criteria</td>
<td>262</td>
</tr>
<tr>
<td>Query with a combination of AND and OR</td>
<td>264</td>
</tr>
<tr>
<td>Query using Except</td>
<td>265</td>
</tr>
<tr>
<td><strong>AND, OR and EXCEPT</strong></td>
<td>267</td>
</tr>
<tr>
<td>Save a Query</td>
<td>267</td>
</tr>
<tr>
<td><strong>Special Query</strong></td>
<td>267</td>
</tr>
<tr>
<td>Change to Selection to Head of family</td>
<td>267</td>
</tr>
<tr>
<td>Change Selection to Mothers</td>
<td>268</td>
</tr>
<tr>
<td>Change Selection to Fathers</td>
<td>268</td>
</tr>
<tr>
<td>Change Selection to Adult and all Children</td>
<td>268</td>
</tr>
<tr>
<td>Find Single Parents</td>
<td>268</td>
</tr>
<tr>
<td>Find Keywords</td>
<td>268</td>
</tr>
<tr>
<td>Find possible blended families</td>
<td>268</td>
</tr>
<tr>
<td>Find people with picture</td>
<td>268</td>
</tr>
<tr>
<td>Find families with a picture</td>
<td>269</td>
</tr>
<tr>
<td>Find possible uninvolved families</td>
<td>269</td>
</tr>
<tr>
<td><strong>CREATING CUSTOM REPORTS</strong></td>
<td></td>
</tr>
<tr>
<td>Create a custom report</td>
<td>270</td>
</tr>
<tr>
<td>Base Table</td>
<td>271</td>
</tr>
<tr>
<td>Data for the Report</td>
<td>271</td>
</tr>
<tr>
<td>Select columns for the report</td>
<td>271</td>
</tr>
<tr>
<td>Calculated columns</td>
<td>272</td>
</tr>
</tbody>
</table>
APPENDIX A - TABLE LAYOUTS

Address Table .......................................................................................................................309
People Table ..........................................................................................................................309
Group Table ..........................................................................................................................310
Group Membership Table ....................................................................................................310
Donations Table ...................................................................................................................311
Designations Table ..............................................................................................................311
Attendance Table ..................................................................................................................311
Special Columns ...................................................................................................................312
INSTALLING ROLL CALL

Single User Installation

The single user version of Roll Call allows one user, on one computer to access Roll Call. For the single user installation, use the following instructions.

Mac users from the CD

To install Roll Call from the CD, simply place the CD in your CD drive. A By the Book disk image will be displayed on your desktop. Double click on that image. There will be three Roll Call files: 1) Roll Call 2) Roll Call Client and 3) Roll Call Server. Double click on the Roll Call file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Windows users from the CD

To install Roll Call from the CD, simply place the CD in your CD drive. There will be three Roll Call installation files: 1) Roll Call 2) Roll Call Client and 3) Roll Call Server. Double click on the Roll Call file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, you will have a Roll Call icon on your desktop. To use Roll Call, double click on that icon.

From the download file

To install Roll Call from the downloaded file, double click on the Roll Call installer file you downloaded. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, you will have a Roll Call icon on your desktop. To use Roll Call, double click on that icon.

Network Installation?

A network installation of Roll Call allows multiple people to access the data. If you have a multi-user license, multiple users can access the data simultaneously. For example, if you have purchased a 3 user license, 3 users may access the database at the same time. If you have purchased a single user license, you may still install the network version, but only one person may access the data at a time.

First, you must decide which computer will house the database. That computer will be your server. The computer you choose as your server should not be used for many other applications. For example, if your secretary’s computer is used for creating the bulletin, writing letters and accounting, you probably wouldn’t want her computer to be your Roll Call Server. Since the server needs to be running at all times, it would slow down her other work.

Next, decide who will need to use Roll Call. Each of those users will need Roll Call Client installed on their computer.

Installing the Server

To install Roll Call Server from the CD, simply place the CD in your CD drive. For Windows users there will be three Roll Call files: 1) Roll Call 2) Roll Call Client and 3) Roll Call Server. For Mac users the By the Book disk image will be displayed on your
desktop. Double click on that image. Next, double click on the Roll Call Server file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

To install Roll Call Server from the downloaded file, double click on the Roll Call Server installation file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, there will be a Roll Call Server icon on the desktop. To start Roll Call Server, double click on the icon. The Roll Call Server window will be displayed. For users to work in Roll Call the Server must be running.

**Installing the Client**

To install Roll Call Client from the CD, simply place the CD in your CD drive. For Windows users there will be three Roll Call files: 1)Roll Call 2)Roll Call Client and 3)Roll Call Server. For Mac users, a By the Book disk image will be displayed on the desktop. Double click on that image. Next, double click on the Roll Call Client file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

To install Roll Call Client from the downloaded file, double click on the Roll Call Client installation file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, there will be a Roll Call Client icon on the desktop. To start Roll Call, double click on the icon. If this is the first time this client has connected to the Roll Call Server, you may get a -10002 error. If this happens, just click through the message. Then you will get a window that has 3 tabs: Recent, Available and Custom. Click on the Available tab. You should see Roll Call listed there. Highlight it and click OPEN.

**Upgrade from version 10.0.18 or later**

**Single User System**

Before upgrading your Roll Call system, make sure you have a backup of your data files. To create a back up:

1. Determine the location of your data file by selecting Help> About Roll Call from the main menu from Windows, and Roll Call> About Roll Call on Mac. Look under the Data file Location and note the path and name of the file. For example, C:\Program Files\BytheBook\RollCall\Data\RollCall.4dd on Windows, or HD:Applications/RollCall /RollCall.4dd on Mac
2. Close the Roll Call program
3. Copy your data file to a different location such as a CD or memory stick. On Mac, your data file may be one file ending in *.data or it may be two files, one ending in *.4dd and the other *.4dr.

Next, install version 11 from the CD or from the download file. Once version 11 is installed, your data needs to be converted to the new version. When you are ready to convert, copy your backup data file to the following location:

Windows  C:\BytheBook\RollCall\Database
Mac    HD:Applications\RollCall\
To begin the conversion, connect Roll Call version 11 to your data file. Double click on the Roll Call v11 icon, then hold down the ALT/OPTION key. Choose the option for opening a different data file. A data dialog box will be displayed. Navigate to your data file (from the previous step), highlight the file, and press OPEN. Once the conversion process is complete, you will be at the version 11 main menu.

Next, you'll need to enter your new license number. From the main Roll Call screen, go to File>Enter License. Type in the license number found in the upper right corner of your invoice, press the tab key. The number of users and people records allowed will be displayed.

Once you review your data and everything looks fine, uninstall your earlier version of Roll Call.

**Network Multi-User System**

Before upgrading your Roll Call system, make sure you have a backup of your data files. To create a backup:

1. Determine the location of your data file by selecting Help>About Roll Call from the main menu in Windows, or Roll Call>About Roll Call on the Mac. Look under the Data file Location and note the path and name of the file. For example C:\Program Files\BytheBook\RollCall_Server\Data\RollCall.4dd on Windows or HD:Applications/RollCallserver/RollCall.4dd on Mac
2. Close the Roll Call program
3. Copy your data file to a different location such as a CD or memory stick. On Windows, your data file has an extension of 4dd. On Mac, your data file will have an extension of *.data or *.4dd depending on your version.

Next, install Roll Call Server version 11 from the CD or from the server download file. Next, install Roll Call Client on each of the workstations that need to access Roll Call. Roll Call Client needs to be upgraded with this new version.

Once version 11 is installed, your data needs to be converted to the new version. When you are ready to convert, copy your backup data file to the following location on your server:

Windows  C:\BytheBook\RollCall_Server\n
Mac   HD:Applications\RollCall Server\n
Next, connect Roll Call Server version 11 to your data file. Double click on the Roll Call Server icon, then immediately press the ALT key. Choose the option for opening a different data file. A data dialog box will be displayed. Navigate to your data file (from the previous step), highlight the file, and press OPEN. Next, start Roll Call Client from a workstation and connect to Roll Call. This will begin the conversion process.

Next, you'll need to enter your new license number. From the main Roll Call screen, go to File>Enter License. Type in the license number found in the upper right corner of your invoice, press the tab key. The number of users and people records allowed will be displayed.
Upgrade from version 10.0.17 or earlier

**Single User System**

Before upgrading your Roll Call system, make sure you have a backup of your data files. To create a backup:

1. Determine the location of your data file by selecting Help> About Roll Call from the main menu on Windows, or Roll Call> About Roll Call on Mac. Look under the Data file Location and note the path and name of the file. For example C:\Program Files\BytheBook\RollCall8\Data\yourdatafile.4dd
2. Close the Roll Call program
3. Copy your data file to a different location such as a CD or memory stick. On Mac, your data file may be one file ending in *.data or it may be two files, one ending in *.4dd and the other *.4dr.

Next, install version 11 from the CD or from the download file. Once version 11 is installed, your data needs to be converted to the new version. When you are ready to convert, copy your backup data file to the following location:

Windows C:\BytheBook\RollCall\Database
Mac HD:Applications\RollCall\ Database

If you had imported pictures into Roll Call, you’ll also need to move all the images from the old image folder to the new image folder:

Windows C:\BytheBook\RollCall\Images\ Mac HD:Applications\RollCall\Images

To begin the conversion, connect Roll Call version 11 to your data file. Double click on the Roll Call v10 icon, then hold down the ALT/OPTION key. Choose the option for opening a different data file. A data dialog box will be displayed. Navigate to your data file (from the previous step), highlight the file, and press OPEN. Once the conversion process is complete, you will be at the version 11 main menu.

Next, you’ll need to enter your new license number. From the main Roll Call screen, go to File> Enter License. Type in the license number found in the upper right corner of your invoice, press the tab key. The number of users and people records allowed will be displayed.

Once you review your data and everything looks fine, uninstall your earlier version of Roll Call.

**Network Multi-User System**

Before upgrading your Roll Call system, make sure you have a backup of your data files. To create a backup:

1. Determine the location of your data file by selecting Help> About Roll Call from the main menu on Windows, or Roll Call> About Roll Call on Mac. Look under the Data file Location and note the path and name of the file. For example C:\Program Files\BytheBook\RollCall_Server\Data\yourdatafile.4dd
2. Close the Roll Call program
3. Copy your data file to a different location such as a CD or memory stick. On Windows, your data file has an extension of .4dd. On Mac, your data file will have an extension of *.data or *.4dd depending on your version.

Next, install Roll Call Server version 11 from the CD or from the server download file. Next, install Roll Call Client on each of the workstations that need to access Roll Call. Roll Call Client needs to be upgraded with this new version.

Once version 11 is installed, your data needs to be converted to the new version. When you are ready to convert, copy your backup data file to the following location on your server:

Windows    C:\BytheBook\RollCall_Server\  
Mac   HD:Applications\RollCall Server\  

If you have pictures in Roll Call, you’ll need to move all the images from the old image folder to the new image folder:

Windows    C:\BytheBook\RollCall_Server\Images\  
Mac   HD:Applications\RollCall_Server\Images  

Next, connect Roll Call Server version 11 to your data file. Double click on the Roll Call Server icon, then immediately press the ALT key. Choose the option for opening a different data file. A data dialog box will be displayed. Navigate to your data file (from the previous step), highlight the file, and press OPEN. Next, start Roll Call Client from a workstation and connect to Roll Call. This will begin the conversion process.

Next, you’ll need to enter your new license number. From the main Roll Call screen, go to File>Enter License. Type in the license number found in the upper right corner of your invoice, press the tab key. The number of users and people records allowed will be displayed.
GETTING STARTED

Navigator
When you start Roll Call, the Roll Call home screen will be displayed in the Navigator Window. The main sections of the navigator are discussed below:

Navigator Menu
The main menu items for Roll Call are found on the left side. If there is an arrow, pointing to the right, there are sub menus underneath that item. Click on the arrow to expand that menu. If an arrow is pointed down, click on it to collapse the menu items. If there is no arrow in front of the menu item, click on it, to perform that function.

Top Menu
Additional menu items can be found across the top of the Navigator Window. These menu items are typically administrative type items, for example: backups, maintenance, and imports. Click on the name of the menu, then move the mouse and select.

To Do List
Each Roll Call user will have a To-Do list displayed on the Home page. To add an item to your To-Do list, click on the plus sign (+) in the lower corner of the area. A window will be displayed for you to enter the task. To mark an item as completed, click on the box in front of the item. To delete items from the list, highlight one or more items, then click on the minus (-) sign in the lower part of the area. To print your To-Do list, click on the printer icon.

Birthdays
The birthday section of the Home page will show you who has a birthday this week, next week, this month, or next month. Use the drop down to choose which time frame you are interested in.

Each Roll Call user, can set their own preferences for this birthday list. For example, the children’s ministry leader may only want to see kids who are in the Sunday school classes.
in her list. While a deacon, who is the shepherd for several families, would only want to see the birthdays for the people he is responsible for. To set this preference, click on the Pref icon underneath the birthday area.

Choose the time frame for birthday list.

Choose activity date.

Visitors
The visitor section outlines anyone with an association of “Visitor”, who attended or gave last week. To set the preferences for which attendance or contributions to consider, click on the Preferences icon in the lower right corner. Double click on the visitor’s name to enter their record.

Church Logo
If you would like to display your church logo on the Home page instead of the Roll Call logo, select File>Import Logo from the top menu. A “look in” window will be displayed. Navigate to your image file and open it. For the best network performance, this should be a small file.
Icons

There is a standard set of icons you will see on each main Roll Call screen. They allow you to perform many common functions such as printing, querying, saving a set, etc. These icons are listed below.

The **printer** icon allows you to print the list that is displayed on your screen. For example, if you were in the people search screen you would get a list of all the people that are in your current list.

The **email** icon allows you to send an email or text all the people in the current list.

The **write a letter** icon allows you write a mail merge letter to the people in the current list. If you are in an individual’s record, you can write a letter to them.

The **label** icon allows you to print mailing labels (Avery 8160) for the people in your list.

The **spreadsheet** icon allows you to put the information displayed on your screen in a spreadsheet program.

The **show all** icon displays all records when pressed.

The **sort records** icon allows you to sort the information in your list by any of the fields in your list.

The **search records** icon allows you to perform a query of the database.

The **special search** icon allows you to perform a predefined query, like finding the heads of the families listed.

The **compare sets** icon allows you to perform a comparison of two results sets. For example, who are my donors that are also in a small group.

The **save set** icon allows you to save the results of a query.

The **get set** icon allows you to retrieve the results of a previously saved set.

The **subset** icon allows you reduce your list to only those records that are highlighted.
The **preference** icon allows you to set user specific criteria based on the window you are currently in. From the search windows, the preference icon will allow you to choose which columns to display.

**Search/Summary Screens**

Each of the main functional areas of Roll Call will have a **Search** menu item. These **Search** or **Summary** screens can be used to find records, correspond with people and add new records.

**Customize**

Each Roll Call user can choose which fields they’d like displayed on a **Search** screen. To select the columns, do the following:

1. Click on the **Search** menu item for the area you are interested in.
2. Click on the **Preferences** icon.
3. Move the columns you’d like displayed from the left side to the right side. You can either **drag and drop**, double click or highlight the field and click the arrow to the right.
4. To modify the ordering of these columns, **drag** the field name to the position in the list.
5. To reduce your list to display family units, rather than individuals, click **Display Families**.
Find By
When you first select a Search menu item, all records will be displayed in the window. To find specific records, you can use the Find By option. Use the Find By drop down to select the criteria you are interested in. Next, enter the value for the criteria you are searching for.

Add or Delete Records
Notice the plus and minus buttons (+/-) in the lower left of the Search window. Use these buttons to add new records. Or highlight one or more records and click the minus sign to delete those records.

Print
To print the information that is displayed in your Search window, simply click on the PRINT icon. A report will be printed that contains that same information.
**Organization Info**

When you first begin using Roll Call, you will want to set up your Church or Ministry information. To do this, click *Organization* from the *Navigator* menu on the left. Enter the following information, then press SAVE:

1. **Organization Name** – Enter the name of the church or organization.
2. **Address** – Enter the street address for the church or organization.
3. **More Address** – Enter more address info, if necessary.
4. **City** – Enter the city where the church or organization is located.
5. **State** – Enter the state where the church or organization is located.
6. **Zip Code** – Enter the postal code for the church or organization.
7. **Country** – If not in the US, enter your country here.
8. **Telephone 1** – Enter the main phone number here for the church or organization.
9. **Telephone 2** – Enter the secondary phone number here.
10. **Tax ID** – Enter your tax id. This is used on Canadian donation receipts.
11. **Bank account** – Enter the bank account name for the church or organization.

12. **Weekly budget** – Enter the weekly budget for the church or organization.
13. **Church email** – Enter the church or organization email address.
14. **Church website** – Enter the web address for the church or organization.

**License Number**

When you purchase Roll Call, you will be given a *License Number*. You will need to enter that number into Roll Call. To do that select File>Enter License from the top menu. Enter your number and press the tab key. The number of users and number of allowed records will be filled in for you. Click OK to save the number.

**Preferences**

The *preferences* area allows you to define certain characteristics of Roll Call functionality. For example, do you require multi-campus functionality, do you wish to default the address to the same city, state and zip as the church, etc... To modify the *preferences*, go to the top menu and select Edit>Preferences (on Windows) or select RollCall>Preferences (on Mac).

**People Preferences**

The following information can be set under the *People* tab of the *Preferences* screen.

1. **Optional Mailing Name Autofill** - Mark yes if you would like the first and last name of
the person to be automatically filled into the Optional Mailing Name field.

2. **Last Comm Date** - Choose which name you’d like for the date field underneath Wedding date.

3. **Family Numbers** - Mark if you’d like family numbers to be automatically or manually generated.

4. **Family Position** - Mark at what ages children should change from Child to Youth and from Youth to Adult. Do you want the system to automatically change this position on their birthdate?

5. **Security Clearance Level** - Mark if you’d like to turn off this field.

6. **Multiple Campus** - Does your church have multiple campuses? If so, mark yes here to add a campus field to the people and group screen.

7. **Custom Fields** - Use the custom tab under the People tab to define the field, checkbox and date custom field names. These field names will be used in the People screen under the custom tab.

---

**Address Preferences**

The following information can be set under the Address tab of the Preferences screen.

1. **Default Address** - Mark if you would like the city, state or zip from the church address to be the default city, state and zip for the people you enter into the system.

2. **Postal preferred** - If you’d like to use postal preferred address format on labels and receipts mark this checkbox.

3. **Increase state field size** - If you’d like to increase your state field size to handle foreign counties mark this checkbox.

4. **Country** - Mark if you’d like to display a country field in the People screen.

5. **Web Maps** - If you’d like to use a different web map, enter the URL and syntax required.

6. **Address Validation** - If you’d like Roll Call to validate address info using SmartyStreets, select this option, and go to www.smartystreets.com to sign up.

7. **SmartyStreets key** - Input your SmartyStreets key code here.

---

Choose the options that apply to your church.

Click on Custom to define the People custom field.
**Setting up Smartystreets.com for Address Validation**
2. Create your login account. Your first 250 address validations are free.
3. Under Live Address, click on API keys.
4. Under Secret Pair Keys, press ADD.
5. Copy and paste Auth ID. On Mac go to Roll Call>Preferences>Addresses tab. In Windows go to File>Preferences>Addresses tab.
6. Copy and paste "Auth token" by pressing `raw`. On Mac, go to Roll Call Preferences>Addresses tab. Paste this where it says “SmartyStreets Key”. In Windows, go to File>Preferences>Addresses tab and paste this where it says “SmartyStreets Key”
7. Make sure address validation is turned on. On Mac, go to Roll Call>Preferences>Address. In Windows, go to File>Preferences>Addresses tab

**Contribution Preferences**
The following information can be set under the Contribution tab of the Preferences screen.
1. *Default Designation* - Enter the default fund name for entering contributions.
2. *Pledges* - Select which pledges you’d like to see on the donation entry screen.
3. *Connect Pledges* - Indicate if you want to connect contributions to incomplete pledges or just the current pledge/
4. *Print Receipt* - Indicate if you’d like to print a donation receipt immediately after entering a contribution.
5. *Sort order* - Select the sort order of the Batch Detail report.
6. *How to denote checks* - If you need to denote your checks with a special of ‘cheque’, rather than ‘check’, write it in here.
Enter your default fund name.

Indicate how you’d like to handle pledges.

**Attendance Preferences**

Under *attendance preferences* you can select the default information that will be included on the barcode badges used for child check-in.

**Group Custom and Member Custom Preferences**

The *group custom* and *member custom preferences* allow you to set up templates for certain group types. For example if you have a group type of “small group” and you want to set up custom fields for every group that is a small group, use these fields.

In our small group example, let’s say we want to track what they are studying and if they are accepting new members. These fields are considered group custom fields because that is information about the group as a whole. If we also want to track for every member of a small group, their Tshirt size and Bible Knowledge Level, these would be considered member custom fields.

Select the *Group Type* that you are creating the template for.

Enter the field names you want for each of your “small groups”.

Enter the custom field names you want for each of your small group members.
Import People Information

When you begin using Roll Call, you may wish to import your existing contacts into the database. Roll Call allows you to import people contact information and some custom fields from a *tab delimited text file* (.txt). If you have the information in Excel, you can create the *tab delimited file*, by saving as “tab delimited text file”.

There are four file variations that can be used for the import:

**One Row per Family (standard)**

This format assumes that all the information on a single line is for one family. The data must be in the following order:

1. Family Last Name
2. Head’s First Name
3. Gender
4. Association
5. Cell Phone
6. Work Phone
7. Email
8. Spouse Last Name
9. Spouse First Name
10. Spouse Gender
11. Spouse Cell
12. Spouse Work Phone
13. Spouse Email
14. Home Phone 1
15. Home Phone 2
16. Address 1
17. Address 2
18. City
19. State
20. Postal Code
21. Child 1 First Name
22. Child 1 Gender
23. Child 1 Birth date
24. Child 2 First Name
25. Child 2 Gender
26. Child 2 Birth date
27. Child 3 First Name
28. Child 3 Gender
29. Child 3 Birth date
30. Child 4 First Name
31. Child 4 Gender
32. Child 4 Birth date
33. Child 5 First Name
34. Child 5 Gender
35. Child 5 Birth date
One Row per Family (custom)

This format allows you to import the same information (names, children, address, city state, zip, gender and birthdates) but the order does not have to be exact. For example, if you don’t have a second home phone, you don’t need to leave a blank column for that field. You will be able to tell Roll Call which data is in which column.

One Row per Person (standard)

In the one row per person format, each row in the spreadsheet represents an individual. Roll Call will pull people together based on matches in the address field. The first person it encounters with an address will be marked as the head of family.

This file type requires the data to be in this exact order. If you do not have data for a column, leave that column blank.
1. Title (ex. Mr., Mrs., Rev etc.)
2. Last Name
3. First Name
4. Nick Name
5. Suffix (ex. Jr., Sr.)
6. Gender (Male or Female)
7. Family Position (Husband, Wife, Youth, Child, Adult or Other)
8. Marital Status
9. Association (ex. Member, Regular Attender, Visitor)
10. Email
11. Home Phone 1
12. Home Phone 2
13. Address 1
14. Address 2
15. City
16. State (2 character abbreviation)
17. Postal Code
18. Birth Date
19. Cell Phone
20. Work Phone

One Row per Person (custom)

In the one row per person format, each row in the spreadsheet represents an individual. Roll Call will pull people together based on matches in the address field. The first person it encounters with an address will be marked as the head of family.

In the custom format, the columns can be in any order you choose. This format also allows you to import custom fields. As part of the import process you will be able to define which data belongs to which fields.

Import Process

Once you have created the file that will be imported, do the following to bring the data into Roll Call.
1. Expand the People menu on the left side.
2. Click on Import People (You can also select File>Import People from the top menu).
3. From the window that is displayed, select your file format type, click NEXT.
4. From this window, select your default Association and default Family Position. These fields are required, so if you don’t have a value in the record, Roll Call will use the default value to create the record in Roll Call.
5. Indicate which row the data starts. For example if you have titles in row 1, the data would start on line 2.

6. Click LOAD FILE. Navigate to your text file and open it. Your data will be displayed in a spreadsheet fashion in the lower section of the window.

7. If you selected a custom file format, you will need to use the drop down box at the top of each column to define the data represented in that column. If you do not want to import the data in a column, leave the selection as SKIP.
Enter a new Family

To enter people information into Roll Call using the Add a Family screen you can do either of the following:
1. From the Search Profiles (under People), click on the plus (+) sign in the lower left.
2. OR, Open up the People menu (left sidebar) and click Add a Family.

You are now in the Add Person screen. If you are entering a new family, enter the person who will be marked as Head of Family first. When you first come into the form, you’ll be in the Family Position field. Based on your selection here, the Title, Gender and Marital Status can be filled in.
Contact Information

Once you’ve entered the Family Position, you can tab through each of the fields on this main page. Enter the following information:

1. **First Name** - enter the person’s full first name.
2. **Nickname** - the nickname will default to the value entered for the first name. You can change this to the nickname if it is different than the first name.
3. **Middle Name** – enter the middle name. This field is not required.
4. **Last Name** – enter the last name. This field is required. If you are entering a business, enter the business name in the last name field.
5. **Suffix** - enter the suffix Jr., Sr., etc if applicable.
6. **Spouse** - if the person you are entering is married, you can enter the spouse’s name here.
7. **Association** – enter how this person is involved in the church. Are they a Member, Regular Attender, Visitor, etc.
8. **Birth Date** - enter the full birth date for the person.
9. **Primary & Alt Phones** - enter the phone numbers for the family here.
10. **Unlisted** - if the family doesn’t want their phone numbers listed in directory check here.
11. **Head of Family** – this box will be checked for the head of family. Each family needs one and only one head.
12. **Personal Email** – an email address for this person.
13. **Envelope Number** – you may enter an envelope numbers here, or use the assign envelope number option under the Bulk Changes menu to assign numbers en masse.
14. **Family Number** – if you selected “automatic” from preferences, this number will be assigned by Roll Call. Otherwise, you may assign a family number manually.
15. **Badge No.** - if the family position is child, a badge number will be assigned. You may enter a different number if you’d like.
16. **Barcode No.** – the barcode number is used to identify individuals and families for child check-in. This number is automatically assigned by Roll Call, unless you have the preference set to manually assign the number.
17. **Person No.** - This is an automatic internally assigned number that identifies a person and cannot be modified.

Address

Next, we’ll move down to the Address/Pictures tab on the People screen. Notice there are three tabs underneath Address. You can now click on the tab to enter Primary Address, Alternate Address and Notes. The Primary address is the families main address. The Alternate address if for folks who live in a different part of the country for part of the year. The notes section can be used to enter driving directions.

Enter the following information on the Primary address tab:

1. **Optional Mailing Name** - The name entered here will be used as the mailing name on all correspondence and labels. For example, if you have a husband and wife Jim & Sue Smith, the default mailing label would be Jim & Sue Smith OR Mr. & Mrs. Smith. However, if you entered “The Smith Family” as the optional mailing name, the letters, labels and receipts would be addressed to “The Smith Family”.
2. **Address, City, State and Zip**.
3. **Country** – if you have the preference turned on for country there will be a country field displayed here.
4. **Shepherd Area** – if your church assigns deacons, congregational care pastors or other lay people to come along side families, you may indicate that here.
5. **Family Email** – an email address that can be used to send emails to the entire family.
6. **Bad Address** – if you’ve had mail returned, so you know it is an invalid mailing address, you can mark the box for “bad address”.

7. **Do not send mail** – if someone has requested that you not send them mail, mark this box.

8. **Unlisted Address** – if someone has requested that their address is not published, mark this box.

---

If you need to enter a secondary or alternate address, click on the ALT Address tab. Enter the following information:

1. **Address** – the street address for the alternate address.
2. **More Address** – the address line 2.
3. **City, State and Zip** of the alternate address.
4. **Country** – if you have the preferences to display country, you can enter the country here.
5. **Phones** – enter the home phone numbers for the alternate location.
6. **Effective Month & Days** – enter the start date when this address takes effective.
7. **Ends Month & Day** – enter the moth and day that this address should no longer be used.

**Notes on Address**:
To take additional notes on the address, use this tab. This area also records latitude and longitude information gathered from using the address validation system in Roll Call. For more info on that, see the chapter on *Getting Started* and read up on “Address Preferences”.

If you’d like directions to an address, click on the WEB MAP button on the bottom of the page. If you’d like to copy the address onto the clip board to paste in another application, click COPY ADDRESS.

**Pictures**
You can pull in *family pictures* and/or *individual pictures* into Roll Call. Click on the *Address/Pictures* tab. Notice the two tabs on the right side for Picture and Family Picture.

The individual picture should be a portrait picture. To pull in the individual picture do the following:
Click on the tab for the type of picture you are bringing in.

To navigate to the image file, click on the plus sign.

1. Make sure you are anchored on the Picture tab (click on the word Picture).
2. Click on the plus sign (+) in the lower left.
3. Navigate to your image file and click OPEN.

The family picture should be in landscape. To pull in the family picture do the following
1. Make sure you are anchored on the Family Picture tab (click on the word Family Picture).
2. Click on the plus sign (+) in the lower left.
3. Navigate to your image file and click OPEN.

Phones
To enter an individual’s phone numbers, click on the Phones tab. Enter the following information:

Click on Phones tab.

Enter an individual’s phone number.

Click to add additional phone numbers.
1. **Work Phone & Extension** – enter the person’s work number.
2. **Cell Phone** – enter the cell phone number for this person.
3. **Pager** – enter a pager number for this person if they have one.
4. **Fax** – enter a fax number for this individual.

If an individual has multiple cell numbers or emergency numbers or additional phone numbers you’d like to record, use the **Additional Phones** section to enter these numbers.

To enter these numbers, do the following:
1. Click the **plus** sign (+) in the lower left.
2. Enter the **Phone Number**.
3. Enter an **Extension** if applicable.
4. Select the **Description** of the phone from the drop down, or enter a new one.

**Contributions**

The **Contributions** tab in the **People** screen allows you to view giving and pledge history, whether or not they have a **bank account** tied to Roll Call, their settings on filing individually and whether or not they want their **statement emailed** to them, as well as their first and last donation dates.

1. To view their giving history select the **Contributions** tab from their profile. You’ll have the option to view **Summary by Year, Month, Week or Overall**. To learn how to transfer donations from this area, see the chapter on **Modifying Contributions**.
2. To view **pledge** history, go to the **Contributions** tab under a person’s profile and select the **Pledges** tab.
3. To view **bank account** information, go to the **Contributions** tab under a person’s profile, and select **Account**. To add or delete an account, select the **plus** or **minus** sign. Adding an **account** typically is done by using a **check reader** and sliding the check through the **check reader**. The **check reader** will then have you pull up the **last name** of the person who the account is assigned to, and then you select it. To delete, simply highlight the account and select the **minus** sign.
4. The **Settings** tab allows you to checkmark the **file individually** option, and/or the **email receipt** option. To set these, go to the **Contributions** tab under a person’s profile, and click on **Settings**.
**Custom Fields**

The *custom fields* in the **People** screen allows you to track information about a person that we don’t have as a standard field in Roll Call. The following are all good examples of custom fields that can be set up in Roll Call: a person’s occupation, whether or not they want to receive emails or a baptism date.

To define the *custom fields* that you will track for each person, do the following:

1. Click on the *Custom* tab.
example is this an emergency number, secondary cell, etc.

2. Click on the CHANGE TITLES button.
3. Select the type of field you are defining… field (text), check box (yes or no) or dates.
4. Name the field.

To enter the data for a person, do the following:
1. Click on the Custom tab.
2. Click on the sub tab for either Custom Fields or Custom Check Box.
3. Enter the values applicable for this person.

**Dates**

The *Dates* tab can be used to enter the *Anniversary date* for married couples as well as custom dates that you define. See the *Custom Field* section for instructions on defining date custom fields.

This section can also be used to enter *Significant Dates*. *Significant Dates* are events that happen to an individual that you may wish to track so that you can follow up with this person on the anniversary of the event. Good examples of significant dates would be the death of a family member or diagnosis of cancer.

To enter significant dates into the system, do the following:
1. Click on the *Dates* custom tab
2. On the right portion of the **tab**, click on the *plus* sign (+).
3. Enter the *Date* of the event
4. Enter the description of the *Significant Date*.

**Groups**

If you have groups or classes already set up in Roll Call, you can enroll a person into a group/class from the People Screen.
Click on the **Groups** tab.

Click on **plus** sign to enroll this individual into a group.

Click on the group you’d like to enroll this person into. It will move the **group name** to the **selected** column.

Click **SELECT** to enroll.

To enroll someone in a group/class, do the following:
1. Click on the **Groups** tab.
2. Click on the **plus** sign (+) in the lower left portion of the screen.
3. Select the group or groups that you’d like to enroll this person into.

**Keywords**

The **Keywords** area allows you to categorize folks. Good examples for keywords would be tracking volunteer interests, spiritual gifts and talents. Once you have assigned a keyword to people, it is very easy to get a list of all the people that are “prayer warriors” or “mechanics” etc.

To enter a keyword for an individual, do the following:
1. Click on the **Keyword** tab.
2. Click the **plus** sign (+) in the lower left of the window.
3. If applicable, enter the relevant **Date** for this keyword.
4. Enter the **Keyword**. Select a value from the drop down list. If the value you need is not in the list, simply type the keyword and you’ll be asked if you want to add it to the list.
Click on **Keywords** tab.

Use the drop down to select a keyword, or enter a new value.

Click on plus sign to assign a keyword to this individual.

---

5. Enter the **Rank**. The rank could be from a survey… how interested are they in volunteering in the nursery.

**Visits**

Visits are used to track telephone calls or personal visits with individuals. Maybe your church calls first time visitors. You could track those conversations here. Maybe the pastor visits folks in the hospital. Those visits could be tracked here.

To enter visitation information, do the following:
1. Click on the **Visit** tab.
2. Click on the plus sign (+) in the lower left of the window.
3. The **Visitation** screen is displayed.
4. Enter the **Last Name** of the person from your church who is making the call, going
Enter the Last name of the person who made the visit, then select from the list.

Enter the duration, date and remarks from the visit.

to the hospital, going to their home, etc. Once you leave that field, a list will be displayed to pick the individual who is doing the visit. Double click on the appropriate name.

5. Indicate the Type of Visit. This will be either In Person or Telephone.
6. Enter the Length of the visit.
7. Enter the Date of the visit.
8. Enter the Remarks. This would be a summary of the visit.

Comments
There are several types of comments that can be tracked within Roll Call. The General comments would be a comments section that all Roll Call users can see. General comments also include a field for Special Needs and Allergy information. The Custody
comments allow you to enter any restraining order type information. This will be displayed in the child check in system on check out. The Confidential comments can only be entered and viewed by users that have the appropriate security access in Roll Call.

To enter general comments, do the following:
1. Click on the Comments tab.
2. Click on the General tab underneath the Comments tab.
3. Enter your general Comments.
4. Enter any Special Needs or Allergy information in the right field. This information will be printed on the Sign in Roster and on the Name Tag for children.

To enter custody information, do the following:
1. Click on the Comments tab.
2. Click on the Custody tab underneath the Comments tab.
3. Enter the Custody information.

To enter confidential comments, you must have the proper security access to enter or view this information. If you don’t have access, you won’t even see the tab. To add a confidential comment:
1. Click on the Comments tab.
2. Click on the Confidential tab underneath the Comments tab.
3. Click the plus sign (+) on the left portion of the window.

4. Enter the Date of the comment.
5. Enter the Comment.

Background Check
Roll Call allows you to record background check information for people you have in the system. When you are in the People screen you can record the background check request and/or the background check results.

The Background Check can only be entered and viewed by users that have the appropriate security access in Roll Call. If you do not have the proper authorization, you will not see the Background Check tab.

To enter this information, do the following:
1. Click on the Background Check tab.
2. Click on the (+) sign in the lower left. The Background Checks window is displayed.
3. **Request Date** – enter the date that the background check was requested for this person.
4. **Requested by** – enter the department or person who requested the check.
5. Indicate whether this person is an *employee* or *volunteer*.
6. Use the drop down, to select the **Type of Check** (e.g. Background, Fingerprint, Reference, etc.).
7. **Report Date** - enter the date that the background check report was completed.
8. **Report Result** – use the drop down to select the background check result.
9. **Clearance Level** – use the drop down to indicate this individual’s clearance level. Can they work with all ages, only over 18, pending, etc.
10. **Overall Clearance Level** – The overall clearance is displayed on the Comments tab. So if you want to publish the clearance level for all Roll Call users to view, enter the clearance level in this field as well.

Click on the **Background Check** tab.

Click on the plus sign to add a new background check for this person.

Enter the *background check request* information, who requested, type requested, etc.

Enter the *results* of the background check.
Letters
Roll Call allows you to record letter correspondence by typing and saving an actual letter, so just the subject and date only.

To enter this information, do the following:
1. Go to People>Search Profiles and open the person’s profile by double clicking on their name.
2. Click on the *Letters* tab.
3. Click on the (+) sign in the lower left. Select *Add a New Letter* to type, print, and save letter information. For more on Letter correspondence, check out the chapter on *Corresponding with your Congregation*.

To input simple subject and date info only,
1. Go to People>Search Profiles, and find the person. Double click to open their profile.
2. Click on the *Letters* tab.
3. Click on the (+) sign in the lower left.
4. Select *Add Subject Only*.
5. From here you add the letter date and subject.
6. Press *Yes* to save this information.

To delete letters or subject themes from the Letters tab:
1. Go to People>Search Profiles>Letters tab.
2. Highlight the item you would like to delete.
3. Press the minus (-) sign to delete.

---

Attendance
Roll Call allows you to view *attendance summary* and *details* of each individual’s attendance history under the Attendance tab. To view:

1. Go to People>Search Profiles and open the person’s profile by double clicking on their name.
2. Click on the *Attendance* tab.
3. To view a *summary* of their attendance taken in groups, classes or worship, stay on the summary screen under this attendance tab.
4. For a more detailed look at their attendance, click on the *details* within the attendance tab.
11. Report Text – You may wish to type in the comments from the background check report.

Add the Next Family Member

Once you have added all the information for an individual, you can do several things:
1. Click SAVE & CLOSE. This will save the information you entered, and return you to the Search People window.
2. Click SAVE & NEW, then select ADD NEW FAMILY MEMBER. This action will save the information you just entered. You will be taken to the People Information window, with the family information displayed. At this point you can start entering the information for the wife, children or other family member.
3. CLICK SAVE & NEW, then select ADD NEW FAMILY. This option saves the information you just entered. Then you will be taken to the People Information window to begin entering a completely new family.

Modify Family Relationships

Once you’ve entered the people of your parish or congregation into the system, there are life events that can cause family relationships to change: birth of a child, marriage, divorce or a death in the family. This next section discusses how to make changes in Roll Call for each of these events.

Addition to the Family

To add children (or others) to an existing family, do the following:
1. Open up the People menu on the left side.
2. Click on Search Profiles.
3. Find a person from the family you need to add to, and double click on their record.
4. Click the SAVE & NEW button.
5. Choose the option for ADD NEW FAMILY MEMBER.
6. You will be taken to the People Information window, with the family information displayed. At this point you can start entering the information for the new family member.
7. Click SAVE & CLOSE to save the information for the new family member and return.
to the Search window. Or click SAVE & NEW to enter another family member.

**Marriage**

When folks get married, their records need to be combined into one family unit. The different scenarios include:

1. The husband/wife is in Roll Call, but the other is not.
2. Both the individuals are in Roll Call.
3. The husband or wife has children as part of their family.

To handle the situation where one is in the database and the other is not, do the following:

1. Open up the *People* menu on the left side.
2. Click on *Search Profiles*.
3. Find the individual (husband or wife) who is in your database.
4. Click the SAVE & NEW button.
5. Choose the option for *ADD NEW FAMILY MEMBER*.
6. You will be taken to the *People Information* window, with the family information displayed. At this point you can start entering the information for the new family member.
7. Click SAVE & CLOSE to save the information and return to the Search window.

To handle the scenario where both the husband and wife are in Roll Call, do the following:

1. Pull up the new wife’s record.
2. Click on the *Head of Family* check box.
3. Select the option for “Make this person member of another family”.
4. Enter the *Last Name* of the husband.
5. Click OK.
6. A list of people with that last name will be displayed. Click to highlight the appropriate person. Press OK.
7. The wife is now part of the husband’s family. You’ll need to manually change the *Marital Status* and *Family Position*. You may also enter the spouse name in the

![Image of People Information window](image)
Select option for Make member of another family.

Enter the Last Name of the husband, then click OK.

Choose from the list of people with that last name.

Notice Kim & Dave are now in the same family.

Make sure to update marital status, titles, gender and last name.
Spouse field if you choose.

The final scenario would be a blended family. For this example, let’s say we have a family of four that was entered as two separate families. One family has the husband and a child. The other family has the wife and another child.

1. Pull up the wife’s record.
2. Click on the Head of Family check box.
3. Select the option for “Make this person member of another family”.
4. Enter the Last Name of the husband.
5. On the right hand side of the screen, highlight the child’s name to indicate that you’d like to move the child as well.
6. Click OK.
7. A list of people with that last name will be displayed. Click to highlight the appropriate person. Press OK.
8. The wife and child are now part of the husband’s family. Check that the Marital Status and Spouse name are correct for the husband and wife’s record.

Select option for Make member of another family.

Enter the Last Name of the husband, highlight the children that are moving to the new family, then click OK.

Notice we now have both Kim and Taylor in Dave’s family.
Divorce

In the case of divorce you will need to separate the husband and wife into two separate families in Roll Call. To do this:

1. Pull up the wife’s record.
2. Click on the Head of Family check box.
3. Select the option for “Make this person head of a new family”.
4. On the right hand side of the screen, highlight any children who will be staying with mom.
5. Mark the Retain Address box, if the wife is staying at the current address.
6. Click OK.
7. The wife is moved into a new family with any children that were marked. Make sure you enter her new address if she is not staying at the current address. Also change the Marital Status, Family Position and Spouse Name for both the husband and wife.
Change HOF

If you imported people into Roll Call, or used child check in to enter children’s names into the database and now realize the wrong person is marked as the Head of Family, this can be changed. To change who is marked as the HOF, do the following:

1. Pull up the record for the person you want to be the HOF
2. Click on the Head of Family check box.
3. A window will be displayed. Mark “make this person the head of the current family”
4. Click OK.

Death

If a person within a family dies, we recommend that you change their Association to “Deceased”. If the deceased is the Head of the Family and donations were recorded for him, transfer the donations to the surviving spouse. To ensure that he is not included in the directory or in any mailings, split him out into a separate family.

To change the association:
1. Pull up the deceased’s record.
2. Change Association to “Deceased”.

To transfer the donations:
1. Click on the Contributions tab.
2. Use the drop down and select Details by Week.
3. Right mouse click and select Transfer.
4. A Find Person window will be displayed to allow you to choose who to transfer these donations to. Enter a last name. Select from the list.

To move the deceased into a separate family:
1. Click on the Head of Family check box or select Additional>Change HOF from the menu bar at the top of the people screen.
2. Select the option for “Make this person head of new family”.

At the end of this process, you have retained a record of the deceased person. His donations have been transferred to the spouse, so she will receive the year end contribution statement and all correspondence will be addressed to her.
Delete People from the Database

People who have not made contributions can be deleted from Roll Call. To delete records you can do it from the People details screen or the Search window.

To delete a person from the People details screen, do the following:
1. Click on the Search Profile menu, under People.
2. Find the person you wish to delete.
3. Double click on the record to view the details.
4. Click the DELETE button in the bottom right of the window.

To delete a person from the Search screen, do the following:
1. Click on the Search Profile menu, under People.
2. Find the person or people you wish to delete.
3. Highlight their records. To highlight one or more, hold down your CTRL or CMD key while clicking on the record.
4. Click the minus sign (-) in the lower left of the window.

Pull up the record for the person you wish to delete, click DELETE.

Highlight the people you wish to delete, click the minus sign.
This screen allows you to review a list of the people who will be deleted. Anyone with contributions will be in red. Those records will not be deleted. Click to delete all.

A log of all deletions.

*To delete a person who has donations* you first have to do something with the donations. You must transfer them or delete them. If you are unsure who should own the donations, create a dummy record. To do this, go to People>Add a Family. Create a fake person with first name “Dummy”, last name “Record”. Give “Other” as Family Position, then you’ll have to choose an Association. Next, to transfer donations:

1. Click on the Contributions tab.
2. Find the person or people with donations you wish to delete, by selecting Search by Person.
3. Highlight their record, and double click to open. Right click in the Donation Summary Window, and select “Select All”.
4. Right click again, and select TRANSFER. Find “Dummy Record”, and transfer your donations. Now you are free to delete that person, as described on the previous page.
5. If you’d rather delete the donations, especially if they don’t have many, you’ll need to find the batch, reverse it (if it’s been posted), then open the person’s record and delete each donation, then repost. For more information on editing donations, see the section on Modifying Contributions.
Background Checks

Roll Call allows you to record background check information for people you have in the system. This information can be entered from an individual’s profile or it can be added from the Background Check menu, under People. If you have multiple background checks to enter, it may save you time to enter from the Background Check menu.

The Background Check can only be entered and viewed by users that have the appropriate security access in Roll Call. If you do not have the proper authorization, you will not see the Background Check menu.

Enter the Request & Results

To enter the Background Check report do the following:
1. Expand the People menu on the left side.
2. Click on Background Check.
3. From the Background Check window, click on the plus sign (+) in the lower left.
4. You are now in the Background Check entry screen. Enter the Last Name of the
person that the background check is for. Press tab, and a list of people with that last name will be displayed. Select the appropriate person from the list.

5. Enter the following information:

a. **Request Date** – enter the date that the background check was requested for this person
b. **Requested by** – enter the department or person who requested the check
c. **Indicate whether this person is an employee or volunteer**
d. Use the drop down, to select the **Type of Check** (e.g. Background, Fingerprint, Reference, etc.)
e. **Report Date** - enter the date that the background check report was completed
f. **Report Result** – use the drop down to select the background check result
g. **Clearance Level** – use the drop down to indicate this individuals clearance level. Can they work with all ages, only over 18, pending, etc.
h. **Overall Clearance Level** – The overall clearance is displayed on the Comments tab. So if you want to publish the clearance level for all Roll Call users to view, enter the clearance level in this field as well.
i. **Report Text** – You may wish to type in the comments from the background check report.

Highlight **Background Check** under the **People** menu.

To add a new background check record, click the **plus sign**.

Enter the **last name to find** the appropriate person.

Enter the information about the **type of request and the final results**.
Find/Research Background Checks

To lookup Background Check information, you can do the following:
1. Expand the People menu on the left side.
2. Click on Background Check.
3. Notice the Find By drop down box. Select the criteria (Name, Type or Clearance Level) that you’d like to find.
4. Begin entering the criteria. For example, if you looking for the Background Check’s on file for Diana Conklin, you would enter Conklin in the field to the right of the Find By drop box. As you begin entering that value, your list will be reduced to just the Conklin records.
5. To view the details for this background check, double click on the record and the detail screen will be displayed.

Visitation

Visits are used to track telephone calls or personal visits with individuals. Maybe your church calls first time visitors or the pastor visits folks in the hospital. These are both good examples of visitations.

Roll Call allows you to record visitation information for people you have in the system. This information can be entered from an individual’s profile or it can be added from the Visitation menu, under People. If you have multiple visitations to enter, it may save you time to enter from the Visitation menu.

Enter Visitations

To enter the Visitation information do the following:
1. Expand the People menu on the left side.
2. Click on Visitations.
3. From the Visitation window, click on the plus sign (+) in the lower left.
4. You are now in the Visitation entry screen. Enter the Last Name of the person that is being visited. Press tab, and a list of people with that last name will be displayed. Select the appropriate person from the list.
5. Enter the Last Name of the person that is making the visit, for example, the pastor or deacon. Press tab, and a list of people with that last name will be displayed. Select the appropriate person from the list.
6. Enter the following information:

   a. Visit Type – mark “in person” or “telephone to indicate how the visit was made.
   b. Length – indicate how long the visit was.
   c. Date – enter the date the visit took place.
   d. Remarks – enter any comments applicable to this visit.

Find/Research Visitations

To look up Visitation information, you can do the following:
1. Expand the People menu on the left side.
2. Click on Visitation.
3. Notice the Find By drop down box. Select the criteria (Name, Type or Date) that you’d like to find.
4. Begin entering the criteria. For example, if you looking for the Visitations on file for Diana Conklin, you would enter Conklin in the field to the right of the Find By drop box. As you begin entering that value, your list will be reduced to just the Conklin records.
5. To view the details for this visitation, double click on the record and the detail screen will be displayed.
Highlight Visitation under the People menu.

Select the “find by” criteria. Then enter the value you are looking for.

Confidential Comments

Roll Call allows for Confidential comments that can only be entered and viewed by users that have the appropriate security access in Roll Call. Confidential comments can be entered from an individual’s record, or from the Confidential comments menu.

Enter Confidential Comments

To enter the Confidential comments from the menu, do the following:
1. Expand the People menu on the left side.
2. Click on Confidential Comments.
3. From the Search window, click on the plus sign (+) in the lower left.
4. You are now in the Comments entry screen. Enter the Last Name of the person that this comment is for.
5. Enter the Date of the comment.
6. Enter the Remarks.
Enter the last name, then press tab. Select the appropriate person from the list.

Enter the date and the comments.

Find/Research Confidential Comments

To look up Comment information, you can do the following:

1. Expand the People menu on the left side
2. Click on Confidential Comments,
3. Notice the Find By drop down box. Select the criteria (Name or Date) that you’d like to find.
4. Begin entering the criteria. For example, if you looking for the Confidential Comments on file for Diana Conklin, you would enter Conklin in the field to the right of the Find By drop box. As you begin entering that value, your list will be reduced to just the Conklin records.
5. To view the details, double click on the record and the detail screen will be displayed.
FINDING PEOPLE

Search Profile Window

To find records in Roll Call, use the Search window. To find specific people, expand the People menu, then click Search Profiles. There are several main sections of the Search window:
1. The icon bar.
2. The Find By drop down and criteria.
3. The results.
4. The add and delete buttons.

Icon Bar

Note the icons across the top of the Search window. These icons allow you send emails, write letters or create labels for the people that are in the list. You can also print the list, do more detailed queries or do special searches. For more information on these icons, see the Getting Started – Icons chapter.

Find By

Note the drop down box to the right of “Find by”. Use this drop down to choose the criteria you’d like to use to find specific records. The field to the right allows you to enter the value you are looking for.
Results
As you type in the value you are looking for, the result set will change. For example, if you choose to find by “last name”, and start entering Smith, when you type in S, you’ll get a list of all names that start with S. As you type “m”, the list will be reduced to those last names that start with “Sm”.

From the results list, simply double click on a record to view the detail information for that person.

Add/Delete
In the lower left of the results section, notice the plus and minus (+/-) signs. Click on the plus sign to add a new record. Click on the minus sign to delete records from this list.

Customize Search Window
The Search window for People shows the following information: Last Name, First Name, Head of Family checkbox, Association, Family Position, Individual Email, Home Phone, Address 1, City, State and Postal Code.

If this information is not all displayed on your screen, you can use the scroll bar at the bottom of the window to view information that is off the screen. If you have a larger monitor, you can drag the lower right corner of the window to enlarge it.

Each Roll Call user can set preferences for what fields they’d like displayed in the Search window. To change the display fields:
1. Click on Prefs icon.
2. Drag a field from the left side to the right side, or highlight and use arrow keys.
3. To re-order the fields, drag the field up or down on the right side.
4. Click SAVE & CLOSE to save changes.
Find Specific Records

Find By Criteria
To find people by Last Name, First Name, Association, Family Position, Email, Street, City, Postal Code, Family No, Badge No, Envelope or Keyword you can select that criteria from the Find By drop down box. Once you’ve selected your criteria, enter the value you are looking for in the field to the right. The results will be displayed below.

Select your Find By criteria. How do you want to find this person?

Enter the value you are looking for.

Search Window
If you are searching for people by their Last Name or by a Keyword, use the Search box on the right side of the screen. Enter the name or keyword, then press Enter. Your results will be displayed.

Enter last name or keyword in search box, then press ENTER.
Query Editor

If you need to search for people by a field that is not listed in the Find By drop down box, you will need to use the Query Editor. To use the query editor, do the following:

1. Click on the SEARCH icon.
2. Select a field from the Field drop down box on the left side of the window.
3. Select your comparison operator.
4. Enter the value you are looking for.
5. Click QUERY.

In this first example, let’s say we have a custom date field that we set up for Baptism Date. We want to find all folks who were baptized this year.

1. Click on SEARCH icon.
2. Choose Baptism Date.
3. Choose “is greater than” as the comparison.
4. Enter “01/01/11” as the date value.
5. Click QUERY.

The results of our query. So we know that these people have a baptism date later than 1/1/11.
In this next example, let’s say we want to find folks that are Members, Regular Attenders or Occational Attenders.

1. Click on SEARCH icon.
2. Click on the Association tab.
3. Click over the Associations Member, Regular Attender and Occational Attender.
4. Click QUERY.

For more details on using the query editor, see the “Using the Query Editor” chapter.

Tag People

If you are a deacon responsible for a certain group of people, or a children’s minister responsible for the children, you may want to “tag” those people that you work with most often. By tagging people, you can go straight to the Tagged People menu item, under Home to see those folks.
To tag people, do the following:
1. Do a query or find by to get the people in the list.
2. Highlight all the people you’d like “tagged”.
3. Right mouse click.
4. Select “Tag”.

To view the “tagged” people, do the following:
1. Expand the Home menu.
2. Click on Tagged People.
3. Your tagged people are listed here.

To “un tag” a person, do the following:
1. Expand the Home menu.
2. Click on Tagged People.
3. Highlight the folks you no longer want in your list.
4. Right mouse click, and select “unTag”.

Expand the Home menu, and click on Tagged People. Your “tagged” people are listed here.

Highlight the people you wish to remove from your list, right mouse click and select “unTag”.
RUNNING REPORTS

The majority of reports in Roll Call are run in the same manner. This chapter discusses the methodology for running reports and walks you though much of the terminology. Whether you want a list of people, an attendance report, a contribution report, a pledge report or a group report, you will process them in the same manner.

Report Selection Window

To begin, you’ll need to decide which report you’d like to run. There is a report option under each of the main menu options on the left sidebar. For example, if you want to run a contribution report, expand the Contributions menu and select Reports. The report selection window for contribution reports will be displayed. Choose the specific report on the left sidebar of the window.

Expand the menu for the area you wish to report on, then click Reports.

Select your report on the left hand side.

Enter date range and other criteria.

Click GENERATE to run the report.

Notice there is also a Reports menu on the top menu. Once you drop down the reports menu you can choose People, Attendance, Contribution, Pledge or Groups. Again, the Report Selection window will be displayed for the area you choose.

Depending on the type of report you selected, there will probably be 3 tabs in the Report Selection Window: Criteria, Columns and View People. There may also be tabs across the middle of the page: Who, What and When.
Criteria
Most reports will be anchored in the Criteria tab. The information on the criteria tab will change based on what report you are running. For example, if you were running a contribution report, the Criteria tab would allow you to enter the date range of contributions you wanted to include in the report.

Who
If the report you are running is for certain people, attenders or donors there may be a “Who” tab on the Criteria section. The Who tab allows you to select who should be considered for the report. For example, you will be able to run the report for certain associations, groups, keywords, shepherd areas or by using the query editor. First select the type, association, group, etc. Then choose the specific values you are interested in.

For example, if you wanted a list of your members who donated to a certain fund, you would select Association as the type, then click over Member to the Selected column. As another example, if you wanted to see who attended children’s church, you would select Groups as the type, then click over all the classes or groups associated with your children’s church.
What
The “What” tab is used to further refine your criteria. For example, if you are running a Contribution report, which funds should be included? If you are running an Attendance report, which attendance should be included?

When
The “When” tab is used in the Absent/Present report to further refine your criteria. This tab allows you to enter your “missing” criteria to further refine your criteria.

Columns
Once you’ve identified who will be considered for the report, click on the Columns tab to change what data is included in the report. Each report has a standard set of columns that will be displayed, but if you’d like to change that, use the Columns tab.

All the columns that are available for the report will be listed in the left column. If there is an arrow in front of a word like People or Addresses, this means you can expand the list of fields under that table. There is also a section called Special Columns. Special Columns combine pieces of information into one field. For example, if you want the Head & Spouse as a field, or Parents Names as a field, these can be found under Special Columns. For a full listing of tables, field names and descriptions please see Appendix A.
Click on the arrow to view fields under each section.

Double click or drag a field from left column to "selected" column.

Move the selected columns around to order them in the report.

Click on **Columns** tab to pick fields for the report.

Move a field to 3rd column to sort by that field.

---

**View Records**

The **View Records** tab allows you to see which people or data will be included in the report based on the criteria you selected.

**Run the Report**

When you click GENERATE, the report results will be displayed in the **Report Output** window.

---

**Report Output**

The report results are displayed in the main section of the **Report Output** window. Use the scroll bars on the bottom and to the right of the report to scroll up and down; left and right.

On the right side of the **Report Output** window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in your report. If you choose Email report, the email editor will be displayed. You will need to enter the email address of the person you are emailing. Enter any introductory text in the body, the report will be sent as an attachment. Click SEND.
12. Click GRAPH to view the report data in a graphical format. This option is generally available for summary by week, month or year type reports.
13. To enlarge the window, click on the lower right corner of the window and drag to the appropriate size.
REPORTING ON PEOPLE

There are quite a few standard reports that can be run to obtain people type information. You can run a list of people who have a birthday, anniversary or significant date in a specific month. Or, maybe you want a list of people with their envelope number. Maybe you’d like a one page summary about a family, or a report to send each family to confirm their contact information. All these reports can be found in the Reports menu under the People menu.

Report Window

Each report is run in a similar manner. This section will discuss the methodology for running the People reports. To select a report, do the following:
1. Expand the People menu.
2. Expand the Reports menu.
3. Highlight the report you’d like to run.

Once you’ve selected the report, you’ll see three tabs across the right side of the window. The criteria let’s you select who should be included in the report. Do you want the report for certain associations, groups, shepherd areas, keywords, assigned envelopes or other criteria?

Note the three tabs:

Click on Criteria tab, then choose which people you’d like in the report.

Click on Columns tab.

Drag field name from left column to “Selected” to include on the report.

Click GENERATE to run the report.
Once you’ve identified who will be in the list, click on the Columns tab to change what data is included in the report. Each report has a standard set of columns that will be displayed, but if you’d like to change that, use the Columns tab.

The View Records tab allows you to see which people will be included in the report based on the criteria you selected.

When you click GENERATE, most reports will be displayed in the Report Output window. From the Report Output window you can print the report, zoom in and out, or change page setup. You can also create mailing labels or write letters to the people listed in the report. The email option allows you to email the people listed in the report or actually email the report to someone else.
Envelope Number Report

The Envelope Number report lists people (based on your criteria selection) with their name, address and current envelope number. To run the report, do the following.

1. Expand the People menu.
2. Expand the Reports menu.
3. Highlight Envelope #.
4. From the Criteria tab, select the associations, keywords, groups, shepherd area, or assigned envelopes that you’d like to see in the list.

In this example, I’ve choose to run the report for Associations and I selected Member.

5. If you’d like to change which columns are displayed in the report, click on the Columns tab. Drag the field you’d like to add to the right side “Selected” column.
6. To change the sort order of the report, drag the field you’d like to sort on.
7. Click GENERATE to run the report.
Family Report

The Family Report lists all the family members in the top section of the report. Next, it shows the individual contact and email information. Next, the addresses are outlined. Finally the group involvements for each family member are listed. To run the report, do the following.

1. Expand the People menu.
2. Expand the Reports menu.
4. From the Criteria tab, select the associations, keywords, groups, or shepherd area, that you’d like to see in the list.
5. There isn’t a columns tab for this report. The format for this report is fixed.
6. Click GENERATE to run the report.

Highlight Family Report on the left side menu.

Choose who you want the reports for. In this example, I’m running the family report for all families in the Johnson shepherd area.

Click GENERATE to run the report.

Here’s an example of the Family Report.

Family information for the Mr. Juan Garcia family

<table>
<thead>
<tr>
<th>Name</th>
<th>Position</th>
<th>M/F</th>
<th>Association</th>
<th>Date of Birth</th>
<th>Marital Status</th>
<th>Initial Date</th>
<th>Modified Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mr. Juan Garcia</td>
<td>Headshot</td>
<td>M</td>
<td>Member</td>
<td>8/10/62</td>
<td>Married</td>
<td>3/20/11</td>
<td>4/16/11</td>
</tr>
<tr>
<td>Mrs. Maria Garcia</td>
<td>Wife</td>
<td>F</td>
<td>Member</td>
<td>8/10/60</td>
<td>Married</td>
<td>3/25/11</td>
<td>4/5/11</td>
</tr>
<tr>
<td>Miss Gail Garcia</td>
<td>Youth</td>
<td>F</td>
<td>Member</td>
<td>7/10/90</td>
<td>Single</td>
<td>3/20/11</td>
<td>4/20/11</td>
</tr>
<tr>
<td>Mr. Sebastian Garcia</td>
<td>Child</td>
<td>M</td>
<td>Member</td>
<td>8/12/90</td>
<td>Single</td>
<td>3/20/11</td>
<td>4/20/11</td>
</tr>
<tr>
<td>Miss Jennifer Garcia</td>
<td>Child</td>
<td>F</td>
<td>Member</td>
<td>12/12/90</td>
<td>Single</td>
<td>3/20/11</td>
<td>4/20/11</td>
</tr>
</tbody>
</table>

Family eMail: johnsonfamily@illinoisidaho.com
Personal eMail
- Mr. Juan Garcia: juan@illinoisidaho.com
- Mrs. Maria Garcia: maria@illinoisidaho.com
- Mr. Sebastian Garcia: sebastian@illinoisidaho.com

Personal Phones

<table>
<thead>
<tr>
<th>Local Address</th>
<th>Alternate Address</th>
<th>Effective Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>2300 Neil</td>
<td></td>
<td>00:00 to 00:00</td>
</tr>
<tr>
<td>Byron, IL 61015</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Shepherd Area: Johnson
Wedding Date: 00:00:00

Comment on Address
Take left at light.

Group Involvements

- Mr. Juan Garcia: javetest
- Miss Jennifer Garcia: A
Birthday Report

The Birthday Report will list all the people that meet your birthday criteria and that are in the associations, shepherd areas, groups or keywords. The default birthday report lists the name, address, birthday and age. To run the report, do the following:

1. Expand the People menu.
2. Expand the Reports menu.
4. From the Criteria tab, chose your birthday date range.
5. From the Criteria tab, select the associations, keywords, groups, or shepherd area that you’d like to consider for the report.

Click on Columns tab and enter date range criteria.

In this example, I wanted to run this for my 1st, 2nd and 3rd grade groups.

Click GENERATE to run the report.

6. If you’d like to change which columns are displayed in the report, click on the Columns tab. Drag the field you’d like to add to the right side “Selected” column.
7. To change the sort order of the report, drag the field you’d like to sort on.
8. Click GENERATE to run the report.

Click on the Columns tab.

To add fields to the report, drag the field name to the “Selected” column.

Click GENERATE to run the report.
This is an example of the Birthday Report.

Anniversary Report

The Anniversary Report will list all married folks who have an anniversary in your date range and that are in the associations, shepherd areas, groups or keywords selected. The default anniversary report lists the name, address, anniversary and length married. To run the report, do the following:

1. Expand the People menu.
2. Expand the Reports menu.
4. From the Criteria tab, choose your date range.
5. From the Criteria tab, select the associations, keywords, groups, or shepherd area that you’d like to consider for the report.

From the Criteria tab, select the date range you are looking for.

Also select the folks you want to consider for this report. In this example, I will look for any member, regular attender or occasional attender who has an anniversary in January.
6. If you’d like to change which columns are displayed in the report, click on the **Columns** tab. Drag the field you’d like to add to the right side “Selected” column.
7. To change the sort order of the report, drag the field you’d like to sort on.
8. Click GENERATE to run the report.

**Significant Dates Report**

The **Significant Dates Report** will list all folks who have a significant date in your date range and that are in the associations, shepherd areas, groups or keywords selected. The default report lists the name, address, the significant event and date. To run the report, do the following:

1. Expand the People menu.
2. Expand the Reports menu.
3. Highlight **Significant Dates Report**.
4. From the Criteria tab, chose your date range.
5. From the Criteria tab, select the associations, keywords, groups, or shepherd area that you’d like to consider for the report.
Highlight **Significant Date Report** on left side menu.

From the **Criteria** tab, choose time frame, and who you want to consider for the report.

6. If you’d like to change which columns are displayed in the report, click on the **Columns** tab. Drag the field you’d like to add to the right side “Selected” column.

7. To change the sort order of the report, drag the field you’d like to sort on.

8. Click **GENERATE** to run the report.

Click on the **Columns** tab.

To add fields to the report, drag the field name to the “Selected” column.

Click **GENERATE** to run the report.

Use the top buttons to print, zoom or change page setup.

Use these buttons to create mailing labels, write a letter or email the folks in this list.
Confirm Data Report

The Confirm Data summarizes the families contact information. This report is set up as a letter to the family so that they can confirm their contact information. To run the report, do the following.

1. Expand the People menu.
2. Expand the Reports menu.
3. Highlight Confirm Data Report.
4. From the criteria tab, select the associations, keywords, groups, or shepherd area, that you’d like to see in the list.
5. There isn’t a Columns tab for this report. The format for this report is fixed.
6. Click GENERATE to run the report.

Select the criteria for who you want to have a confirmation report printed.

Click GENERATE to run the report.

An example of the confirm data report. Note when folded, this fits in #9 envelope.
Uninvolved Families Report

The Uninvolved Families Report allows you to find families that:
1. Have not given since a certain date
2. Have not attended any service or group since a certain date
3. Are not members of an active group.

To run the report, do the following.
1. Expand the People menu.
2. Expand the Reports menu.
4. From the Criteria tab, chose the uninvolved criteria.

Select your “uninvolved” criteria.

Select which associations, groups, keywords, etc. that you’d like to consider in this report.

Select the fields you’d like displayed in the report. Drag from left column to “Selected” column.

Click GENERATE to run the report.

Select which associations, groups, keywords, etc. that you’d like to consider for the report.

If you’d like to change which columns are displayed in the report, click on the columns tab. Drag the field you’d like to add to the right side “Selected” column.

To change the sort order of the report, drag the field you’d like to sort on.

Click GENERATE to run the report.
Background Check Report

The Background Check Report will list all background checks on file for the people in the associations, shepherd areas, groups or keywords selected. The default report lists the name, request date, type, result, and clearance level. To run the report, do the following:

1. Expand the People menu.
2. Expand the Reports menu.
3. Highlight Background Check Report.
4. From the Criteria tab, select the associations, keywords, groups, or shepherd area that you’d like to consider for the report.
5. If you’d like to change which columns are displayed in the report, click on the Columns tab. Drag the field you’d like to add to the right side “Selected” column.
6. To change the sort order of the report, drag the field you’d like to sort on.
7. Click GENERATE to run the report.
To select a column for the report, drag from left column to “Selected” column.

Click GENERATE to run the report. Click RESET to reset back to default values.

Use the top buttons to print, zoom or change page setup.

Use these buttons to create mailing labels, write a letter or email the folks in this list.

### Visitation Log

The Visitation Log is a sheet that can be used to record comments on a specific visit. It contains the families address, attendance history, comments from their last visit and a blank area to make notes. To run the report:

1. Expand the People menu.
2. Expand the Reports menu.
4. From the Criteria tab, select the associations for the folks you’d like to run the log for.
5. Click GENERATE to run the report.
Select the association of the folks you’d like to print logs for.

Highlight Visitation Logs.

Click GENERATE to run the report.

Contact information for this person to be visited.

Last visit comments.

Blank area to record comments for this visit.

**Visitation History**

The *Visitation History* lists all visits made since a certain date. To run this report:

1. Expand the People menu.
2. Expand the Reports menu.
4. From the Criteria tab, enter the *beginning date of the visits* you’d like to report on.
5. Click GENERATE to run the report.
Enter your date criteria for the history report.

Click GENERATE to run the report.

This report shows all visitation records since the date entered above.

My Reports

The My Reports area allows each user to build their own reports. These reports can then be saved to run again in the future. To create a report, do the following:

1. Expand the People menu.
2. Expand the Reports menu.
3. Highlight My Reports.
4. From the Criteria tab, select the associations, keywords, groups, or shepherd area that you’d like to consider for the report.
Select the criteria for which people you’d like in this report.

Highlight My Reports.

5. Click on the Columns tab and drag the columns you’d like in the report to the right side “Selected” column.
6. To change the sort order of the report, drag the field you’d like to sort on to the Sort Column.
7. To save the report, click SAVE and name the report.
8. Click GENERATE to run the report.

To select a column for the report, drag from left side to “Selected” column.

Click GENERATE to run the report.

Click SAVE to save this report for later use.

Use this drop down to retrieve saved reports.
RECORDING ATTENDANCE

Worship Attendance

Create Service

Before you can begin recording attendance for worship services you must first create the service record in Roll Call. The service record contains the name of the service, what day and time it meets, and which associations you’d like to record attendance for. You may also indicate if you’ll be recording attendance for only adults.

If you’d like to use the check in system for services, indicate if you’d like a name tag printed upon check in.

To create the service:
1. Expand the Services menu on the left side bar.
2. Click on Search menu item.
3. Click on the plus sign in the lower left of the Search window.
4. Enter the Name and Description of the service. The name will be used in the drop down box for you to select which service you’ll be recording attendance for.
5. Enter the Day, Start Time and End Time that this service meets.
6. If you will have the congregation checking into the service and would like to print name tags, indicate the Number of Labels to print upon check in.
7. Mark Inactive if this service is not used any more.
8. Click the associations you’d like to record attendance for this service. Roll Call will use these associations to build the list of people to mark as present when recording attendance.

9. Enter any comments about this service.

10. Click SAVE & NEW to save this service information and create another service record. Click SAVE & CLOSE to save this service record and return to the search window.

Record Attendance

To record attendance:
1. Expand the Attendance menu.
2. Click on Search, then click on the plus sign in the lower left OR
3. Click on the Record Attendance menu item.

To record attendance for a specific service and date, enter the following information:
1. Select the Type of attendance you’ll be recording. Choose Service.
2. Select the specific Service you are recording for.
3. Enter the Meeting Date that you are recording for.
4. If you know the Head Count, you may enter it manually, or if you will be marking people present, Roll Call will fill this in for you.
5. If communion was served at this service, mark the communion box and indicate how many people took communion. This information is optional.
6. To record attendance for a specific person, find their name and click on the box to the left of their name. You may also place your cursor in the last name field, and begin entering the last name. If the correct row is highlighted, you can press the return key to mark them as present.

7. When you are done marking the people that attended, click SAVE & NEW to save this attendance and record for another service or group. Click SAVE & CLOSE to save the attendance and return to the search screen.

Select specific service you are recording attendance for.

Enter the date for which you are recording attendance.

Click on a name to mark them as present.

Enter portion of the last name to move to that section of the list.

If a person attended the service and they are not in the list (based on associations) you can click the plus sign in the lower left to find this person in the database and they will be marked present and added to the list.

If a person attended who is not in the database, you will need to add them first. Once they are added into Roll Call, you can add them to the list and mark them present.

To record attendance using a bar code roster, click on the bar code symbol on the right side of the screen. Begin scanning the bar code of the people who are present. Their names will be marked present in the list.

To add an existing person from the database to your attendance list, click the plus sign.

To record attendance by barcode scan, click scanner icon. Next, scan the bar code for the first person present.
Find/Modify Attendance

If you need to modify or continue recording attendance for a specific service and date, do the following:

1. Expand the Attendance menu.
2. Click Search.
3. Find the attendance record for the specific service and date you are interested in.
4. Double click on that attendance record.
5. Note the people you have already marked present should still be marked present. Make the necessary changes.

To modify or complete recording attendance for Sunday Worship 9 a.m. on the 15th of May, locate the record in the search window.

Double click to view the detailed attendance and make any necessary changes.

Here are the details for that attendance. The people marked present have a check in front of their name.

Group Attendance

Create Group

Before you can begin recording attendance for a group/class, you must first create that group or class in Roll Call. To create a group/class, do the following:

1. Enter the values for Campus, Group Type, Department and Status.
2. Enter the name of the specific group under Group Section.
3. If the group has a leader, enter the last name in the Leader field. Press tab to view a list of the folks with that last name. Select from the list.
4. If the group has a co-leader, enter the last name in the Co-Leader field. Press tab to view a list of the folks with that last name. Select from the list.
5. Enter the Location of the group, if applicable.
6. Indicate if the group meets weekly or randomly.
Enter the group type, department and name to define the group.

Make sure to indicate the day and times this class meets under the Sessions tab.

7. You may enter any comments or notes in the Notes field.
8. The Start Date will default to today’s date. You may change it if you’d like.

To enroll people into the group, press the Members tab. From within the members tab:
1. Click the plus sign in the lower left of the window. A new window will be displayed for you to enter the Last Name and First Name (or portion of the last name) of the person you want to enroll.
2. Select the appropriate person to enroll in the group.
3. Tab across to enter any of the custom field data for this person. If you need to define the membership custom field names, click CHANGE TITLES and enter the name of the data you’d like to capture.

Next, you’ll want to indicate which days and at what times the group meets. The meeting days and times are called sessions in Roll Call. A group that meets weekly can have an unlimited number of sessions. A group that meets randomly does not have any sessions defined.

To create a session:
1. Click on the Sessions tab, if sessions are not currently displayed.
2. Click on the plus sign in the lower left. A row will be displayed, with a default of Sunday and time of 12 a.m.
3. Use the Day of Week drop down box to select the appropriate day.
4. Enter the Start Time.
5. Enter the End Time.
6. Place your cursor under Room and double click to enter the room number of this group meeting.

Click SAVE & CLOSE to save the information and return to the Search screen. Click SAVE & NEW to save the information and enter a new group.

Record Attendance
To record attendance:
1. Expand the Attendance menu.
2. Click on Search, then click on the plus sign in the lower left OR
3. Click on the Record Attendance menu item.
To record attendance for a specific group and date, enter the following information:
1. Select the Type of attendance you’ll be recording. Choose Group.
2. Select the specific Group or Service you are recording for. For groups you will need to select a department, group and session (if more than one session is available).
3. Enter the Meeting Date that you are recording for.
4. If you know the Head Count, you may enter it manually, or if you will be marking people present, Roll Call will fill this in for you.
5. To record attendance for a specific person, find their name and click on the box to the left of their name. You may also place your cursor in the last name field, and begin entering the last name. Once the correct row is highlighted, you can press the return key to mark them as present. Or, you can mark that they took communion. If you mark the communion box, it will automatically mark them as present. Marking them as having taken communion also automatically updates the Last Comm date field in their personal record.
6. When you are done marking the people that attended, click SAVE & NEW to save this attendance and record for another service or group. Click SAVE & CLOSE to save the attendance and return to the search screen.

If a person attended the group and they are not in the list you can click the plus sign in the lower left to find this person in the database and they will be marked present and added to the group.

If a person attended who is not in the database, you will need to add them first. Once they are added into Roll Call, you can add them to the list and mark them present.

To record attendance using a barcode roster, click on the barcode symbol on the right side of the screen. Begin scanning the bar code of the people who are present. Their names will be marked present in the list.

**Find/Modify Attendance**

If you need to modify or continue recording attendance for a specific group and date, do the following:
1. Expand the Attendance menu.
2. Click Search.
3. Find the attendance record for the specific service and date you are interested in.
4. Double click on that attendance record.
5. Note the people you have already marked present should still be marked present. Make the necessary changes.
Find the attendance that you need to modify and double click on it.

Update the attendance as required.

Mark here to show that they received communion. This automatically updates their attendance record.

**Attendance Reports**

**Attendance Summary**

The Attendance Summary report gives head count information for service and group attendance information. The Attendance Summary by Day lists the group or service, the meeting date, the number of people enrolled if the attendance is for a group, the number of visitors (people with the association of visitor) that attended, the head count and the number of people that attended. For a specific class/service and day the head count and number of people will be the same. However, on the summary lines, the number of people represents the number of “unique” people that attended those classes. So, if someone attended two classes and a worship service, they would only be counted once.

The Attendance Summary can also be run by week, month or year. When running for this time frame, it will display the head count.

To run the Attendance Summary report by day:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. Enter the date range for the attendance data you are interested in.
5. Select By Day as the report type.
6. Choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose Groups, then pick the specific groups you’d like included in the report.
7. Click GENERATE to run the report.

To run the Attendance Summary report by week, month or year:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. Enter the date range for the attendance data you are interested in.
5. Select by week, by month or by year as the report type.
6. Choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose Groups, then pick the specific groups you’d like included in the report.
7. Click the Columns tab to modify which columns to view in the report. To view more options, open the columns options by clicking on the arrow to the left of Attendance Summary so that it points downward. To move additional columns to the selected side, double click or drag your options. You can also remove from the selected side by a double click, dragging, or using the center arrow.
8. To reset the default columns press RESET.
9. Click GENERATE to run your report.
Choose the attendance you are interested in seeing.

Click on Columns tab to add or remove more columns.

Click EMAIL to send this report to someone via Email.

Click graph to create a graphical representation of this data.

Graph of above attendance data. Note weeks along bottom.

To print, right click and select PRINT.

Note each of the classes I chose is listed. The head count for the entire week is listed.

Attendance by Person

The Attendance by Person report outlines the different services or groups a person came to, if you run this report by day. If you run this report by week, month or year it will show you in a spreadsheet format how many times they attended each week, month or year.

To run the Attendance by Person report by day:

1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance by Person.
4. Enter the date range for the attendance data you are interested in.

Enter date range.

Select by week, month or year.

Click on Columns tab to add or remove more columns.

Note each of the classes I chose is listed. The head count for the entire week is listed.
5. Select *By Day* as the report type.
6. On the *Who* tab, select which people you want to run this for. You can choose by association, groups, keywords, shepherd areas, tagged people or search the database. Once you choose your type, you can pick the specific values. For example, if you wanted to see all your Members and Regular Attenders, choose Associations, then click on Member and Regular Attender to select those values.
7. Next, click on the *What* tab to choose which attendance you want to run this for.

Highlight *Attendance by Person*.

Enter date range and select *by day* to get the detail attendance information.

In this example I choose groups, and picked several Sunday School classes.

You may select *All* and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select *Service*, and then choose which services you’d like to see, or you may choose *Groups* then pick the specific groups you’d like included in the report.

8. Next, click on the *Columns* tab to choose the information you wish to include on

Click on the *Who* tab. And choose which people you want included in the report.

Click to only show active groups in the list. Mark if you only want to see active members in the report.

In this example I’ve chosen to include attendance for the K-5th grade classes.
the report. Click on a column name from the left column and move it to the middle column.

9. Click on the View People tab, to review the people that will be included in the report.
10. Click GENERATE to run the report.
To run the by person report by week, month or year:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance by Person.
4. Enter the date range for the attendance data you are interested in.
5. Select by week, by month or by year as the report type.
6. On the Who tab, select which people you want to run this for. You can choose by association, groups, keywords, shepherd areas or search the database. Once you choose your type, you can pick the specific values. For example, if you wanted to see all your Members and Regular Attenders, choose Associations, then click on Member and Regular Attender to select those values.
7. Next, click on the What tab to choose which attendance you want to run this for.

You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose Groups, then pick the specific groups you’d like included in the report.
8. Next, click on the Columns tab to choose the information you wish to include on the report. Click on a column name from the left column and move it to the middle column.
9. Click on the View People tab, to review the people that will be included in the report.
10. Click GENERATE to run the report.
Double click on a field from the left side column to move it to the Selected column.

The report lists how many times a person came each month. The dash means there was no attendance for that month.

**Attendance by Type**

The *Attendance by Type* report will list all the people who came to a group or service on a specific day. This is a great report to run if you want to see who came to your Sunday School classes last weekend and who was absent. Or you can see who attended last Saturday nights service.

To create the *Attendance by Type* report, do the following:

1. Expand the *Attendance* menu.
2. Click on Reports.
3. Highlight *Attendance Summary*.
4. Enter the date range for the attendance data you are interested in.
5. Choose which attendance you want to run this for. You may select *All* and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select *Service*, and then choose which services you’d like to see or you may choose *Groups*, then pick the specific groups you’d like included in the report.
6. Click GENERATE to run the report.
Highlight **Attendance by Type**.

Select which type of attendance you are interested in. Select **group**, **service** or **all**.

Select the specific values based on the **type** of attendance you chose.

Click on the **Columns** tab to select additional data to be included on the report.

Double click or drag a field from left side to **Selected** column.

Click **GENERATE** to run the report.

Lists the class name.

Lists members present for the **date**.

Lists **absent** members.

### Attendance by Session

The **Attendance by Session** report will list all the people who came to a specific group session or a specific service time on a specific day.

To create the **Attendance by Session** report, do the following:

1. Expand the **Attendance** menu.
2. Click on **Reports**.
3. Highlight **Attendance by Person**.
4. Enter the date range for the attendance data you are interested in.
5. Choose which attendance you want to run this for. You may select *All* and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select *Service*, and then choose which services you’d like to see or you may choose *Groups*, then pick the specific groups you’d like included in the report.
6. Click GENERATE to run the report.

The report lists the *name* of the group or service and the specific *time*. All who attended at that time are listed.

**Absent/Present Report**

The *Absent/Present* report allows you to find folks who have been absent so many weeks or who have attended so many times in a certain time frame.

To run the *Absent/Present* report:
1. Expand the *Attendance* menu.
2. Click on *Reports*.
3. Highlight *Absent/Present*.
4. Enter the date range for the attendance data you wish to view.
5. On the *Who* tab, select the people to consider for the attendance report. You can choose by association, groups, keywords, shepherd areas or search the database. Once you choose your type, you can pick the specific values. For example, if you wanted to evaluate attendance for all your Members and Regular Attenders, choose *Associations*, then click on Member and Regular Attender.

Highlight the *Absent/Present* report.

Enter date range of attendance that will be included on report.

From the *who* tab, choose which people you’d like to consider for the report.
6. Next, click on the *What* tab to choose which attendance you want to use in determining who was present or absent. You may select *All* and it will evaluate attendance for all services and groups. Select *Services* and choose the specific services to only look at attendance for those services. Select *Groups* to choose specific groups.

In determining if a person was *absent or present*, which attendance should be considered... *All*, specific *groups* or specific *service* attendance.

7. Click on the *When* tab to enter your absent present criteria. Enter how many weeks you wish to look back. Choose to find people who were absent or find people who were present. Enter how many times.

8. Next, click on the *Columns* tab to choose the information you wish to include on the report. Click on a column name from the left column and move it to the middle column.

9. Click on the *View People* tab, to review the people that will be included in the report.

10. Click GENERATE to run the report.
Visitor Report

The Visitor report will list all your first time, second time, third time visitors, based on the association of visitor and the attendance data you wish to evaluate.

To create the Visitor report, do the following:
1. Expand the Attendance menu.
2. Click on Reports.
4. Enter week of attendance you are interested in looking at.
5. Choose the type of visitor you are looking for from the drop down under the Who tab. Then choose the association(s) you use to indicate a visitor.
6. Click on the What tab and indicate which type of attendance you wish to evaluate.
7. Click GENERATE to run the report.

Highlight Visitor report.

Choose the association your church uses for visitors.

Choose the type of attendance you wish to consider when determining if it was their 1st, 2nd or 3rd time visiting.

Our list of 1st time visitors on the 15th.

Choose the number of times visited.

Click GENERATE to run.

Our list of 1st time visitors on the 15th.
ENTERING CONTRIBUTIONS

Giving Funds
Before you can begin entering contributions in Roll Call, the giving funds must be defined. The giving funds are the designations that people can contribute to. A new Roll Call database will contain one giving fund, “General”. To add giving funds, do the following:

1. Expand the Contributions menu on the left side bar.
2. Click on Giving Funds.
3. Click on the plus sign in the lower left of the Giving Fund summary window.

4. Enter the Fund name. This is the name that will be in the drop down box to select designations from the Enter Contributions screen.
5. Enter the associated Account Number. This number is not mandatory.
6. If this giving fund is no longer valid or used, check the “Inactive” box.
7. If this fund is not tax deductible, mark the box for “Not on Receipt”. If this box is checked any monies given to this fund will not be printed on the year-end tax statement.

Click on Giving Funds, under the Contributions menu.
Click on the plus sign to add a new fund.
Enter the fund name and account number.
Enter GL Account mapping information.
Click SAVE to save the information.

Click on Giving Funds, under the Contributions menu.
8. Select the **Fund Color**. This color will represent the fund in pie charts showing total giving. Click on the “…” and click on the color you’d like to use.

9. The **GL Fund** is used to map the giving funds to your accounting system. For example if you have a giving fund of “Tithes & Offerings” and you want that to map to the **General Income Fund** in your accounting system, you would enter General Income as the GL Fund. If you are importing into Quickbooks and your fund is a sub-account, enter the Account, then a colon then the sub account name, for example, Operating Income:General.

10. The **GL Account Number** is the account number to map to MYOB accounting.

11. **GL Key** is the number to map to Roll Call’s accounting system.

**Batches**

All contributions are entered in Roll Call through a batch. A batch is nothing more than a grouping of contributions. Typically, users will enter all the giving for a deposit in a batch.

Because of the integration with Accounting, batches must be either Cash or Non-Cash. Cash contributions include all cash, checks, credit cards and ACH type transactions. Non-Cash batches contain property gifts, things that cannot be deposited into the bank.

To create a batch, do the following:

1. Expand the **Contributions** menu on the left side bar.
2. Click on **Add a new Batch**.

Enter the following information:

1. **Batch Date** – This date will become the default for all contributions entered in this batch.
2. **Description** – Enter a qualifying description of this batch. Especially if you will have multiple batches for the same day. Maybe this group of contributions is for the 9 a.m. service. You could enter “9 a.m. service” as the description.
3. **Anonymous Cash** – Enter the amount of loose cash that was in the offering. This is cash that cannot be associated with any specific donor.
4. **Cash Fund** – Enter the fund that the anonymous cash should be designated to.

5. **Default Fund** – Enter the fund that you’d like all contributions in this batch to default to. This doesn’t mean that you can’t have other funds included in this batch. This is only used as a default. If the majority of the giving is for Tithes & Offerings… make “Tithes & Offerings” the default fund.

6. **Batch Type** – Select Cash for batches that will contain cash, checks, credit card, online, ACH type contributions. Select Non-Cash for property or in-kind gifts.

7. **Asset Fund** – This is the fund to map non-cash gifts to the appropriate asset fund in your accounting system.

8. **Batch Control Count** – This field can be used as a control count for the number of entries expected in this batch. This field is not required, but by using it you may be able to catch any data entry errors. If the Batch Count and Batch Control Count do not match, they will be displayed in red.

9. **Batch Control Total** – This field can be used as a control total for the amount expected in this batch. This field is not required, but by using it you may be able to catch any data entry errors. If the Batch Total and Batch Control Total do not match, they will be displayed in red.

10. To begin entering individual contributions, click on the plus sign in the lower left corner.

### Check/Cash Contributions

To begin entering cash or cash equivalent contributions, you will need to create a batch. To create a new batch, do the following:

1. Expand the **Contributions** menu.
2. Click on **Add a new Batch**.
3. Enter the batch header information as described in the previous section.
4. Click on the plus sign in lower left to begin entering the contributions.

To enter new contributions to an existing batch, you will need to locate your batch.

1. Expand the Contributions menu.
2. Click on **Search by Batch**.
3. Change the Find By Criteria to “Date”.
4. Select the date of the batch you are adding to.
5. Double click on the appropriate record.
6. Click on the plus sign in the lower left to begin entering new contributions.

### Basic

To record a donation, enter the following information:

1. **Donor Name or Envelope Number**. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

2. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

3. **Total Amount** – Enter the amount of the contribution.

4. **Check Number** - If the contribution was a check, you may enter the check number in this field.

5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.
6. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to *Batch* window.

- Enter the *last name* of the donor. Press the TAB key.
- Select from this list, or reduce the list further by typing the *first name*.
- Enter the *amount*, *check number* and *donation type*.
- Select the *fund* to designate this contribution to.
Split

A split donation is a single contribution that needs to be designated to two or more funds. To record a split donation, enter the following information:

1. **Donor Name or Envelope Number.** When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

2. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

3. **Total Amount** – Enter the amount of the contribution.

4. **Check Number** - If the contribution was a check, you may enter the check number in this field.

5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.

6. **Amount** – Notice the amount and designation fields underneath the contribution header information. Place your cursor in the amount field, and reduce the amount so that it matches the amount to be designated to the first fund. Press TAB. Note a 2nd line is created with the remainder, so you can designate that amount.

7. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

Click **SAVE & NEW** to enter a new contribution in this batch. Click **SAVE & CLOSE** to save the current contribution and return to the Batch window.

**Connect to Pledge**

When you are entering a contribution for an individual that has made a pledge, the pledge will be listed near the bottom of the screen on the pledges tab.

If you enter a contribution and designate it to the fund that the donor pledged to, the contribution and pledge should be automatically connected. Notice the **Pledge ID** to the right of the designation and description fields. If the pledge ID is listed here, you know the contribution is connected. If you need to change which pledge is connected to this contribution, use the **Pledge ID** drop down to change the connection.
Note the Pledge ID on the designation line tells us this contribution is connected to her pledge.

All of the donor’s pledges will be listed on the Pledge tab.

Quid Pro Quo

Quid Pro Quo contributions are contributions where something of value was given. For example, if your youth group is selling CD’s as a fundraiser. The CD’s are worth $15. If someone gives the youth group $50 for the CD, you’d want to enter that as a Quid Pro Quo contribution.

To enter this transaction, go to the Donation Entry window and enter the following information:

1. Donor Name or Envelope Number. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

2. Date – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

3. Total Amount – Enter the amount of contribution. In the above example this would be the $50.00.
4. **Check Number** - If the contribution was a check, you may enter the check number in this field.

5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.

6. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

7. Click on the Quid Pro Quo tab. Select the item that was given. Enter the value of the item given. In this example the item was the CD. The value was $15.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to the Batch window.

### Non-Cash/Property Gift Contributions

There are three ways that you can enter an in-kind or property gift in Roll Call.

1. **Donation Type** – Use the donation type method if you’d like to assign a value to the property gift. You will need to use this method if you want to apply this gift towards a pledge.

2. **In-Kind tab** – Use this method if you do not want to assign a value to this gift.

3. **Non-Cash screen** – Use this method if you have a complicated transaction such as stock or real estate where brokerage fees need to be applied.

### Donation Type

To record a property gift using the Donation Type method do the following:

1. **Create a non-cash type batch.**

2. **Click on the plus sign in the lower left.**

3. **Enter Donor Name or Envelope Number.** When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the **last name** then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

4. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

5. **Total Amount** – Enter approximate value of the gift. This amount will be listed on the year end tax statement with an asterisk to indicate that this amount needs to be determined by the donor.

Enter value of *in-kind gift*. Enter *Donation Type* that is classified as “non-cash”.

Enter *description of gift*. 
6. **Donation Type** – Select a donation type that has been defined as a “non-cash” type.
7. **Designation** – Use the drop down list of values to select the fund that these monies were given to.
8. **Description** – Enter a description of the property donated.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to Batch window.

**In Kind tab**

To enter a property gift without having to enter an amount, do the following:

To record a property gift using the *In Kind* tab method do the following:

1. Create a *non-cash* type batch.
2. Click on the **plus** sign in the lower left.
3. Enter **Donor Name or Envelope Number**. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the **Select a Person** window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.
4. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.
5. **Total Amount** – Leave this amount 0.
6. **Donation Type** – Select a donation type that has been defined as a “non-cash” type.
7. Click on the **In Kind** tab. You may enter the amount and designation if you wish. This will be for informational purposes only. The amount will not be used on year-end statements or against pledges.
8. **Description** – enter the description of the property gift. This description will be listed on the donation receipt.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to Batch window.
Non-Cash screen

If you have large property gifts, where you need to track the sale of stock or real estate, use the Non-Cash gift screen.

To record a property gift using the Non-Cash gift screen:
1. Expand the Contributions menu on the left.
2. Expand the Non-Cash Gift menu.
3. Click on Add a Non-Cash Gift.
4. Enter the Gift Date and select Gift Type. Gift types are the donation types that are marked as non cash items.
5. Enter a Description of the gift. When you press tab, the first 20 characters of this description will be copied to Receipt Description. The receipt description is listed on the donation receipt detail. You may modify this description if you’d like.
6. The Status will be set to “Pending”. When the gift is posted and a donation record is created, the status will be automatically changed to “Posted”.
7. Enter the donor’s Last Name and press the tab key. A list of people with that last name will be displayed. Click on the appropriate person to select. Notice the full name and address is displayed under Donor/Address.
8. Enter the Designation or the fund that this gift was given to.
9. Enter the Quantity, Unit Selling Price and $ Value at Sale. Enter the amount of Commission & Fees. The Net Sales Cash Proceeds will be calculated.
10. Enter the Sell Date and the Initials of the person responsible, if applicable.
11. Enter the Contribution JE Date and Initials of the person who made the journal entry, if applicable.
12. Indicate if the Contribution Letter was sent, the Date Letter Sent and Initials of the person who processed the letter.
13. You may enter the Agent, Contact Name and Contact Phone for the agency the processed the sale.
14. Click GIFT COMMENT if you’d like to enter additional comments regarding this gift.
15. Click SAVE and CLOSE. To post, select POST in lower right.

Check Reader

The check reader, approved to work with Roll Call, is the Mag-Tek keyboard wedge device check reader. You may order this from us at 800.554.9116 and we’ll configure it for you.

To begin recording donation, get to the Enter Donation screen.
1. Slide the check through the check reader, with the magnetic numbers on the bottom facing inward.
2. If Roll Call recognizes the account number, the name of the donor and the check number will be displayed. All you need to enter is the Amount and the Designation. Press SAVE & NEW to enter another donation.

3. If Roll Call does not recognize the account number, it will ask you to identify the donor. Enter the Last Name or portion of the last name. A list of all people with that last name will be displayed. Double click to select the appropriate person.

4. Now the account number from the check and the person are linked. The next time you get a check from them, Roll Call will automatically pull up their information.

5. To delete the account number from their record, go to their record under People>Search Profiles. Find the person and double click to open. Open the Contributions tab, then Account tab. Use the (-) to delete the account, or (+) to add a new account.

Import Contributions

If you use a service for online contributions, you can import those contributions into Roll Call. We can import a csv file with the following information in this exact order:
1. Date
2. Last Name
3. First Name
4. Address 1
5. City
6. State
7. Postal Code
8. Amount
9. Fund

The import will create a batch with a contribution for each line in the import file. Each contribution will be assigned a donation type of Credit Card. To find the appropriate donor, we will look for a match on name and address. If no match is found, it will create a person record with the association of IMPORT. If the fund is not found in Roll Call, a giving fund will be created.

To import the contributions, do the following:
1. Expand the Contributions menu on the left side bar.
2. Click on Import.
3. Click on the Import button.
4. Navigate to your csv file that you wish to import, highlight it and click OPEN.
5. You will get a message that the import is complete.
6. The batch window will be displayed for you to review the import.

**Post a Batch**

Posting a batch in Roll Call sets several things in motion. When you post a batch:

1. The batch can NO LONGER be modified, unless reversed (see Modifying Contributions chapter on how to reverse a batch.)
2. If you are using Roll Call Accounting the receipt information will be sent to the accounting system.
3. If you are using Quickbooks or MYOB, you can create your export files as part of the posting process.
4. As part of the post process you can choose to print the batch summary and batch detail report.
5. As part of the post process you can choose to print a deposit slip.

To post a batch do the following:

1. Expand the *Contributions* menu.
2. Click on *Search by Batch*.

From the *Search by Batch* window, highlight one or more batches and click POST.
Mark the reports you’d like to run and the export files you’d like to create.

Click POST to run the reports and post the batch.

3. Highlight one or more batches that need to be posted.
4. Click on POST BATCH button in the lower right of the window.
5. You will be presented with a list of reports to run. Check the options you’d like to print.

**Import deposit to QB or MYOB**

When you post a batch in Roll Call you will be given the option to export for MYOB or Quickbooks. If you marked either box to create an export file, you will be prompted for a folder to create the file in. The file will automatically be named. Next, you will be prompted for the bank account name that you’ll be depositing the money into.

To import the file in Quickbooks, do the following:
1. Open Quickbooks.
2. Select File>Utilities>Import>IIF files.
3. Navigate to the file you just created.
4. You should now have a deposit journal entry representing the batch.

To import the file into MYOB, select File>Import. Navigate to the file you just created. You now have a deposit journal entry that represents this batch.

**Batch Reports**

There are two batch reports available when you post a batch. The first is the Batch Summary report. This report will outline how much was given to each fund in this specific batch. The second report is the Batch Detail report. It will outline each donor and how much was given.

To run these reports, mark the box for Batch Summary and/or Batch Detail after you choose to Post the batch.
The **Batch Detail** lists all donations included in a batch.

### Deposit Slip

When you close a batch there is an option to print a *deposit slip* for the batch. Check the box to print the deposit slip. Click OK.

- **Mark the box to print a deposit slip for the current batch.**
- **If you’d like a deposit slip to include multiple batches, highlight those batches, choose to close, then mark combined.**
- **Lists contributions.**
- **Totals by cash and check.**

---

<table>
<thead>
<tr>
<th>Name</th>
<th>Date</th>
<th>Type</th>
<th>Total</th>
<th>Designation</th>
<th>Check</th>
<th>Enc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gomez, Mike</td>
<td>9/4/2011</td>
<td>Check</td>
<td>$250.00</td>
<td>General</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Sample, Sarah</td>
<td>8/17/2011</td>
<td>Cash</td>
<td>$500.00</td>
<td>General</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Johnson, Mark</td>
<td>9/4/2011</td>
<td>Cash</td>
<td>$999.99</td>
<td>General</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Smith, John</td>
<td>9/3/2011</td>
<td>Cash</td>
<td>$150.00</td>
<td>General</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Brown, Jane</td>
<td>9/5/2011</td>
<td>Cash</td>
<td>$300.00</td>
<td>General</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

The deposit slip includes summaries for cash and check.

**Totals:**
- **Cash:** $2,449.89
- **Check:** $1,807.00
- **Total:** $4,256.89
LOOKING UP CONTRIBUTIONS

Search by Person
To research the contribution data for a specific individual, you can use the Search by Person option under the Contributions menu.

Find By
To use the Find By option, do the following:
1. Expand the Contributions menu.
2. Click on Search by Person.
3. Select your Find By criteria. You can select last name, association, or envelope number.

Click on Search by Person under the Contributions menu.
Then select your Find By criteria.

Double click on the record you’d like to view.

4. Enter your criteria.
5. The people that meet that criteria will be displayed.
6. Double click to view details.

Each contribution is listed on the left.

Choose the type of summary information you’d like to see.
Query Editor

If you need to find a person by criteria other than last name, envelope number, or association, you’ll need to use the query editor. To use this option, do the following:
1. Expand the Contributions menu.
2. Click on the Search by Person menu option.
3. Click on the SEARCH icon.
4. Select the field you’d like to query on.
5. Highlight the comparison operator.
6. Enter the value that you are looking for.
7. Double click on the appropriate person to view their contributions.

Choose the Search by Person menu under Contributions. Then click on SEARCH icon.

Choose table to query in. This drives what fields will be in the list.

Choose comparison and the value you are looking for.

Click QUERY to return people that meet this criteria.

Results

Once you have double clicked on a person’s record, you will get a window that displays all their individual gifts on the left hand side of the screen. To look at the individual contribution record, double click to see the contribution entry.

The right side of the window displays summary information. Use the drop down to select your view. You can choose to view a summary by Year or Overall. The Yearly Summary will show a bar graph by year. The Overall Summary will display the individual’s giving in a pie chart by fund. The Details by Month will show a line graph of giving totals by month. The Details by Week will show a line graph of giving by week.
Each contribution is listed on the left.

Choose the type of summary information you’d like to see.

The **Summary Overall** shows giving over all time by fund.

The **Details by Month** shows a line graph of giving by month.

The **Details by Week** shows a graph of giving for the last 12 weeks.
Search by Batch

To research the contribution data for a specific batch, you can use the **Search by Batch** option under the **Contributions** menu.

**Find By**

To use the **Find By** option, do the following:

1. Expand the **Contributions** menu.
2. Click on **Search by Batch**.
3. Select your **Find By** criteria. You find batches based on date, fund, description or year.
4. Enter your criteria.
5. The batches that meet the criteria will be displayed.
6. Double click to view details.

**Query Editor**

If you need to find a batch by criteria other than the fields listed in the **Find By** drop down, you’ll need to use the query editor. To use this option, do the following:

1. Expand the **Contributions** menu.
2. Click on the **Search by Person** menu option.
3. Click on the SEARCH icon.
4. Select the field you’d like to query on.
Click on Search by Batch, then click on the SEARCH icon.

Choose table to query in. This drives what fields will be in the list.

Choose comparison and the value you are looking for.

Click QUERY to return people that meet this criteria.

5. Highlight the comparison operator.
6. Enter the value that you are looking for.
7. Double click on the appropriate batch to view the details.

Results
Once you have double clicked on batch, the batch window will be displayed. To view the details for a specific contribution, double click on it.

In People Profile
If you are working the People screen, you can view the contributions for that individual. To view contributions within an individual’s record, do the following:
1. Expand the People menu.
2. Click on Search Profiles.
3. Use the Find By to select your criteria to find the person.
4. Double click on the record of the person you are interested in.
5. Click on the Contributions tab.
6. Use the display option to select how you’d like the contributions displayed. The choices are Summary by Year, Overall Summary, Detail by Month and Detail by Week.
Summary by Year charts the giving for each year.

Summary totals for each year are displayed.

The Summary Overall charts all giving and charts it by Fund.

Totals by Fund are listed on the right side.

Details by Month charts giving by the last 12 months.

Detailed contributions are listed on the right side. Double click to view contribution record.
Details by Week charts the last 12 weeks giving.

All contributions are listed on the right. Double click to view contribution record.
MODIFYING CONTRIBUTIONS

Open Batches
If a batch has not been posted, you can add contributions to that batch and you can make corrections to individual contributions in that batch.

Add Contributions to Existing Batch
To add contributions to an existing batch, find the batch by selecting Search by Batch under the Contributions menu. Double click on the batch you need to modify. From the batch window, click on the plus sign in the lower left to start adding new contributions.

Correct a Contribution
To correct a contribution that has already been recorded in Roll Call, you will need to find that specific contribution. If you know the batch it was in, click on Search by Batch under the Contributions menu. Double click on the batch. Double click on the specific contribution.

If you know the person that made the contribution, select Search by Person under the Contributions menu. Double click on the appropriate person. Find the contributions on the left side, double click on it. Make the necessary changes.
You can change the date, amount, type and check number.

You can modify the designation by using the drop down box.

To change the total amount, date, or type, place your cursor in the field and make the correction. To change the fund it was designated to, use the drop down to the right of designation and choose the correct fund.

To change the donor, click on the TRANSFER button and enter the last name for the correct donor. Select the appropriate person from the list.

Click SAVE & CLOSE to save the changes to the contributions record and return to the Search screen.

**Posted Batches**

Corrections are not allowed to posted batches. If errors were made in the batch, you will need to reverse the batch, make the correction, then re-post the batch.

**Reverse the Batch**

When you reverse a batch, a reversing journal entry will be written in the Roll Call Accounting system. Then the status of the batch will change to un-posted. At this point you can make corrections to the batch.

To reverse the batch, do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Highlight the batch that needs to be reversed.
4. Click the REVERSE button.
You may also reverse from the batch window:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Double click the batch that needs to be reversed.
4. Click the REVERSE button.

Correct the Contribution

Now that the batch is “un-posted”, you can make corrections to existing contributions or add contributions to the batch. To correct a contribution that has already been recorded in Roll Call, you will need to find that specific contribution. Click on Search by Batch under the Contributions menu. Double click on the batch. Double click on the specific contribution.

To change the total amount, date, or type, place your cursor in the field and make the correction. To change the fund it was designated to, use the drop down to the right of designation and choose the correct fund.

To change the donor, click on the TRANSFER button and enter the last name for the correct donor. Select the appropriate person from the list.

Click SAVE & CLOSE to save the changes to the contributions record and return to the Search screen.

Re-post the Batch

Once you have corrected the batch, you will need to post it, to send the information over to Roll Call Accounting. To post the batch:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Highlight one or more batches that need to be posted.
4. Click on POST BATCH button in the lower right of the window.
5. You will be presented with a list of reports to run, check the options you’d like to print.

Transfer Contributions

If a contribution was assigned to the wrong donor, you can transfer the contribution to the correct donor at any time. You can do this for posted and un-posted batches.
A single contribution
To transfer a contribution that has already been recorded in Roll Call, you will need to find that specific contribution. If you know the batch it was in, click on Search by Batch under the Contributions menu. Double click on the batch. Double click on the specific contribution.

If you know the person that the contribution is under, select Search by Person under the Contributions menu. Double click on the appropriate person. Find the contributions on the left side, double click on it.

To change the donor, click on the TRANSFER button and enter the last name for the correct donor. Select the appropriate person from the list.

Multiple contributions
A good example of having to transfer multiple contributions from one person to another, would be from a wife to the husband. Another example might be person with the same name. To transfer multiple donations at once, do the following:
1. Expand the People menu on the left.
2. Click on Search Profiles.
3. Find the person who currently has the contributions.
4. Double click on their record.
5. Click on the Contributions tab.
6. Change the view to Detail by Month or Detail by Week.
7. Highlight one or more contributions that need to be transferred.
8. Right mouse click and press Select All; right mouse click again and select Transfer.
9. Enter the last name of the correct donor.
10. Select the appropriate person.

Open the record for the person you are transferring donations from.
Click on Contributions tab.
Change view to Detail by week or month.

Enter the last name or portion of the last name.

Select the appropriate person to transfer donations to.

**Delete Contributions**

Contributions can be deleted from an un-posted batch. The contribution can be deleted from the batch window or from the individual contribution screen.

To delete one or more contributions from the batch window, do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Use the Find By to select your criteria to find the batch.
4. Double click on the batch you need to delete from.
5. Highlight one or more contributions.
6. Click on the minus sign.

To delete a contribution from the contribution window, do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Double click on the batch you need to delete from.
4. Double click on the specific contribution you need to delete.
5. Click on the DELETE button.
Highlight the contributions you need to delete.

Click on minus sign.

From the individual donation record, click DELETE.
RECURRING DONATIONS

Recurring Donation Process

A recurring donation exists when a donor arranges for online giving at regular intervals through your website or through “bill pay” at his bank. To record this regular online giving, you may set up recurring donation entries in Roll Call. This will save you from having to enter these donations manually. Roll Call will automatically create the contribution record on the appropriate day.

The recurring donation process in Roll Call is as follows:
1. A recurring donation entry is added in Roll Call.
2. On the specified date or day (based on interval) a donation record is automatically created in Roll Call.
3. An email is sent to the “donation administrator” that this has occurred.
4. The donation administrator can review the batch and decide whether or not to post the batch.

Recurring Donation Preferences

Defaults

To speed up the data entry process for recurring donations, you can set the default designation as well as the default days for the recurring donation. These defaults will be used when you add a new recurring donation entry. These defaults can be changed. Also, enter the email information for recurring donation notifications.

Email notification

To enter the recurring donation preferences, expand the Contributions menu. Next, expand the Recurring Contributions menu. Click Search, then click the Preferences icon in the upper right. Select the Default Designation for recurring donations as well as the Default Days. Next, enter the email address for the folks who need to be notified when recurring donations have been posted. Also enter your outgoing email host information.
Find Recurring Contribution Profiles
To view all your recurring donation profiles expand the Recurring Donations menu. All profiles will be displayed.

Find By
To view the recurring donation profiles for a specific donor, designation, frequency, day, creation date or status, select Recurring Contributions under the Contributions menu on the left side bar. Select the Find By criteria. Enter the value you wish to view. Press return.

To view the details of a specific profile, double click on the record in the summary list. From this window, you can scroll through the list of recurring donations from the summary list by clicking on the Next and Previous links.

Query
If you would like to view the recurring donation profiles based on a criteria that is not included in the Find By drop down box, you can use the query editor. Click the SEARCH database icon. Perform the query for the criteria you are interested in. See “Using the Query Editor” for more information on creating custom queries.

Click on Search under the Recurring Contribution menu.

Choose your find by criteria. Enter the value you are looking for.

Click NEXT to go to next profile from the list in your search screen.
Create Recurring Donation Profile

To enter a new recurring donation profile, click Add Recurring from the Recurring Contributions menu.

1. Enter the donor’s Last Name and press the tab key. A list of people with that last name will be displayed. Click on the appropriate person to select. Notice the full name and address is displayed under Donor/Address.
2. Enter the Designation. The designation is the fund that the person is donating to.
3. Select the Status. The options for status are active or inactive. Donation entries will only be created for active recurring donations.
4. Enter the Amount of the donation.
5. Enter the Frequency of the recurring donation. If the donor wishes to make this donation once per month, select Monthly. If the donor wishes to make this donation twice a month, select Bimonthly. If the donor wishes to make this donation each week, select Weekly.
6. Enter the value for Day 1 and Day 2, if applicable. If the frequency is monthly, enter the day of the month that the donation should be posted in Day 1. If the frequency is Bimonthly, enter the two days that the donation should be posted in Day 1 and Day 2. If the frequency is weekly, do not enter any value in Day 1 or Day 2.
7. Enter the Day of Week for profiles that are weekly donations.
8. Enter the Start Date. This is the effective date for recurring donation processing. Donations will not be created before this date.
9. Click SAVE & CLOSE to save this profile and return to the Summary window. Click SAVE & NEW to save and enter a new profile. Enter CANCEL to ignore the data entered and return to the Summary window.

Posting the Recurring Donations

When a Recurring Contribution is posted, that means it becomes a contribution record. This is different than the posting a batch. Under normal circumstances, recurring donations are posted automatically by Roll Call. They can also be posted manually by a user, if need be. When recurring donations are posted, a batch is created and specific donation records are created in that batch. The donation administrator will be notified via email that recurring donations have been posted.

Automatically

Each morning, Roll Call evaluates the active recurring donations profiles to determine if they need to be posted on today’s date. When a recurring donation is posted, a batch is created with all the donations that are to be created for that day. As an example, let’s say we have 10 monthly recurring donations that are to post on the 15th. Also, we have two weekly donations that are set up to post on Fridays. In our example, the 15th falls on a Friday. At around 2:00 a.m. on the 15th, the recurring donation process will create a batch that includes the 10 monthly donations as well as the two Friday donations.
This is the normal processing for recurring donations. You need to leave Roll Call running overnight for this processing to occur. If for some reason the system is down, Roll Call will evaluate recurring donations based on the last time the process was run when it comes back up.

**Manual**

You can also manually post recurring donations. You may need to do this if you enter the recurring donation profile, after the processing for that day has taken place. For example, if you enter a recurring donation for the 15th of each month on the 15th. The processing for the 15th has already occurred, so that donation will not post automatically until next month on the 15th.

To post a recurring donation, select Search under the Recurring Contributions menu. Find and highlight the donations that need to be posted. Click POST in the lower right of the window.

**Stopping the Recurring Donation**

If a donor decides they no longer want to automatically contribute on a certain day, you’ll need to end that recurring donation. To do that, click Search under the Recurring Contribution menu. Find the donation that needs to be stopped. Double click on it. Change the status to inactive. Note the end date will change to today’s date.
CREATING CONTRIBUTION RECEIPTS
(STATEMENTS)

Contribution Receipt Process
The flow for creating contribution statements is as follows:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose your receipt type on the Criteria tab.
4. Mark the applicable items on the Criteria tab.
5. Click on the View People tab to see all the folks that will be receiving a statement.
6. Click on the Receipt Text tab. Customize your text areas.
7. Click PRINT RECEIPTS to print the statements or click EMAIL to email the receipts.

Contribution Statement Formats
To begin the process of creating the contribution receipts, you’ll need to choose the type of contribution statement.

Quarterly
The Quarterly Statement is for a single quarter. It will list either summary information or detail all the contributions made in that quarter.
Quarterly Tabular
The Quarterly Tabular receipt shows weekly giving for the quarter. Pledge information is displayed at the bottom of the receipt.

Weekly giving amounts listed under each month.

Annual
The Annual Statement summarizes all giving for the year. The statement can show totals by fund or just a grand total. You can also list all contributions for the year as well. Pledge information can be displayed on this receipt.

Annual statement for 2011. Includes all detail and also pledge information.
Canadian

The Canadian receipts show total giving for the year. The information required by the government in Canada is included on this receipt.

A Canadian receipt in triplicate. Original on top and 2 copies.

Individual Gift

This receipt is for a single contribution.

The receipt for a single contribution.
Quarterly Statements

To create quarterly receipts, do the following:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose Quarterly Receipt from the Receipt Type drop down area.

Criteria

When you choose Bulk Receipts, the Contribution Receipts window will be displayed. You will be anchored on the Criteria tab. From this tab, you can choose the type of receipt you want and what information should be displayed on the report.

Enter the following information:
1. Year - Indicate the year that these receipts are for.
2. Quarter – Indicate which quarter you are interested in.
3. Period Starting - This date is defaulted to the beginning of the quarter or year you selected. These dates may be changed.
4. Period Ending. This date is defaulted to the end of the quarter or year you selected. This date may be changed.
5. Total Giving for Period Over – If you only want to produce statements for folks who gave over a certain amount, enter that amount here.

Select Bulk Receipts under the Contributions menu.

Indicate if you’d like all contributions listed or just totals.

Mark if you’d like to include pledge information on the statement.

Choose quarterly as the receipt type. Choose applicable quarter and year.

Details

1. From the Details tab, select the people to include: All pledgers, those who gave in a specific period, those who didn’t give in the period but have given, or those who haven’t given.
2. Next, decide the pledge Summary Details to consider. The fund and pledge total are already chosen for you. You can also include what’s been received to date (rec’d to date), what’s been received this period (rec’d this period), the pledge starting and ending dates, and the frequency of their gift.

Print Options

1. Single Print Job- The first option to consider is Single Print Job. If you choose this option, all the pledge summary letters are sent to the printer at once, as you are sending
it all as one document. If you want to duplex, turn this option off.

2. Cover Letter- if you would like the option to create and print a cover letter to go along with your Pledge Summary Letter, select this option.

3. Print on Stationary- If you would like to print on your own stationary, this will automatically take out the church address information. You will have the option from here to Use Own Letterhead, and First Page Only. You can customize this further to fit your letterhead by selecting the Customize tab.

4. Show Envelope Number- Select this option to show the envelope number of the pledger.

5. Exclude- You can choose to exclude people who have Bad Address or Do Not Send Mail marked in their people record.

Customize

1. Top Margin- You can set your top margins here.

2. Organization starts on line # - This will allow you to choose which line on the letter you would like your Organization or Church name to appear.

3. Address starts on line # - This will allow you to choose which line on the letter you would like your Organization or Church address to appear.

4. Body starts on line # - This will allow you to choose which line on your letter you would like the progress letter information to start on.

5. Customize font- if you would like to change the font style, select from the dropdown menu.

6. Font size- If you would like to change the font size, select from the dropdown menu.

Receipt Text

There are seven different types of “text” that can be used to customize your receipt. They are as follows:

1. Top Text – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have large thank you note, we recommend you use the cover letter section.

2. Cover Letter – The cover letter is a 1 page letter that will be printed before each statement.

3. Bottom Text – The bottom text area is used as footer text. It typically indicates no goods or services were received.

4. NonCashGifts – if the donor had any non-cash gifts where an amount was assigned
to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbiage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.

5. **Third Party Gift** – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receiving them.

6. **QPQ Gifts** – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.

7. **In Kind Gift** – if you have a property donation where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

8. **Org. letterhead** - Org. Letterhead- If you have a logo you would like to pull into the letterhead area to be printed on the Pledge Progress Letter, pull it in here. You must have it marked under Criteria>Print Options>Print on Stationary>Use Org. Letterhead for this to print.

To enter the text you’d like displayed on the statement, do the following:

1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it, as appropriate.
Click on the Receipt text tab.

Click on the type of text you’d like to customize.

To include the church name and address and/or donors name and address on the cover letter text, place your cursor in the position that you want a field, for example, “addressed to”. Then choose that information from the Insert Function drop down box on the lower section of the word processor.

Click on View People tab.

Click PRINT RECEIPTS to print receipts for everyone in the list.

Click EMAIL to email receipts to everyone that has email checked.

View People

The View People tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.

Printing/emailing your receipt

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.
If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status, highlight everyone you’d like to email a statement, then click SEND EMAIL.

**Quarterly Tabular Statements**

To create quarterly tabular receipts, do the following:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose *Quarterly (tabular) Receipt* from the Receipt Type drop down area.

**Criteria**

When you choose Bulk Receipts, the Contribution Receipt window will be displayed. You will be anchored on the Criteria tab.

Enter the following information:
1. *Year* - Indicate the year that these receipts are for.
2. *Quarter* – Indicate which quarter you are interested in.
3. *Special Gifts* – Indicate which funds should be listed on the right side as “special gifts”. All other funds will be listed in the main section of the report.

Choose *quarterly tabular* as the format.

Choose *fund* that should be included in Selected column.

Mark if you’d like to *exclude bad addresses or do not send addresses*.

**Custom Options** info goes here.

4. *Exclude Pledge Info* – mark this box if you do not want pledge information listed at the bottom of the report.
5. *Exclude* – mark the appropriate box if you do not want a receipt for folks whose address is marked as “bad address” or “do not send mail”.
6. *Sort* – indicate how you’d like the receipts ordered… by name or zip code.

**Text**

The standard text areas do not apply to the tabular receipt. Any text entered will not be used on the tabular statement.

**Custom Options**

In this receipt, you can choose the Gifts Totals Title, and the Total Budget Title. You can also add some limited Custom Text, but only if you exclude any pledge info.
**View People**

The *View People* tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.

**Printing your receipt**

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.

If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status, highlight everyone you’d like to email a statement, then click SEND EMAIL.

**Annual Statements**

To create quarterly receipts, do the following:

1. Expand the *Contributions* menu.
2. Click on the *Bulk Receipts* menu item. The *Contribution Receipts* window will be displayed.
3. Choose *Annual Receipt* from the *Receipt Type* drop down area.

**Criteria**

From this tab, you can choose the type of receipt you want and what information should be displayed on the report.

- Choose *annual*, select *year* and confirm *date range*.
- Choose *totals only*, *summary by fund* and whether or not to list all contributions.
- Choose to *include pledge* information.

Enter the following information:

1. *Year* - Indicate the year that these receipts are for.
2. *Period Starting* - This date is defaulted to the beginning of the year you selected. These dates may be changed.
3. *Period Ending* - This date is defaulted to the end of year you selected. This date may be changed.
4. **Total Giving for Period Over** – If you only want to produce statements for folks who gave over a certain amount, enter that amount here.

**Details**

1. From the Details tab, select the people to include: *All pledgers*, those who *gave in a specific period*, those who *didn’t give in the period but have given*, or those who *haven’t given*.
2. Next, decide the pledge Summary Details to consider. The *fund and pledge total* are already chosen for you. You can also include what’s been *received to date* (rec’d to date), what’s been *received this period* (rec’d this period), the pledge *starting and ending dates*, and the *frequency* of their gift.

**Print Options**

1. *Single Print Job* - The first option to consider is *Single Print Job*. If you choose this option, all the pledge summary letters are sent to the printer at once, as you are sending it all as one document. If you want to duplex, turn this option off.
2. *Cover Letter* - if you would like the option to create and print a cover letter to go along with your Pledge Summary Letter, select this option.
3. *Print on Stationary* - If you would like to print on your own stationary, this will automatically take out the church address information. You will have the option from here to Use Own Letterhead, and First Page Only.
   You can customize this further to fit your letterhead by selecting the Customize tab.
4. *Show Envelope Number* - Select this option to show the envelope number of the pledger.
5. *Sorted by* - use the dropdown to change the sort order.
6. *Exclude* - You can choose to exclude people who have *Bad Address* or *Do Not Send Mail* marked in their people record.

**Customize**

1. *Top Margin* - You can set your top margins here.
2. *Organization starts on line #* - This will allow you to choose which line on the letter you would like your Organization or Church name to appear.
3. *Address starts on line #* - This will allow you to choose which line on the letter you would like your Organization or Church address to appear.
4. *Body starts on line #* - This will allow you to choose which line on your letter you would like the progress letter information to start on.
5. *Customize font* - if you would like to change the font style, select from the dropdown menu.
6. *Font size* - If you would like to change the font size, select from the dropdown menu

**Receipt Text**

There are seven different types of “text” that can be used to customize your receipt. They are as follows:

1. *Top Text* – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have large thank you note, we recommend you use the cover letter section.
2. *Cover Letter* – The cover letter is a 1 page letter that will be printed before each statement.
3. *Bottom Text* – The bottom text area is used as footer text. It typically indicates no goods or services were received.
4. *NonCashGifts* – if the donor had any non-cash gifts where an amount was assigned
to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbiage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.

5. Third Party Gift – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receipting them.

6. QPQ Gifts – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.

7. In Kind Gift – if you have a property donation where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

8. Org. Letterhead- If you have a logo you would like to pull into the letterhead area to be printed on the Pledge Progress Letter, pull it in here. You must have it marked under Criteria>Print Options>Print on Stationary>Use Org. Letterhead for this to print.

To enter the text you’d like displayed on the statement, do the following:
1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it, as appropriate.

To include the church name and address and/or donors name and address on the cover letter text, place your cursor in the position that you want a field, for example “addressed to”. Then choose that information from the Insert Function drop down box on the lower section of the word processor.
View People

The View People tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.

Printing/emailing your receipt

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.

If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status, highlight everyone you’d like to email a statement, then click SEND EMAIL.

Canadian Receipts

The Canadian receipts are 1/3 page receipts. They can be printed 1 per page or in triplicate. They summarize the donations for previous year. There can be only one “original” receipt printed, each subsequent print has the word “copy” on it. There are three types of Canadian receipts:
1. Check or cash gifts
2. Cash gifts with advantage (Quid Pro Quo)
3. Non-cash or property gifts (In Kind gifts)

Printing Canadian receipts

To print Canadian receipts expand the Contributions menu. Click on Bulk Receipts. From criteria window select Canadian Receipts.

Select Period

1. Select the year for which you’ll be printing the receipts. Once you choose the year, the starting and ending dates will be filled in. These dates may be changed.
**Print options**

1. If you would like to print a sample receipt, mark the *Sample* box. This uses sample data. It is used primarily for lining up paper and viewing the format.

2. If you would like to use the receipt text, from Contributions>Receipt Text, mark the *Receipt Text* box in the *Print Options* area.

3. Select either a single copy or triplicate within the *Print Options* box. If you select “single”, only one receipt will be printed for each donor. If you select triplicate, 3 receipts will be printed. One will be the “original”, the other 2 will be labeled “copy”.

4. Indicate the type of labels you’d like to print in the *Print Option* area. If you do not want to print labels, select none. If you are printing on labels that are 3 across and 10 down, select Avery 5160 labels. If you would like to create a custom size and format, select custom. See “Creating Custom Labels” for more details.

**Sort options**

1. If you would like to have the receipts printed in alphabetical order, select *Last Name* in the Sort options box. If you would like to print the receipts in postal code order, select *Postal Code* in the *Sort Options* box.

**Reprint Options**

1. Many times receipts must be re-printed for various reasons (they get lost, the printer jams, or they get lost in the mail). If you need a copy of a receipt that has already been printed, select “Reprint”. If you need a second “original”, select “Original”.

2. If you would like to print labels only, select the type of label from the Print Options area, then mark “Labels only”.

**Signature**

1. Enter the *Name* of the person authorized to sign the receipt.

2. Enter the *Location* at which is issuing the receipt.

3. Click on the *Add Image* button to upload an electronic signature.

4. Click on the *View Image* to view your electronic signature.

5. Click on the the *Clear* button to start over or clear out your electronic signature.

Once this information is entered, click PRINT RECEIPTS to print the receipts.

**Individual Gifts**

Individual gift receipts are receipts for a single contribution. To create these receipts, do
the following:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose Individual from the Receipt Type drop down.

Criteria
From this tab, you can choose the type of receipt you want and what information should be displayed on the report.

Enter the following information:
1. Year - Indicate the year that these receipts are for.
2. Quarter – Indicate the quarter for these receipts.
3. Period Starting - The date range for these receipts is typically 1 day.
4. Period Ending:  The date range for these receipts is typically 1 day.
5. Total Giving for Period Over –If you only want to produce statements for folks who gave over a certain amount, enter that amount here.

Details
1. From the Details tab, select the people to include: All pledgers, those who gave in a specific period, those who didn’t give in the period but have given, or those who haven’t given.
2. Next, decide the pledge Summary Details to consider. The fund and pledge total are already chosen for you. You can also include what’s been received to date (rec’d to date), what’s been received this period (rec’d this period), the pledge starting and ending dates, and the frequency of their gift.

Print Options
1. Single Print Job- The first option to consider is Single Print Job. If you choose this option, all the pledge summary letters are sent to the printer at once, as you are sending it all as one document. If you want to duplex, turn this option off.
2. Cover Letter- if you would like the option to create and print a cover letter to go along with your Pledge Summary Letter, select this option.
3. Print on Stationary- If you would like to print on your own stationary, this will automatically take out the church address information. You will have the option from here to Use Own Letterhead, and First Page Only.
   You can customize this further to fit your letterhead by selecting the Customize tab.
4. Show Envelope Number- Select this option to show the envelope number of the pledger.
5. Sorted by- use the dropdown to change the sort order.
6. Exclude- You can choose to exclude people who have Bad Address or Do Not Send Mail marked in their people record.

Receipt Text
There are seven different types of “text” that can be used to customize your receipt. They are as follows:
1. Top Text – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have large thank you note, we recommend you use the cover letter section.
2. Cover Letter – The cover letter is a 1 page letter that will be printed before each statement.
3. **Bottom Text** – The bottom text area is used as footer text. It typically indicates no goods or services were received.

4. **NonCashGifts** – if the donor had any non-cash gifts where an amount was assigned to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbiage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.

5. **Third Party Gift** – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receiving them.

6. **QPQ Gifts** – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.

7. **In Kind Gift** – if you have a property donation where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

8. **Org. Letterhead** - If you have a logo you would like to pull into the letterhead area to be printed on the Pledge Progress Letter, pull it in here. You must have it marked under Criteria->Print Options->Print on Stationary->Use Org. Letterhead for this to print.

To enter the text you’d like displayed on the statement, do the following:
1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it, as appropriate.

To include the church name and address and/or donors name and address on the cover
letter text, place your cursor in the position that you want a field, for example “addressed to”. Then choose that information from the Insert Function drop down box on the lower section of the word processor.

**View People**

The View People tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.

**Printing/emailing your receipt**

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.

If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status, highlight everyone you’d like to email a statement, then click SEND EMAIL.

**Statement for a Specific Person**

To print a receipt for a specific individual, do the following:

1. Expand the Contributions menu.
2. Click on the Personal Receipts menu item. The Select a Person window will be displayed.
3. Enter the last name of the individual, select from the list or further refine by entering the first name.

**Criteria**

From this tab, you can choose the type of receipt you want and what information should be displayed on the report.
Enter the following information:
1. **Year** - Indicate the year that these receipts are for.
2. **Quarter** – Indicate the quarter for these receipts.
3. **Period Starting** - The date range for these receipts is typically 1 day.
4. **Period Ending**. The date range for these receipts is typically 1 day.
5. **Total Giving for Period Over** – If you only want to produce statements for folks who gave over a certain amount, enter that amount here.

**Details**
1. From the Details tab, select the people to include: *All pledgers*, those who *gave in a specific period*, those would *didn’t give in the period but have given*, or those who *haven’t given*.
2. Next, decide the pledge Summary Details to consider. The *fund* and *pledge total* are already chosen for you. You can also include what’s been *received to date* (rec’d to date), what’s been *received this period* (rec’d this period), the *pledge starting and ending dates*, and the *frequency* of their gift.

**Print Options**
1. **Single Print Job**- The first option to consider is *Single Print Job*. If you choose this option, all the pledge summary letters are sent to the printer at once, as you are sending it all as one document. If you want to duplex, turn this option off.
2. **Cover Letter**- if you would like the option to create and print a cover letter to go along with your Pledge Summary Letter, select this option.
3. **Print on Stationary**- If you would like to print on your own stationary, this will automatically take out the church address information. You will have the option from here to *Use Own Letterhead*, and *First Page Only*.
   You can customize this further to fit your letterhead by selecting the *Customize* tab.
4. **Show Envelope Number**- Select this option to show the envelope number of the pledger.
5. **Sorted by**- use the dropdown to change the sort order.
6. **Exclude**- You can choose to exclude people who have *Bad Address* or *Do Not Send Mail* marked in their people record.

**Receipt Text**
There are seven different types of “text” that can be used to customize your receipt. They are as follows:
1. **Top Text** – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have a large thank you note, we recommend you use the cover letter section.
2. **Cover Letter** – The cover letter is a 1 page letter that will be printed before each statement.
3. **Bottom Text** – The bottom text area is used as footer text. It typically indicates no goods or services were received.
4. **NonCashGifts** – if the donor had any non-cash gifts where an amount was assigned to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbiage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.
5. **Third Party Gift** – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for
receipting them.

6. **QPQ Gifts** – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.

7. **In Kind Gift** – if you have a property donation where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

8. **Org. Letterhead** – If you have a logo you would like to pull into the letterhead area to be printed on the Pledge Progress Letter, pull it in here. You must have it marked under Criteria>Print Options>Print on Stationary>Use Org. Letterhead for this to print.

To enter the text you’d like displayed on the statement, do the following:

1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it, as appropriate.

To include the church name and address and/or donors name and address on the cover letter text, place your cursor in the position that you want a field, for example “addressed to”. Then choose that information from the Insert Function drop down box on the lower section of the word processor.

**Printing/emailing your receipt**

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.

If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The
Email Receipts

If you’d like to email contribution statements, there are several things that need to be in place first:

1. If you are not using a Mac, you will need to download and install the PDF CREATOR print driver. You can do that from: [http://sourceforge.net/projects/pdfcreator](http://sourceforge.net/projects/pdfcreator).
2. Make sure “My Email” is set up correctly in Roll Call.
3. For the people that would like to get an emailed receipt, mark that preference under by entering their record and opening the contributions tab and the settings tab. Select Email Receipt.

Install the Print Driver

To email receipts from a Windows machine, download the print driver from [http://sourceforge.net/projects/pdfcreator](http://sourceforge.net/projects/pdfcreator).

1. Click on the **Download Now** button.
2. Select Run.
3. Select Run again.
4. Follow the on screen directions to install.

Once you have the software installed, you will notice a PDF CREATOR print driver in your list of printers.

My Email

To email receipts from Roll Call make sure you have your outgoing email host information set up. To enter this information, expand the Home menu. Choose my Email settings. Enter the following information.

1. **Return address** – the email will be “from” this address. If the recipient hits reply, this is the address that would receive the reply.
2. **SMTP Outgoing Host** – Determine your email host’s outgoing SMTP address. Contact your email provider for this information.
3. **User Name/Password** – If your outgoing email provider requires authentication, enter the user name and password.
4. **Port Number** – Some providers require you to use a specific port number for large email jobs. Contact your provider for this information.
5. **SSL** – If your provider requires SSL encryption, mark this box.
6. Click **SAVE** to save these settings.
Set Email Setting in Profiles

For the people who would like to receive their receipt via email, mark the setting in their profile. Find their record, click on the Contributions tab, then click on the Settings tab. Mark Email Receipt.

Click on the Contributions, Settings tab in the person’s profile.

Choose the option for Email Receipts.

The email setting can also be entered from the View People tab when you are creating donation receipts.

Email Receipts

To email receipts from Roll Call, click on the EMAIL RECEIPT button. All donors who have “email” marked will be sent an email with their statement as an attachment. The send email window will be displayed. Enter the subject of the email and a comment in the body of the email. The statement will be a pdf attachment.

If you like to email receipts to people regardless of the “email” setting, highlight all the people in the View People tab that you’d like to email. Click EMAIL RECEIPTS. This will email to everyone you have highlighted.
Highlight the people you’d like to email to. Click EMAIL.

Married Couples filing Individually

By default, Roll Call will combine contributions for a Husband and Wife into one receipt. If the couple files separately and wants separate receipts, set the “files individually” setting in their profile.

1. Use Search Profiles to find the person who wants a separate receipt.
2. Click on the Contributions tab.
3. Click on the Settings tab.
4. Mark the option for “file individually”.

Click on Settings tab under the Contributions tab.

Mark the option for filing separately.

Shows first donation date and last donation date.
CREATING CONTRIBUTION REPORTS

To run the standard donation reports,
1. Expand the Contributions menu and click Reports OR
2. Select Reports from the Top menu and select Contribution Reports.

Select Contribution reports from top Reports menu.

Select reports under the Contribution menu on the Navigator.

From this Report window, all the reports are listed on the left side. There are also three tabs across the top: Criteria, Columns and View Records. The Criteria tab allows you to enter the date range and select who you want to include in the report as well as which funds to include in the report. The Columns tab allows you to choose what data or fields you want displayed on the report. The View Records shows you which people will be included in the report based on your criteria.

Donor Detail Report

The Donor Detail report outlines all donations for a given time period, for the funds you are interested in, for the people you are interested in. To run the Donor Detail report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Detail on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are
interested in including on this report.
5. Click on the **Columns** tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the **Selected** column. You can rearrange the ordering in the **Selected** column by dragging and dropping in the order you wish to see them in the report.
6. If you’d like to change the sort order, move the columns from the **Selected** column to the **Sort** column.
7. Click **GENERATE**.

In our first example, let’s say we’d like a donor report for all donors (we don’t care what their association is) and we want to know all of their donations for all funds. On this report we want to see donor name, email address, donation date and amount.

1. Highlight **Donor Detail** on the left sidebar.
2. From the **Criteria** tab, select “This Week” from the date range drop down.
3. Click on the **Who** tab. Leave “Everyone” selected.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.
5. Click on the **What** tab. Click the double arrow to move all funds to the **Selected** column.
6. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well.
7. Click on the **Columns** tab. Drag the email, address, city and state fields from the left
side column to the *Selected* column on the report.

8. Click GENERATE to produce the report.

In this next example, let’s say we’d like a donor report for all members who have given to the building fund. On this report we want to see donor name, address, donation date, fund and amount.

1. Highlight *Donation Detail* on the left sidebar.
2. From the *Criteria* tab, select “This Month” from the date range drop down.
3. Click on the *Who* tab. Select Association from the “Run for” drop down box. Click on *Member* to move that value to the *Selected* column.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.
5. Click on the *What* tab. Click on *Building* to move that fund to the *Selected* column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
7. Click on the *Columns* tab. Drag address, city and state fields from the left side column to the *Selected* column on the report.
8. Click GENERATE to produce the report.
Select Members as the folks you want in the report.

Select Building fund as the fund to consider for the report.

Members who gave to the building fund.

Donor Summary Report

The Donor Summary report calculates the amount given by the donor for all the funds selected for the given time period. To run the Donation Summary report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Summary on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the
report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.

5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.

6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.

7. Click GENERATE.

In our first example, let’s say we’d like a Donor Summary report for all donors and we want a total of all of their donations for the given time period. On this report we want to see donor name, email, total giving, and number of gifts.

1. Highlight Donor Summary on the left sidebar.
2. From the Criteria tab, select “This Quarter” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.
5. Click on the What tab. Click the double arrow to move all funds to the Selected column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in
the report as well.
7. Click on the Columns tab. Drag the email field from the left side column to the Selected column on the report.
8. Click GENERATE to produce the report.

In this next example, let’s say we’d like a Donor Summary report for all members who have given to the building fund. On this report we want to see donor name, address, total, number of gifts and average gift.
1. Highlight Donor Summary on the left sidebar.
2. From the Criteria tab, select “This Month” from the date range drop down.
3. Click on the Who tab. Select Association from the “Run for” drop down box. Click on Member to move that value to the Selected column.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.
5. Click on the What tab. Click on Building to move that fund to the Selected column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
7. Click on the Columns tab. Drag address, city and state fields from the left side column to the Selected column on the report.
8. Click GENERATE to produce the report.
Donor Summary by Fund

The Donor Summary by Fund report calculates the amount given to each fund by the donor for the given time period. To run the Donor Summary by Fund report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Summary by Fund on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
7. Click GENERATE.

In our first example, let’s say we’d like a Donor Summary by Fund report for all donors and we want a total of all of their donations for the given time period. On this report we want to see donor name, email, amount, and number of gifts.

1. Highlight Donor Summary by Fund on the left sidebar.
2. From the Criteria tab, select “This Month” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.
5. Click on the What tab. Click the double arrow to move all funds to the Selected column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
7. Click on the *Columns* tab. Drag the email field from the left side column to the *Selected* column on the report.
8. Click GENERATE to produce the report.

**Donor Giving by Week, Month or Year**

The *Donor Giving* summarizes how much a donor gave by week, month or year in a spreadsheet format. The weeks, months or years are listed across the top of the spreadsheet for the time frame you selected.

To run this report:
1. Expand the *Contributions* menu.
2. Click on *Reports*.
3. Click *Donor Giving* on the left sidebar.
4. Click on the *Criteria* tab. From the criteria tab, select the date range that you wish for this report. Next, select the *Report Type*: by Week, by Month or by Year. Then under the *Who* tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc. Once you’ve chosen who, click on the *What* tab. From here, select the funds you are interested in including on this report.
5. Click on the **Columns** tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the **Selected** column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.

6. If you’d like to change the sort order, move the columns from the **Selected** column to the “Sort” column.

7. Click **GENERATE**.

As an example, let’s say we’d like a *Donor Giving by Month* report for all donors and we want a total of all of their donations for the given time period. On this report we want to see donor name, birthday and amount for each month.

1. Highlight **Donor Giving** on the left sidebar.
2. From the **Criteria** tab, select “This Month” from the date range drop down.
3. Click on the **Who** tab. Leave “Everyone” selected.
4. Mark the box for **Combine Families** if you want contributions from families lumped together.

5. If you want all people listed, whether or not they gave, uncheck **Only Who Gave**.
6. Click on the **What** tab. Click the double arrow to move all funds to the **Selected** column.

7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.

8. Click on the **Columns** tab. Drag the birth date field from the left side column to the **Selected** column on the report.

9. Click **GENERATE** to produce the report.
In this example, let’s say we’d like a *Donor Giving by Week* report for all members who have given to the building, missions and general fund. On this report we want to see donor name, association and total.

1. Highlight *Donor Summary by Fund* on the left sidebar.
2. From the *Criteria* tab, select “This Year” from the date range drop down.
3. Click on the *Who* tab. Select *Association* from the “Run for” drop down box. Click on *Member* to move that value to the *Selected* column.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.
5. To list all *Members* regardless of giving, uncheck *Only those who gave*.
6. Click on the *What* tab. Click on *Building*, *Missions*, and *General* to move those funds to the *Selected* column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click on the *Columns* tab. Drag address, city and state fields from the left side column to the *Selected* column on the report.
9. Click GENERATE to produce the report.
On the What tab, select the funds you wish to consider for the report.

Click over the columns or fields you wish to include on the report.

Click GENERATE to run the report.

Members who gave to the selected funds.

Giving by week for the date range selected.

Top Donors

The Top X Givers report lists the top givers based on the date range, funds and the people you select. To run this report:

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Top X Donors on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish
for this report. Then under the *Who* tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the *What* tab. From here, select the funds you are interested in including on this report.

5. Click on the *Columns* tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the *Selected* column. You can rearrange the ordering in the *Selected* column by dragging and dropping in the order you wish to see them in the report.

6. If you’d like to change the sort order, move the columns from the *Selected* column to the *Sort* column.

7. Click GENERATE.

As an example, let’s say we’d like to view the top 10 donors that are also members. On this report we want to see donor name, birthday and amount.

1. Highlight *Top X Donors* on the left sidebar.
2. From the *Criteria* tab, select “This Year” from the date range drop down.
3. Enter 10 as the number of givers.
4. Click on the *Who* tab. In the *Run for* drop down, select “Association”. Click on *Member* to move that value to the *Selected* column.
5. Mark the box for *Combine Families* if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
8. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
9. Click on the Columns tab. Drag the birth date field from the left side column to the Selected column on the report.
10. Click GENERATE to produce the report.

Donors over X Amount

The Donors over X Amount report lists the donors that meet the specified amount criteria for the date range, funds and people selected.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donors over X Amount on the left sidebar.
4. From the Criteria tab, select the date range that you wish for this report.
5. Next, enter the amount that you are searching for. The report will search for those folks who gave exactly that amount or greater over the date range.
6. Next, under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the Selected column to the Sort column.
9. Click GENERATE.

As an example, let’s say we’d like to view people who have given over $250 this year. We want to evaluate everyone in the database and we want to consider giving to all funds..

1. Highlight Donors over X Amount on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Enter 250 as the Amount.
5. Mark the box for Combine Families if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click on the Columns tab. Drag the address, city, and state fields from the left side column to the Selected column on the report.
9. Click GENERATE to produce the report.
Given X Times

The *Given X Times* lists the donors who have given over a certain number of gifts based on the date range, funds and people you select.

To run this report:
1. Expand the *Contributions* menu.
2. Click on *Reports*.
3. Click *Given X Times* on the left sidebar.
4. From the *Criteria* tab, select the date range that you wish for this report.
5. Next, enter the number of times you are searching for. The report will search for those folks who given at least that many times over the date range.
6. Next, under the *Who* tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc. Once you’ve chosen who, click on the *What* tab. From here, select the funds you wish to consider for this report.
7. Click on the *Columns* tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the *Selected* column. You can rearrange the ordering in the *Selected* column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the *Selected* column to the *Sort* column.
9. Click GENERATE.

As an example, let’s say we’d like to view people who have given at least 6 times this year. We want to evaluate everyone in the database and we want to consider giving to all funds.

1. Highlight *Given X Times* on the left sidebar.
2. From the *Criteria* tab, select “This Year” from the date range drop down.
3. Enter 6 as the *Times*.
4. Click on the *Who* tab. Leave “Everyone” selected.
5. Mark the box for *Combine Families* if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click on the Columns tab. Drag the address, city, and state fields from the left side column to the Selected column on the report.
9. Click GENERATE to produce the report.

Given 0 Times

The Given 0 Times report lists the people in your database who have not contributed within the specified time period.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Given 0 Times on the left sidebar.
4. From the Criteria tab, select the date range that you wish for this report.
5. Next under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc.
6. Click on the What tab. From here, select the funds you wish to consider for this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from
the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.

8. If you’d like to change the sort order, move the columns from the Selected column to the Sort column.

9. Click GENERATE.

As an example, let’s say we’d like to view members who have not given at all.

1. Highlight Given 0 Times on the left sidebar.

2. From the Criteria tab, select “This Year” from the date range drop down.

3. Click on the Who tab. Select “Associations” as the Run for. Select Member.

4. Mark the box for Combine Families if you want contributions from families lumped together.

5. Click on the What tab. Click General fund to the Selected column.

6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.

7. Click on the Columns tab. Drag the address, city, and state fields from the left side column to the Selected column on the report.

8. Click GENERATE to produce the report.
Listing of Members who have not given to the General fund.

Note actions that can be performed.

---

**Fund Summary**

The *Fund Summary* report calculates the amount given to the fund during the selected time frame by the selected donors. To run the *Fund Summary* report:

1. Expand the *Contributions* menu.
2. Click on *Reports*.
3. Click *Fund Summary* on the left sidebar.
4. From the *Criteria* tab, select the date range that you wish for this report.
5. Next, under the *Who* tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc.
6. Click on the *What* tab. From here, select the funds you wish to consider for this report.
7. Click on the *Columns* tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the *Selected* column. You can rearrange the ordering in the *Selected* column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the *Selected* column to the *Sort* column.
9. Click GENERATE.

As an example, let’s say we’d like to view how much has been given to *General* and *Building* funds by the small groups.

1. Highlight *Fund Summary* on the left sidebar.
2. From the *Criteria* tab, select “This Year” from the date range drop down.
3. Click on the *Who* tab. Select “Groups” as the *Run for* criteria. Click over all the small groups.
4. Mark the box for *Combine Families* if you want contributions from families lumped together.
5. Click on the *What* tab. Click General and Building funds to the *Selected* column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
7. Click GENERATE to produce the report.
Select report period.

Select which donors should be included. In this example we are looking at giving from small group members.

From the What tab, select which funds you wish to include in the report.

Click GENERATE to run the report.

Listing of how much was given to the selected funds by members of the small groups.

**Fund Giving by Week, Month or Year**

The *Giving by Fund by Week* report summarizes all giving for the fund by week, month, or year for a given time period in a spreadsheet format. The weeks, months, or years are listed across the top.

To run this report:
1. Expand the *Contributions* menu.
2. Click on *Reports.*
3. Click *Giving by Fund* on the left sidebar.
4. Click on the *Criteria* tab. From the criteria tab, select the date range that you wish for this report.
5. Next, select the Report Type: by Week, by Month, or by Year.
6. Then under the *Who* tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc. Once you’ve chosen who, click on the *What* tab. From here, select the funds you are interested in including on this report.
7. Click on the *Columns* tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the *Selected* column. You can rearrange the ordering in the *Selected* column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the *Selected* column to the “Sort” column.
9. Click GENERATE.

As an example, let’s say we’d like a *Fund Giving by Month* report for all donors and we want to include giving from *Members* and *Regular Attenders*.

1. Highlight *Fund Giving* on the left sidebar.
2. From the *Criteria* tab, select “This Year” from the date range drop down.
3. Select “by Month” as the *Report Type*.
4. Click on the *Who* tab and choose “Associations” as the *Run for* criteria. Click over *Members* and *Regular Attenders* to the *Selected* column.
5. Mark the box for *Combine Families* if you want contributions from families lumped together.
6. Click on the *What* tab. Click the double arrow to move all funds to the *Selected* column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click GENERATE to produce the report.
From the **What** tab, select the funds you’d like to see in the report.

Click **GENERATE** to run the report.

**Listing of funds included.**

**Monthly totals of giving by Members or Regular Attenders.**

---

**Contribution Detail**

The **Contribution Detail** report outlines all donations for a given time period, for the funds you are interested in, for the donors you select. To run the **Contribution Detail** report:

1. Expand the **Contributions** menu.
2. Click on **Reports**.
3. Click **Contribution Detail** on the left sidebar.
4. Click on the **Criteria** tab. From the **Criteria** tab, select the date range that you wish for this report.
5. Then under the **Who** tab, select the donors you wish to include in the report. Once you’ve chosen who, click on the **What** tab. From here, select the funds you are interested in including on this report.
6. Click on the **Columns** tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the **Selected** column. You can rearrange the ordering in the **Selected** column by dragging and dropping in the order you wish to see them in the report.
7. If you’d like to change the sort order, move the columns from the **Selected** column to the **/column**.
8. Click **GENERATE**.

In our first example, let’s say we’d like a donor report for all donors (we don’t care what their association is) and we want to know all of their donations for all funds. On this report we want to see donor name, email address, donation date and amount.
1. Highlight *Contribution Detail* on the left sidebar.
2. From the *Criteria* tab, select “This Week” from the date range drop down.
3. Click on the *Who* tab. Leave “Everyone” selected.
4. Click on the *What* tab. Click the double arrow to move all funds to the *Selected* column.
5. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
6. Click on the *Columns* tab. Drag the fields from the left side column to the *Selected* column on the report.
7. Click GENERATE to produce the report.
**Contribution Statistics**

The *Contribution Statistics* report breaks down donations by age range, association and zip code, marital status and giving range. This file also outlines the number of givers by range of giving. To run the *Donation Statistics* report:

1. Expand the *Contributions* menu.
2. Click on *Reports*.
3. Click *Contribution Statistics* on the left sidebar.
4. Click on the *Criteria* tab. From the *Criteria* tab, select the date range that you wish for this report.
5. Then under the *Who* tab, select the donors you wish to include in the report. Once you’ve chose who, click on the *What* tab. From here, select the funds you are interested in including on this report.
6. Click GENERATE.

In this example, let’s run the statistics for all donors for this year and let’s consider all funds.

1. Highlight *Contribution Statistics* on the left sidebar.
2. From the *Criteria* tab, select “This Year” from the date range drop down.
3. Click on the *Who* tab. Leave “Everyone” selected.
4. Click on the *What* tab. Click the double arrow to move all funds to the *Selected* column.
5. Click GENERATE to produce the report.
Giving broken down by zip code, association, age range and giving range.

First Time Givers

The First Time Giver report lists the folks who have given for the first time within the reporting period for the funds you select. To run this report:

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click First Time Donors on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report.
5. Select the Times Given (First time, Second Time, etc.)
6. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc.
7. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
8. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
9. If you’d like to change the sort order, move the columns from the Selected column to the Sort column.
10. Click GENERATE.

As an example, let’s say we’d like to view our first time donors that are also members. On this report we want to see donor name, address, city and state.

1. Highlight First Time Donors on the left sidebar.
2. From the Criteria tab, select “Last Week” from the date range drop down.
3. Enter First Time as the “times given”.

174
4. Click on the **Who** tab. In the **Run for** drop down, select “Association”. Click on **Member** to move that value to the **Selected** column.

5. Mark the box for **Combine Families** if you want contributions from families lumped together.

6. Click on the **What** tab. Click the double arrow to move all funds to the **Selected** column.

7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.

8. Click on the **Columns** tab. Drag the birth date field from the left side column to the **Selected** column on the report.

9. Click **GENERATE** to produce the report.

Highlight **First Time Donors**.

Choose **who** want want to consider. In this example we are looking for **Members** who gave for the first time last week.

Choose the **funds** you want to consider. In this example we are looking for people who gave to any fund.

From the **Columns** tab, choose the fields you wish to see on the report.
**Batch Summary**

This report will produce batch summaries from any date range you enter.

To run this report:
1. Expand the *Contributions* menu.
2. Click on *Reports*.
3. Select *Batch Summary*.
4. Select your date range by using the drop down area or putting in your own custom range.
5. Click GENERATE.

**Batch Detail**

This report will produce *Batch Detail* reports from any date range you enter.

To run this report:
1. Expand the *Contributions* menu.
2. Click on *Reports*.
3. Select *Batch Detail*.
4. Select your date range by using the drop down area or putting in your own custom range.
5. Click GENERATE.
MAINTAINING PLEDGES

To track pledges in Roll Call, you must first setup the *pledge fund*. The *pledge fund* can be a multi-year campaign, such as a building fund. Or, it can be a yearly tithe pledge. Once the *pledge fund* has been established, you can record the individual pledges.

**Pledge Fund**

A *pledge fund* must be for an account that is established in the *Giving Funds* section. If the *Giving Funds* does not contain this fund designation, you’ll need to set that up first. See “Getting Started” for more details.

1. Expand the *Pledges* menu.
2. Click on *Add a Campaign*.

First, use the drop down box to select either the *Fund Name* OR *Account Number*. If you selected a fund name, the associated account number will be returned. If you selected the account number, the fund name will be returned.

Next, enter the *Start Date* and an *End Date*. Please note, that once a pledge fund has been created, the start date may not be changed.

If you have a target goal for this pledge drive, you may enter the *Fund Goal* in this field. The pledge progress summaries will use this amount to calculate the percentage of goal reached. The *Fund Type* is a free format field you can use to describe the pledge fund.

Click SAVE & CLOSE to save the information. Click SAVE & NEW to enter another pledge fund.

To CLONE pledgers’ information from a previous pledge campaign into a new pledge campaign, select from the drop down list in the lower right of the *Add a Campaign* screen. This will automatically pull in all information from the previous campaign into your new one. Once they are pulled in, you can make modifications, other additions or deletions to your campaign, as necessary. (More on that later in this chapter.)
Individual Pledges

To begin adding individual promises or pledges, click on the plus sign in the lower left of the pledge fund window.

First, enter the Last Name or a portion of the last name and tab out of the field. A list of people with that last name will be displayed. Double click on the individual who is making the pledge. If a married couple is making a pledge together, enter the pledge under the head of families record. If the husband and wife are making separate pledges, enter the husband’s pledge. Then enter a pledge for the wife. You must set “file individually” from their record, otherwise their contributions will tie together to the same pledge as the HOF. For more on that, read the chapter on Maintaining People Information, and the section on Contributions.

Note the Start and End Dates from the pledge fund will be entered as the defaults for this pledge. These dates may be changed. For example, if you have an existing building fund that runs three years, you may have people that pledge to that fund in the middle of the campaign. Simply change the individual start date on their pledge record.

Next, use the drop down box to select the applicable Payment Period. Will they be paying on a weekly, monthly, or annual basis?

Next, you can enter the Total Amount of their pledge (the amount they will pay over the course of the entire pledge period) in the Pledge Amount field. Once you’ve entered this amount, the Each Payment amount (on the right side of the screen) will be calculated. Or, you can enter the Each Payment amount and the Pledge Amount will be calculated.

If you wish progress against this pledge to be printed on the donation receipt, click “Yes” for Report on Rcpt. The Date Completed, Pledge ID and Pledge Fund ID fields are determined by Roll Call and may not be modified.

To save the information you’ve entered and enter another pledge, press SAVE & NEW. To save the information and return to the Pledge Summary window click SAVE & CLOSE. To leave the screen without saving the information click on CANCEL. To save the information you’ve entered, press OK. To leave the screen, without saving the information, click on CANCEL.
**Finding Pledges**

You can search for pledges based on fund name or by donor name. To find a pledge based on the fund, do the following:
1. Expand the Pledges menu.
2. Click on Search by Fund.
3. Enter the fund name.
4. Double click on the specific fund.
5. Scroll through the list of pledgers and double click on the specific pledge you are interested in.

To find a pledge based on person information, do the following:
1. Expand the Pledges menu.
2. Click on Search by Person.
3. Use the Find By drop down box to select your criteria.
4. Enter the value you are looking for.
5. Scroll through the list of pledgers and double click on the specific pledge you are interested in.
Modify Pledge Information

Changing the pledge information

The only changes that are allowed to the pledge fund are to the Start Date, End Date, Fund Goal and Fund Type. If you would like to modify this information, select Search by Fund under the Pledges menu. Double click on the fund you are interested in changing.

Double click on a specific pledge to change it.

To change individual pledge information, use the Search by Fund or Search by Person to find the specific pledge. Double click on the pledge. Make the necessary changes.

Deleting a pledge fund

If you would like to delete a pledge fund, click the Search by Fund menu item. Highlight the fund you’d like to delete, then click minus sign in the lower left of the window. All pledge funds highlighted will be deleted.

Deleting pledges

If you would like to delete a pledge, click the Search by Fund menu item. Double click on the specific pledge fund. From the lower section, highlight the pledge or pledges that need to be deleted. Click the minus sign in the lower left of the window.
Highlight the campaign you’d like to delete.

Click the minus sign to delete. THIS WILL DELETE ALL THE PLEDGES FOR THIS CAMPAIGN.

Highlight the pledges you’d like to delete.

Click the minus sign to delete.

---

**Pledge Progress Letter**

Roll Call allows you to create *Pledge Progress Letters* to inform donors of how they are doing against their pledges. You can customize the body of the letter and the closing text. The middle of the letter contains a summary of their pledge and amounts received. Then the supporting detail donations are listed.

To create this letter, select *Pledge Progress Letter* from under the *Pledges* menu.

**Criteria**

From the first window, select the specific pledge fund and the types of information you’d like to include in the report.

1. Use the drop down box to select the appropriate fund. For example, if you want to send out progress letters for your Building Fund that started 1/1/13, select Building – 1/1/2013 from the drop down list.
2. Select if what you would like to SHOW ON LETTER... Summary Only, Summary with Period Details, or Summary with All Details.

Details
1. From the Details tab, select the people to include: All pledgers, those who gave in a specific period, those would didn’t give in the period but have given, or those who haven’t given.

2. Next, decide the pledge Summary Details to consider. The fund and pledge total are already chosen for you. You can also include what’s been received to date (rec’d to date), what’s been received this period (recd this period), the pledge starting and ending dates, and the frequency of their gift.

Print Options
1. Single Print Job- The first option to consider is Single Print Job. If you choose this option, all the pledge summary letters are sent to the printer at once, as you are sending it all as one document. If you want to duplex, turn this option off.

2. Cover Letter- if you would like the option to create and print a cover letter to go along with your Pledge Summary Letter, select this option.

3. Print on Stationary- If you would like to print on your own stationary, this will automatically take out the church address information. You will have the option from here to Use Own Letterhead, and First Page Only.
You can customize this further to fit your letterhead by selecting the Customize tab.

4. **Show Envelope Number** - Select this option to show the envelope number of the pledger.

5. **Sorted by** - Use the dropdown to change the sort order.

6. **Exclude** - You can choose to exclude people who have **Bad Address** or **Do Not Send Mail** marked in their people record.

**Customize**

1. **Top Margin** - You can set your top margins here.

2. **Organization starts on line #** - This will allow you to choose which line on the letter you would like your Organization or Church name to appear.

3. **Address starts on line #** - This will allow you to choose which line on the letter you would like your Organization or Church address to appear.

4. **Body starts on line #** - This will allow you to choose which line on your letter you would like the progress letter information to start on.

5. **Customize font** - If you would like to change the font style, select from the dropdown menu.

6. **Font size** - If you would like to change the font size, select from the dropdown menu.
View People

To view the list of people that you will be sending or emailing your Pledge Progress letter to, click on the View People tab. From here you can select the email receipts, in order to email the letter, or if that is blank you can select the PRINT LETTER option, when ready. When selecting PRINT LETTER, a letter will be printed for only people who do not have the Email Receipt option selected.

Letter Text

There are four different text areas, which allow you to customize your pledge progress letter.
1. *Top Text*- to write a short note that will appear near the top of the body text, use this area. If you plan on writing more than a few lines, it is recommended to write a cover letter instead.
2. *Bottom Text*- if you have any closing remarks, use this area to write them.
3. *Cover Letter*- to write a cover letter, use this area. Be sure to mark under Criteria>Print Options, that you want this area to print.
4. *Org. Letterhead*- If you have a logo you would like to pull into the letterhead area to be printed on the Pledge Progress Letter, pull it in here. You must have it marked under Criteria>Print Options>Print on Stationary>Use Letterhead for this to print.
To pull a logo into the Org. Letterhead area on Mac: Find your graphic, open in previewer. Select CMD A, then CMD C. Go to letterhead area, select CMD V to paste. Resize, then File>Save.

After you have gone through and checked all of your setting under the Criteria, View People, and Letter Text tabs, you will be ready to send the letter to the printer or send the email. Press PRINT LETTER to the printer. If someone has email checked in the View People tab area, Roll Call will not send a letter to the printer for that person. The letters will be sent directly to your default printer. To change your default printer in Windows, go to the control panel and select Printers and Faxes. Double click on the printer you’d like to select as the default printer. From that window, select Printer>Set as Default. If you need to change the page set up options from your list of printers, select File>Printing Preferences. You can make any modifications necessary here.

To change your default printer on the Mac, click on the apple and select System Preferences, then double click on Printers and Faxes. Click on the Set Up Printers button. Highlight the printer you’d like, then click on the Make Default icon.

To email, select EMAIL LETTER. Only those with an email in Roll Call, and with email selected will receive the letter. You must also have the email host settings set up in Roll Call under your HOME menu. For more on that, see the chapter on GETTING STARTED.

Pledge Reports

There are various reports that can be run for pledges. They are all run in the same manner. The process is as follows:
1. Expand the Pledges menu
2. Click on Pledge Reports.
3. The pledge report window is displayed. The reports are listed on the left side.
4. Click on the report you wish to run.
5. Complete the Criteria section on the right.
6. Click GENERATE.

Criteria

Once you select your report, the criteria section of the report window will change. For the majority of the reports, you’ll need to select a date range and which funds you wish to report on. When you click GENERATE you’ll be taken to the Pledge Report Output Window.

Output window

The report will be displayed on the left side of the window. If all the results don’t fit in this window you can use the scroll bars to move up & down or left to right. There are a standard set of buttons on the right side of the window. These are as follows:
1. Page Setup – this button allows you to choose the paper size and orientation of the page for your printed report.
2. Preview – This button will allow you to preview your printed report.
3. Print – click this button to send your report to the printer.
4. **Customize** – the customize button puts the report in the Roll Call spreadsheet program. From here, you can save the report to a text file, change fonts, change columns widths, change column headers etc.

5. **Zoom In** – to view the report in a larger font, click Zoom In.

6. **Zoom Out** – to view the report in a smaller font, click Zoom Out.

7. **Save Report** – this allows you to save the report spreadsheet.

8. **Save Set** – allows you to save this set of people to use in a different part of the program.

9. **Create Labels** – this allows you to print address labels for the folks listed in your report.

10. **Write Letter** – this allows you to create a mail merge letter for the folks listed in your report.

11. **Email** – the email option allows you to email all the people in your report OR to email the report to someone else.

**Pledge Status report**

The *Pledge Status* report lists the folks who have pledged to a specific fund and calculates how much they’ve pledged for a date range. The report lists the name, how much they pledged for a period and how much they gave for the same period.

To run the report:

1. Expand the **Pledges** menu.

*Pledge Status* report show amounts received and the differences.

*Body of the report.*

Report options. Click to PRINT, SAVE, EMAIL, WRITE LETTER, etc.
2. Click on Reports.
3. Click on Pledge Status on the left side.
4. Select your date range.
5. Select the fund you wish to run this for.
6. Click GENERATE.

**Pledge Comparison report**

The pledge comparison report compares multiple pledge funds. For example if you wanted to compare how much folks pledged to the 2008, 2009 and 2010 campaigns, you could do that through this report.

To run the report:
1. Expand the Pledges menu.
2. Click on Reports.
3. Click on Pledge Comparison on the left side.
4. Select the funds you wish to list across the top.
5. Click GENERATE.
**Pledge Fund Comparison report**

The *Pledge Fund Comparison* lists the funds you select, the amounts pledged and the amounts received for each selected fund.

To run the report:

1. Expand the *Pledges* menu.
2. Click on *Reports*.
3. Click on *Pledge Fund Comparison* on the left side.
4. Select the *funds* you wish to list.
5. Click GENERATE.
Pledge Giving report

The Pledge Giving Report shows the total amounts received, given, amount pledged and their balances for individuals. It also allows additional custom columns to be added to your report.

To run the report:
1. Expand the Pledges menu.
2. Click on Reports.
3. Click on Pledge Giving Report on the left side.
4. Select the fund you wish to list to report on.
5. Select the people you wish to report on. In this report, chose either ‘only show people who have pledged’, ‘only show people who have given but not pledged’, ‘show people who have given or pledged’.
6. For additional columns to include in your report, select the Columns tab, and move them over to the Selected side by dragging and dropping or double clicking.
7. Click on the View Records tab to see who has qualified for this report.
8. Click GENERATE.
MANAGING GROUPS

Group Hierarchy

Groups are defined by the following classifications:

1. **Campus**- If your church has multiple campuses or locations with different groups and classes at each site, you may want to define your groups at the campus level. The campus indicates which site or location the group stems from.

2. **Group Type**- The next level in the hierarchy is group type. This tells us the general classification of the group. Is the group a committee, a small group, a Sunday school class or a youth group? Your church defines these group types or classifications. Roll Call’s default group types are **Group** and **Class**.

3. **Department**- The next level in the hierarchy is the department. The department is the ministry area within your church that is responsible for overseeing the group. Children’s Ministry, Congregational Care, Youth, and Music are some common departments.

4. **Status**- The status indicates whether the group is **active** or **inactive**.

Every group that is defined in Roll Call must be assigned a **Group Type**, **Department**, **Name** and **Status**. Status always defaults to active.

Group Custom Fields

**Group custom fields**
You may want to define **custom fields** for groups. These fields allow you to customize the information you capture for your groups.

You can set up default **custom field titles** per group type. For example, let’s say we have a “small group”, group type. For each small group we need to know an **emergency contact**, what they are studying, where they meet, and if they are accepting new members.

To create these **group custom field** titles:

1. Select RollCall>Preferences from the top menu
2. Click on the **Group Custom** tab.
3. Select the **Group Type**, “small group” in the upper left drop down box.
4. Enter “Emergency Contact as **Cstm 1**.
5. Enter “Studying” as **Cstm 2**.
6. Enter “Meeting Location” as **Cstm 3**.
7. Enter “Accepting New Members” as **Chk1**.
Now each time you create a small group, there will be fields available to enter Emergency Contact, Studying, Meeting Location, and Accepting New Members. You can customize each group further by modifying the custom field titles for a specific group.

**Group membership custom fields**

Like group custom fields, you may want to define custom fields to track specific information for each member in a group.

You can set up default custom field titles per group type. For this example, let’s say we need to know certain information about the worship team members. We’d create a group type of “worship team”. For each of our worship team members we need to know what instrument they play, can they read music, what is their voice type and how many times per month are they available.

To create these group member custom field titles:

1. Select RollCall>Preferences from the top menu.
2. Click on the Member Custom tab.
3. Select the Group Type, “worship team” in the upper left drop down box.
4. Enter “Instrument” as Cstm 1.
5. Enter “Voice Type” as Cstm 2.
7. Enter “Read Music” as Chk1.

Now, each time you create a worship team group, there will be membership fields available to enter Instrument, Voice Type, Days Available, and Read Music. You can further customize each group by modifying the custom field titles for group members.

**Add a Group**

**Enter general information**

There are several options for getting to the Add a Group window:

1. Expand the Groups menu and click Add a Group OR
2. Expand the Groups menu and click Search. Click on the plus sign in the lower left to add a new group.

Once you are in the screen to add the group:

1. Enter the values for Campus, Group Type, Department and Status.
2. Enter the name of the specific group under Group Section.
3. If the group has a leader, enter the last name in the Leader field. Press tab to view a list of the folks with that last name. Select from the list.
4. If the group has a co-leader, enter the last name in the Co-Leader field. Press tab to view a list of the folks with that last name. Select from the list.
5. Enter the Location of the group, if applicable.
6. Indicate if the group meets weekly or randomly.
7. You may enter any comments or notes in the Notes field.
8. The Start Date will default to today’s date. You may change it if you’d like.

Click SAVE & CLOSE to save the information and return to the Search screen. Click SAVE & NEW to save the information and enter a new group.

Select the group type, department and name of this group.

Click plus sign to add members to this class.

Add Members
To enroll people into the group, press the Members tab. From within the members tab:
1. Click the plus sign in the lower left of the window. A new window will be displayed for you to enter the Last Name and First Name (or portion of the last name) of the person you want to enroll.
2. Select the appropriate person to enroll in the group.
3. Tab across to enter any of the custom field data for this person. If you need to define the membership custom field names, click CHANGE TITLES and enter the name of the data you’d like to capture.

Enter last name or portion of last name. Further refine list by entering first name.

Double click on the name to select it. If the name is highlighted, press enter to select.
Create sessions

Next, you’ll want to indicate which days and at what times the group meets. The meeting days and times are called sessions in Roll Call. A group that meets weekly can have an unlimited number of sessions. A group that meets randomly does not have any sessions defined.

To create a session:
1. Click on the Session tab, if sessions are not currently displayed.
2. Click on the plus sign in the lower left. A row will be displayed, with a default of Sunday and a default start time of 8 a.m. and end time of 9 a.m.
3. Use the Day of Week drop down box to select the appropriate day.
4. Enter the Start Time.
5. Enter the End Time.
6. Place your cursor under Room and double click to enter the room number of this group meeting.

Enter values for group custom information

If you set up custom fields (under Preferences) for this group type, you can enter the data in the Custom (1) and Custom (2) tab. Let’s look at our previous example of a small group. We had set up custom fields to record emergency contact, studying, meeting location and accepting new members.

To enter the custom data for this group:
1. Press the Custom(1) tab. The fields on this tab are the text fields.
2. Enter values for each of the custom fields Emergency Contact, Studying and Meeting Location.
3. Press the Custom (2) tab. The fields on this tab are the checkboxes and dates.
4. Check the box for Accepting New Members, if the answer is Yes.

If no custom fields are defined for this group type, you can define them for this specific group if you’d like. Click on the CHANGE TITLES button to enter the name of the data you’d like to capture. When you are done entering the titles, click CHANGE DATA to enter the actual data for that field.
Enter the data for the custom fields as location, studying, etc.

Click CHANGE TITLES to change the names of the fields.

Preferences
Use the Preferences tab in the group screen to:
1. Tell Roll Call how many labels you wanted printed upon check-in for this group.
2. Tell Roll Call which fields to print on the Attendance Roster.
3. Set age ranges for graduation.

Enter roster preferences.
Enter age ranges if you will be graduating on birthdays.

Copy a Group
To make copies of a group, you’ll want to use the Clone utility. You may make up to 10 copies of one group by cloning. To clone, do the following:
1. Expand the Groups menu.
2. Click on Search and find the group you wish to copy.
3. Double click on that group.
4. Select Clone from the Administration menu at the top.
5. Choose the information you wish to copy. Click NEXT.
6. Enter the new group names. Click FINISH.
From the group you want to copy, select *Clone a Group* from the *Administration* menu.

Mark the information you wish to copy.

Click *NEXT*.

Name up to 10 new groups based on the original group.

Click *FINISH*.

**Mass Enrollment**

To enroll multiple people into a group at once, expand the *Groups* menu, double click on the group you’d like to enroll folks into. Choose *Mass Enrollment* from the *Administration* menu at the top.

**Select Association**

To limit the people in the list based on an *Association*, click over each association you’d like in the list.

**Select Male or Female**

To limit the list of possible enrollees to a certain *Gender*, check the box for *Male* or *Female*. This can also be used in combination with *Age range* and *Association*. For
example, if you wanted only male members, you could check the box for *Male* and click over the association *Member*.

**Enter an age range**

To limit the selection of possible enrollees based on age, enter an *Age range*. You can also use this option in combination with *Male/Female* and *Association*. So if you wanted to limit the list to boys ages 6 – 8, as example you could check *Male*, and enter an age range of 6 – 8.

Press CONTINUE to get your list of potential enrollees. Mark the box to *Select All* if you want everyone in the list to be enrolled in the group. Or, highlight each person you want enrolled. To highlight multiple people, hold down the apple key on the Mac, or the shift key on Windows.

From within the group you wish to enroll people into, select the *Mass Enroll* option under *Administration*.

Use this window to build the list of possible enrollee’s into this group. Choose *associations, gender or age ranges* that should be included in the list.

Highlight all the people you’d like to enroll in the group. Click *ENROLL SELECTED*.

Choose *Select All* to highlight everyone in your list. Then press *Enroll Selected* to enroll them.
Select using query editor
If there is different criteria you’d like to use to determine potential enrollees, you can use the query editor to get that list. For this example let’s say we want a list of those people that live in a certain city. From this window, click the QUERY EDITOR button. The query editor will be displayed.

1. Change the Query In field to Address.
2. Select City from the Field Name drop down box.
3. Highlight “is equal to” in the Comparison box.
4. Enter the name of the city in the Value field.
5. Click on the QUERY button.

A list of people that live in that city will be displayed. Mark the box to Select All if you want everyone in the list to be enrolled in the group. Or, highlight each person you want enrolled. To highlight multiple people, hold down the apple key on the Mac, or the shift key on Windows.

Transfer members to a new group
To transfer members from one group to another, do the following:
1. Expand the Groups menu.
2. Click on Search.
3. Double click on the group you wish to transfer from.
4. Select the Administration menu at the top and then select Transfer.
5. On the right side, choose the group you wish to transfer to.
6. Click over each person from the left side to the right side to transfer them.

Mark your transfer option. Transfer to the new group moves from one group to the other. Enroll in new group/class keeps them in the original group and also enrolls them in the new group. Copy to new group with data will move them into the new group and also move the membership custom data.

Click OK to complete the transfer process.
Graduation

Graduation Profile
To use the graduation part of Roll Call, you will need to set up graduation profiles. For example, your nursery profile might include all the “nursery” classes and you may want to graduate those kids on their birthday. Then you may have your grade school classes that you’d graduate on a specific date. You would set up that profile to indicate that 1st grade goes to 2nd grade, and 2nd grade goes to 3rd grade etc. Defining the “to’s” and “from’s” is called the graduation profile.

Double click on a profile to view the details.

Click on Graduation to view all graduation profiles.

This profile shows the to and from classes. Click GRADUATE NOW to graduate these classes.

On Birthday
There may be cases where you want a child to automatically move to the next class on their birthday. In this example, let’s say we have a Nursery class for kids 0 – 2 years and a 3 year old class, and a 4 – 5 year old class. For these classes we want the child to graduate on their birthday.

To create this “pre-school” graduation profile, do the following:
1. Make sure you have the age ranges set in the Preferences tab of each group.
2. Next, click on Graduation under the Groups menu.
3. Click on the plus sign to add a profile.
4. Select the Department and Group Type for your “pre-school” classes.
5. Give this graduation profile a name. In this example, I’ll call it Pre-School.
6. Click the plus sign in the lower left to set up the first graduation from 0 -2 to 3 year.
olds. Use the drop down to select the “from” class. Use the drop box to the right to pick the “to” class. Click SAVE & NEW or SAVE & CLOSE.

7. Continue this process until all your pre-school classes have been identified.

8. When you are back at the Graduation profile window, click on the box to Graduate on Birthday.

The pre-school profile graduates students on their birthday.

Graduate Now
If you have a series of classes that you need to graduate at the beginning or end of the school year, do the following:
To create this “grade school” graduation profile, do the following:
1. Click on Graduation under the Groups menu.
2. Click on the plus sign to add a profile.
3. Select the Department and Group Type for your “School Age” classes.
4. Give this Graduation profile a name. In this example, I’ll call it Grade School.
5. Click the plus sign in the lower left to set up the first graduation from Kdg to 1st grade. Select Kdg from the “from” box and 1st grade from the “to” box. Click SAVE & NEW or SAVE & CLOSE.
6. Continue this process until all your school age classes have been identified.

This profile shows the “to” and “from” classes. Click GRADUATE NOW to graduate these classes.
When you are ready to actually do the graduation, do the following:
1. Expand the Groups menu.
2. Click on Graduation.
3. Double click on the profile you wish to graduate.
4. Click GRADUATE NOW.
5. A log will be displayed showing the graduation process.

Modify Group Information
To modify any of the information about a group, change sessions, add or delete people from a group, do the following:
1. Expand the Groups menu.
2. Click on Search.
3. Double click on the appropriate group.
4. Make the necessary changes. To add or remove members, click on Members tab, use the plus or minus sign in lower part of window. To add or remove sessions, click on the Sessions tab, use the plus or minus sign in the lower part of the window.

Delete Groups
To delete a group, do the following:
1. Expand the Groups menu.
2. Click on Search menu item.
3. Highlight the group or groups you’d like to delete.
4. Click the minus sign. You’ll be asked if you want to make the groups inactive or completely delete them from the database.
Highlight the groups you wish to delete.

Press the minus sign.

From within the Groups screen, you can click the DELETE button to delete this group.
Group Reports

Attendance Summary

The Attendance Summary report gives head count information for group attendance. This report can be run by day and it will list each group, the day they met, how many attended and how many visitors attended. The Attendance Summary can also be run by week, month or year. When running for this time frame, it will display the appropriate headcount.

To run the Attendance Summary report by day:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. Click over to the Selected column the groups you wish to view on the report.
5. Click on the Criteria tab. Enter the date range for the attendance data you are interested in.
6. Select “By Day” as the report type.
7. Click GENERATE to run the report.
To run the Attendance Summary report by week, month or year:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. Click over to the Selected column the groups you wish to view on the report.
5. Click on the Criteria tab. Enter the date range for the attendance data you are interested in.

From the Columns tab, choose the fields you would like to see on the report.

The report for our groups “by day”.

Click over the groups you’d like to run the report for.
6. Select “By Week, Month or Year” as the report type.
7. Click GENERATE to run the report.

**Absent/Present Report**

The Absent/Present report allows you to find folks who have been absent X many weeks or who have attended X many times in a certain time frame.

To run the Absent/Present report:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Absent/Present.
4. On the Groups tab, click over the groups you are interested in running this report for to the Selected column.
5. On the Criteria tab, select the date to start looking back, how many weeks to look back and if you are looking for people who have been absent or people present X amount of times.
6. Next, click on the Columns tab to choose the information you wish to include on the report. Click on a column name from the left column and move it to the middle column.
7. Click GENERATE to run the report.
From the Criteria tab, choose your starting date, how many weeks to look back and if you are looking for absent or present.

The standard Absent/Present report will show people who met the criteria and their attendance.

Attendance by Group

The Attendance by Group report displays weekly attendance data for the members in the selected groups. If you choose to do this across groups, it will list all the people in the groups selected and order by name. If you choose to run this within each group, it will order it by group, then list each member of that group.

To create the Attendance by Group report, do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Attendance by Group.
4. Click over to the Selected column the groups you wish to include in the report.
5. Click on the Criteria tab. Select the starting and ending date for the report.
6. Click on the Columns tab to add additional fields to the report.
7. Click GENERATE.
Highlight Attendance by Group. Select the groups you are interested in.

From the Criteria tab, enter the date range for the report.

Choose “across groups” if you want a list of people ordered by name. Choose “within each group” if you want it broken down by group.

You can customize this report from the Columns tab. Click over fields you’d like to add to the Selected column.
### Attendance by Session

This report lists the attendance information for each *group by session* for each week within the *data range* criteria. For each session the number of enrolled, the *number of visitors* and the *number present* are listed.

To create the *Attendance by Session* report, do the following:

1. Expand the *Groups* menu.
2. Click on *Reports*.
3. Highlight *Attendance by Session*.
4. Click over to the *Selected* column the groups you wish to include in the report.
5. Click on the *Criteria* tab. Select the *starting and ending date* for the report.
6. Click on the *Columns* tab to add additional fields to the report.
7. Click *GENERATE*.

<table>
<thead>
<tr>
<th>Group</th>
<th>2nd Grade</th>
<th>Smith</th>
<th>John</th>
<th>X</th>
<th>2</th>
<th>Smith</th>
<th>John</th>
<th>X</th>
<th>0</th>
<th>Smith</th>
<th>John</th>
<th>X</th>
<th>X</th>
<th>2</th>
<th>Smith</th>
<th>Taylor</th>
<th>X</th>
<th>X</th>
<th>2</th>
<th>Students</th>
<th>X</th>
<th>X</th>
<th>2</th>
</tr>
</thead>
</table>

From the *Group reports* window, highlight *Attendance by Session*.

Select the reports you wish to run this for.
From the **Criteria** tab, enter your **date range**.

The report lists **headcount information** for each **session** for the **date range** selected.

**Check-in Roster**

The **Check-in Roster** lists the **students** that have checked into a class, their **parents’ names**, **allergy information** and their **birthdate**. This report is typically run from the check-in stations to give to the teachers once check-in is complete. It can also be run from the **Group Reports** screen.

To create the **Check-in Roster**, do the following:

1. Expand the **Groups** menu.
2. Click on **Reports**.
3. Highlight **Check-in Roster**.
4. Click over to the **Selected** column the groups you wish to print a check in roster for.
5. Click on the **Criteria** tab. Select the **date** for the roster. Highlight the applicable **sessions**.
6. Click on the **Columns** tab to add additional fields to the report.
7. Click **GENERATE**.
Highlight Check-in Roster from Group Reports.

On the Criteria tab, select report date, then highlight the group and sessions you are interested in.

Lists all who were checked into that class and session.

### Attendance Roster

The Attendance Roster displays the group members, an area to record attendance for up to 13 weeks or display 13 weeks of attendance history.

To create the Attendance Roster do the following:

1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Attendance Roster.
4. Click over to the Selected column the groups you wish to print a roster for.
5. Click on the Criteria tab. Select the starting date for the roster. Choose “13 weeks prior” if you want to display attendance history. Choose “13 weeks after” if you want blank columns to record attendance.
6. Click GENERATE.
From Group Reports window, highlight Attendance Roster.

Select groups to run the roster for.

From the Criteria tab, enter date for the report, weeks prior or post, and number of visitor lines.

Lists group members and dates across top. Note weeks prior will include attendance history.
Sign-in Roster

The Sign-in Roster can be used for parents or teachers to check students into a class. It contains the times that the class meets, the name of the students, parents’ name, allergy information, and a custom field.

To create the Sign-in Roster do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Sign-in Roster.
4. Click over to the Selected column the groups you wish to print a roster for.
5. Click on the Criteria tab. Select the date of the group meeting and whether or not to Include Leaders. You may also indicate if you’d like to print a roster for all groups that are scheduled to meet on that day.
6. Next, choose which fields will be displayed on the roster. Check the box next to Bar Codes, Family Number, Parent Names, Custom Field and Special Needs if you’d like that column included in the report. The Custom Field will be a blank column with a title that you define. The Special Needs column will print the special needs and allergy data from Roll Call. You may enter a different title for that column.
7. Finally, select the Group Notes or enter a Custom Title for the roster. You may also enter a Custom Footer for the report. Use the Blank Lines option to print user defined number of blank lines for visitors.
8. Click GENERATE.
Lists sessions, group members and other information you selected.

Check-in Log

This report shows check in activity for specified groups. It will list the people who checked in, the time they checked in and the time they checked out. If they checked in and out multiple times, this will be displayed as well.

To create the Check-in Log do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Check-in Log.
4. Click over to the Selected column the groups you wish to include in the report.
5. Click on the Criteria tab. Select the starting and ending date for the report.
6. Click on the Columns tab to add additional fields to the report.
7. Click GENERATE.

Highlight Check-in Log.
Select the groups you’d like to run this for.
From the **Criteria** tab, enter your *date range*. Lists check-in and out times for the students in this class.

**Group Members**

This report lists the members for each of the groups selected. It contains the members name, and address information.

To create the *Group Member* report do the following:

1. Expand the **Groups** menu.
2. Click on **Reports**.
3. Highlight **Group Members**.
4. Click over to the **Selected** column the groups you wish to include in the report.
5. Click on the **Criteria** tab. Select if you want *active, inactive, or both* type of members, and whether it’s *across groups or within groups*. If you select “Within each group”, the report will be *ordered by group*. If you select “Across”, then it will *ordered by members’ names*.
6. Click on the **Columns** tab to add additional fields to the report.
7. Click **GENERATE**.
From the Criteria tab, select if you want active members, inactive or both in the list.

If you select “Within each group”, the report will be ordered by group. If you select “Across”, then it will order by members name.

From the Columns tab, choose the fields you want in the report.

Listing of all nursery group members.
Background Checks for Groups

The Background Check for Groups report lets you find people in a specific group whose background check is either obsolete or missing.

To run this report, navigate to the Group Reports window. Highlight Background Check report. Click on the Group tab and click over each group you’d like to evaluate the members background check status. Next, click on the Criteria tab.

In this first example, let’s say we want to find all of our Sunday School teachers who have background checks that are obsolete.

1. From the Group Reports window, highlight Background Check.
2. Highlight the Sunday School teachers group on the Groups tab.
3. On the Criteria tab, enter the date at which the security check is considered obsolete.
4. Click over the type of security checks you are interested in.
5. Click GENERATE.
Duplicate Class Enrollment

The *Duplicate Class Enrollment* report lists all the people that are enrolled in multiple active classes. This report can be run from the *Group Reports* screen. To get to the *Group Reports* window, expand the *Groups* menu on the left and click *Reports*.

To run this report, highlight *Duplicate Class Enrollment* and choose the classes you wish to evaluate; then click GENERATE. To customize the report, click on the *Columns* tab and click over additional fields you’d like to see on the report.
Listing of students that were in multiple classes.

Group Involvement

The Group Involvement report shows a list of people in the first column, then the groups are outlined in the subsequent columns. An “X” is placed under each group that a person is involved in.

To create this report, expand the Groups menu. Click on Reports and highlight Group Involvements. Select each of the groups you’d like displayed in the report. Click on the appropriate group from the Selected column to move it over into the Include column.

Click on the Columns tab to choose additional fields to be displayed in the report. Finally, click GENERATE to run the report.
All group members displayed, with an X under each class they are enrolled in.

Group Directory

There are two types of directories available for groups. The first directory is a Simple List. It lists the members’ name, phone, email, birthday and address in a spreadsheet format. The second directory contains the members’ name and address in a traditional directory format.

To create the Group Directory do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Group Directory.
4. Click over to the Selected column the groups you wish to print a directory for.
5. Click GENERATE.

Next, choose the format you’d like: Simple or Detailed. If you choose the detailed format you can also choose the member custom fields to include in the directory. If you choose Simple List you will need to choose Home or Cell phone. (Home phone is the primary phone field in their record. Cell phone is found under the Phones tab in their record.) Click PRINT to send it to the PRINTER.
Choose Simple or Detailed.

If you chose Detailed you may also select custom fields to be included in the directory.

Example of Detailed group directory.

Example of Simple List directory.
Group Picture Directory

To create the Group Picture Directory expand the Directories menu and select Group Picture. Select your group from the drop down list. Next, select the information you’d like included in the directory. Click OK to send the directory to your printer.

Select font and size for the directory.

Select fields to be included in the directory.

Example of group picture directory.
CORRESPONDING WITH YOUR CONGREGATION

Determine your Audience

When you are ready to create a letter, compose an email or print mailing labels, the first thing you need to decide is... “Who will be getting this?” Will you be sending to, for example, all your members, or people who have donated X amount, or parents of your grade school children?

People

If you are determining which people to send the correspondence based on people or address types of information, you’ll want to start in the Search Profiles menu under the People menu. Examples of this type of information would be:

- All Members and Regular Attenders
- Everyone who lives in a specific city or zip code
- Everyone over a certain age
- Everyone in a certain Shepherd Area
- Everyone in my database.

From the Search Profiles window, find appropriate people for your mailing or email blast. Once you have the list of people, click on the appropriate icon (LABELS, EMAIL or LETTER)

You may also highlight a person or multiple people in your list and only those highlighted will be included in the correspondence.

Donors

There are several ways you can create correspondence for donors.

1. From a donor report, use the SEND EMAIL, WRITE LETTER or LABELS buttons on the output screen.
2. Through the Search by Person window.
3. Through the Search by Batch window.

In the first method, you’d need to run a donation report that lists people, for example, the donor summary, top x givers, given 0 times reports. Once you click GENERATE to run that report, the results will be listed in the output window. Click the appropriate button to
create the correspondence for the donors included in your report.

To create correspondence for specific donors, expand the Contributions menu and click on Search by Person menu item. Find the donors by entering a last name, envelope number or association. Once you have the list of people in your list, click on the appropriate icon (LABELS, EMAIL or LETTER).

To create correspondence for donors in a specific batch, expand the Contributions menu and click on Search by Batch menu item. Retrieve the batches you are interested in. All the donors in the listed batches (or highlighted batches) will be included for the correspondence. Click on the appropriate icon (LABELS, EMAIL or LETTER).
Pledgers

There are several ways you can create correspondence for people who pledge.

1. From a pledge report use the SEND EMAIL, WRITE LETTER or LABELS buttons on the output screen.
2. Through the Search by Person window.
3. Through the Search by Fund window.

In the first method, you’d need to run a pledge report that lists people, for example, the pledge comparison. Once you click GENERATE to run that report, the results will be listed in the output window. Click the appropriate button to create the correspondence for the pledgers included in your report.

To create correspondence for specific pledgers, expand the Pledges menu and click on

Search by Person menu item. Find the pledgers by entering a last name, envelope number or association. Once you have the correct pledgers in your list, click on the appropriate icon (LABELS, EMAIL or LETTER).

To create correspondence for pledgers for a specific pledge campaign, expand the Pledges menu and click on Search by Fund menu item. Retrieve the campaigns you are interested in. All the pledgers in the listed campaigns (or highlighted campaigns) will be included for the correspondence. Click on the appropriate icon (LABELS, EMAIL or LETTER).
Group Members

There are several ways you can create correspondence for group members.

1. From a group report that lists people use the SEND EMAIL, WRITE LETTER or LABELS buttons on the output screen.
2. Through the Search window under Groups.
3. Through a tagged group.

In the first method, you’d need to run a group report that lists people; for example, the group member list. Once you click GENERATE to run that report, the results will be listed in the output window. Click the appropriate button to create the correspondence for those members.

Attenders

There are several ways you can create correspondence for people who attended a group/class or worship service.

1. From an attendance detail report that lists people, use the SEND EMAIL, WRITE LETTER or LABELS buttons on the output screen.
2. Through the Search window under Attendance.
In the first method, you’d need to run an attendance report that lists people; for example, the Attendance by Person, Visitor report or Absent/Present report. Once you click GENERATE to run that report, the results will be listed in the output window. Click the appropriate button to create the correspondence for those attenders.

To create correspondence for people who attended a specific service or class on a given day, expand the Attendance menu and click on the Search menu item. Retrieve the attendance you are interested in. All the people who attended that service or class (or highlighted groups) will be included for the correspondence. Click on the appropriate icon (LABELS, EMAIL or LETTER).

**Tagged Groups**
To create correspondence for a tagged group, go to Groups.Search, right click on the group or groups you wish to correspond with, and select Tag. Go to your Home menu under tagged groups to proceed with your correspondence. Right click on group again to choose unTag.

**Letters**
Once you have determined who you’ll be writing a letter to, click the LETTER icon from the search screens or click the WRITE LETTER button from a report. The Letters window will be displayed for you to compose and print your letter.

This window is made up of three different areas. The *template* area, in the upper left of the window, will list saved letters that can be re-used for this new set of people. The *addressing options* area is used to create the address block and salutation. For new letters, you’ll need to choose whether to address the letters to each individual or to the family. The *word processor* area is the main part of the window.
Addressing Options

The first thing you’ll want to do when creating a new letter is to choose the addressing option. If you are addressing this letter to each individual represented in your list, choose Individual. Then, choose if you want to use the first name in the salutation or the title, for example Dave Conley vs. Mr. Conley.

If you want to address this letter to the family represented by the list of people, choose the family option. Then choose name, title, or all listed, underneath Family. If you choose name, it will use the first name of the husband and wife if married, or just first name for single folks. If you choose Title, it will use Mr. & Mrs. for married folks, or just the title and last name for single folks. If you choose all listed, it will use the first names of everyone in the family from your list of people.

Word Processor

The word processor in Roll Call is similar to other word processors such as Microsoft Word or Word Perfect.

Note the menu bar items: File, Edit, View, Insert, Style, etc... Underneath the menu items are icons for the commonly used features such as New, Open, Save, Print Preview, Print etc... If you place your cursor over the icon, a text description is displayed for that icon’s function.

Use the paragraph option icons, left justify, center, bullet, etc., to format the text of your letter. Underneath the paragraph options are the font size and type options. Highlight a section of text and then change the font name and size, as appropriate. The ruler bar will allow you to set margins, tabs and paper size.

If you compose your letter in a different word processor and want to copy and paste into Roll Call, make sure to save the original document in an rtf (rich text format) before doing the copy. If you do not save as text first, the invisible characters from the other word processor will interfere with proper formatting in Roll Call.

When you are ready to print your letters, click PRINT MERGE. A letter will be generated for each person or family in your list. Once your send the letters to the printer, you’ll be prompted to save a record of this correspondence in the person’s record. If you’d like to record this, answer yes, the correspondence will be noted in the Letters tab in the People screen.
Add Date/Subject (without creating a letter)

In Roll Call, you also have the ability to store date and subject information, without actually creating a letter. To do this, go to a person’s record by opening the Search Profiles under the People menu, and finding your person. Double click to open their profile. Click on the Letters tab. From here select the plus (+) sign. From here you can Add a new Letter or Add Subject Only. Select Add Subject Only. Put in your Letter Date and Subject. It will be stored here under the Letters tab. If you ever want to delete it, come back to this area, highlight the subject, and press the minus (-) sign. Your subject (and letter, if its an actual letter) will be deleted.

To Add a Subject only, click on the Letters tab, press the plus sign, and select Add Subject only.

From here, you can enter the date of your letter and what the subject of the letter was.

To delete a letter or subject, highlight the letter and press the minus sign.
Insert Data
You can also pull data from Roll Call into a letter. Begin typing your letter. When you are at a point that you’d like to insert some data, select Insert>4D expression from the word processing menu. Next, click on the arrow in front of the type of information you need and double click on the field you’d like to insert.

If you are basing this mail merge letter on People (Search Profiles under People) you may insert fields from People and Addresses.

If you are basing this mail merge letter on Contributions (Search under Contributions) you may insert People, Address, Batch and Donation fields.

If you are basing this mail merge letter on Groups (Search under Groups) you may insert Group, Group Membership, People and Address fields.

If you are basing this mail merge letter on Pledges (Search under Pledge) you may insert Pledge, People and Address information.

Templates
If the letter you composed will be re-used in the future, make sure to save it as a Template. To save the letter, select File>Save as Template in the word processing menu. You’ll be prompted for the name of the letter. Once you save it, notice the name is listed under templates in the upper left of the Letters menu.
When you are ready to use the letter a second time, do the following:

1. Determine who should get the letter.
2. Click the LETTERS icon.
3. Highlight your template.
4. Make any necessary changes to the template.
5. Click PRINT MERGE to print the letters.

To save a letter to use again, select File>Save As Template from Word processing menu.

To use a template, highlight it in the list.

The letter template will be displayed in word processing window.

**Email**

To send an email to a list of people, click on the EMAIL icon or EMAIL button from a report. You will be given a choice to send an email or a text. Choose the option to send an email.

**My Email**

Each user that will be sending emails from within Roll Call, must set up their email information.

1. Select My Email Settings under the Home menu on the left side.
2. Choose a plain text or HTML type email.
3. Enter the Return Address. This is the “from” email address. If a recipient replies to the email this is the address it will go to.
4. Enter the Mail Host Name. This is your Outgoing SMTP mail address.
5. Enter the Username and Password, if your provider requires authentication.
6. Mark the box for SSL if your provider requires SSL encryption.
7. Enter the Port Number, if your provider requires a specific port number.
8. Make sure to click SAVE, to save these settings.
Expand **Home** menu and click on **My Email**.

Enter your **return address** and **outgoing mail host** information.

Choose your preferred email type.

Click **SAVE**.

**Compose Email**

When you click on the EMAIL icon you will get the “plain text” email window or the TinyMCE editor for HTML emails based on your preference under **MyEmail**.

The **plain text** editor allows you to type in a **subject** and **body**. No graphics or linking capabilities are available. You may send **one attachment** by clicking on the **ATTACHMENT** button.

Choose which email address to use.

**Ability to CC this email here.**

Type **body** of email. No formatting options are available in the **plain text** editor.

If you have the preference set for **HTML** emails, you will get the TinyMCE editor for you to copy HTML or to build your own. To **pull in graphics**, drag and drop your **image file** into the editor and place it where you’d like it displayed. Begin typing the content of your email. Notice the **font and size** options. To **create a link** within your email, highlight the words you’d like linked, then click the **link** icon. Enter the URL that you’d like the link to go to.

You also have the ability to send a **Single** email to multiple recipients. To do that, select **SINGLE** located in the upper right of the email. You may also **CC** recipients by adding their email addresses in the CC space provided. If you would like to store the email template for later use, select **Save Template** in the bottom right, next to the **Send** button. When you are ready to open a saved email template, simply find your person or people you wish to send the email to, press **SEND EMAIL**. Once in the email editor, use the template drop down to find your saved template. Once you open it, you may edit it and send when ready.
Log

Once you click send, an e-mail will be sent to each person in your list. Once the send is complete, a log will be displayed indicating which email was sent and if there were any send errors. You may SAVE or PRINT this log or simply click CLOSE to leave the log and return to Roll Call.
All people will be listed with the email used. Any *send errors* will be noted in this log.

Click to SAVE or PRINT this log.

---

**Text**

To send a *text* to a list of people a couple of things will need to be configured:

1. You will need to have your *outgoing email host* information set up under *MyEmail*.
2. You will need to have the person’s *cell phone* and *carrier information* entered in the *Phones* tab of a person’s profile.

**My Email**

Each user that will be sending *emails* or *texts* from within Roll Call must set up their email information.

1. Select *MyEmail Settings* under the *Home* menu on the left side.
2. Choose a *plain text* or *HTML* type email.
3. Enter the *Return Address*. This is the “from” email address. If a recipient replies to the email this is the address it will go to.
4. Enter the *Mail Host Name*. This is your Outgoing SMTP mail address.
5. Enter the *Username* and *Password*, if your provider requires authentication.
6. Mark the box for *SSL* if your provider requires SSL encryption.
7. Enter the *Port Number* if your provider requires a specific port number.
8. Make sure to click SAVE, to save these settings.

Expand *Home* menu and click on *My Email*.

Enter your *return address* and *outgoing mail host* information.

Choose your preferred email type.

Click SAVE.
Phone information
To send a text you will need to have the cell phone number in the Phones tab for each person you wish to send a text. The carrier information will also need to be included.

Sending the Text
Once you have determined who you’ll be texting, click the EMAIL icon from the search screen. You’ll be given the option to send email or to send a text. Choose the option for text. A window will be displayed for you to enter your text message.

Make sure cell number and carrier are listed for the folks you need to text.

Use the Search window to find the folks you wish to text.

Click EMAIL icon, then choose text option.

Enter your text message, then click OK to send.
Labels

There are several ways that you can produce mailing labels for people in your system. You can do it from the Search windows or from the Reports & Labels menu option. To create the mailing labels, do the following:

1. Click the LABELS icon from the Search window, or choose the Labels menu under the Reports and Labels menu item.
2. If you choose the Labels menu item, you’ll need to determine who you want to create the labels for in the Criteria tab. If you used the ICON from the search screen, Roll Call will produce mailing labels based on the list or the highlighted people in your list.
3. Click on the Customize tab to change the font, size of font. You can also use the adjustment areas to move the positioning of the printing on the label.
4. Click PRINT to send the labels to the printer.

Criteria

If you selected the Labels menu item, under the Reports & Labels menu, you be brought into the Criteria tab to start the process. Use the “Run For” drop down to choose who you want to print the labels for. Once you’ve chosen your type, select the specific values you’d like returned. To select, double click on the value and it will move to the right side “Selected” box.

Choose Labels under the Reports & Labels menu.

Click on each of the values you wish to select.

Choose who you want to create labels for... groups, associations, etc.

When you click on a value it is moved to the Selected column.
Options
If you clicked on the LABELS icon from a Search screen, you will be anchored on the Options tab. In this section you will be able to choose to create a mailing label for each individual in the list, or one mailing label per family in the list.

You can also choose to use their first name or to use their title to address the label, or use the Optional Mailing Name listed in their record under the Addresses tab. The Optional Mailing Name will override any other option, if this is turned on. So, if you want it to print “The Smith Family” because you have that written in their Optional Mailing Name area, that will be used if Use Optional Mailing Name is turned on. If nothing is written in the Optional Mailing Name area, Roll Call will revert back to the Family label and whichever options are chosen there.

You may want to opt to exclude people who have an address that is marked as “bad” or who have indicated “do not send” mail.

The default sort for the labels is by Last Name, First Name. If you’d like to change that to postal code or to envelope number, make that selection on the Options tab.

Customize
Use the Customize tab to change the font, type and size of the lettering for your label. You may also add static text to the label, or eliminate the use of Address Line 2 on the label.

If you have a partial sheet of labels, use the area in the upper right to indicate the label number to start with. Also, if you need to adjust where the printing starts, use the adjustment arrows to move to the top, left or right, or up or down.
**View People**

If you’d like to review who will have a label printed click the *View People* tab. Each person that will have a label printed will be listed.

**Envelopes**

Creating and printing *envelopes* is very similar to creating a Mail Merge document. The difference is the *paper size* and *formatting* options. As an example, let’s say we want to print envelopes for the letters that will be sent to the Members of the congregation.

1. Expand the *People* menu.
2. Click on *Search Profiles*.
3. Find by *Association* and select *Member*.
4. Click the *Letters* icon.
5. Choose to address to individual or family in the lower left section of the *Letters* window.

6. Select File>Page Setup from the *word processing* window.
7. Change the *paper size* to your *envelope size*.
8. Change the *orientation* to *landscape*.
9. In the *word processing* section, delete today’s *date*.
10. Delete the *salutation*.
11. Move the name and address of the member to the middle of the page and down several lines.
12. Enter the name and address of your church if you’d like it displayed in the upper left corner of the envelope.
13. Use the Print Preview icon to see how things line up.
14. Click PRINT MERGE to send the envelopes to the printer.
15. Select File>Save as Template to save this envelope in the templates area to use again.
PRINTING DIRECTORIES

There are six types of directories available in Roll Call.
1. Custom - This directory is completely customizable, complete with custom fields, fonts and with or without pictures.
2. Standard - This directory allows the user much more flexibility in choosing the font, size and what information to display.
3. Classic - This directory is a two-column directory, that includes all family member names, address and home phone.
4. Group - This directory contains information on folks in a specific group or class.
5. Family Picture - This directory contains the family's picture, family member's name and phone number.
6. Group Picture - This directory contains individual pictures and is made for groups.

Custom Directory

To create the Custom Directory, expand the Directories menu on the left side. Then click on Custom.

Options
The options tab allows you to choose if you want one, two or three columns, and with or without pictures. Make your selection and press Next.

General
The general tab that is displayed allows you to choose what information you want displayed in your directory. When you are finished with your selections, press Next.

1. List children should be selected if you do want to list children in your directory
2. Show family email should be checked if you want to show the family email address.
3. Show personal email should be checked if you’d like the family member’s birth dates to be included in the directory.
4. Show Cell phone should be checked if you’d like this information listed.
5. Show Work phone should be checked if you wish to include this information.

Under the Options tab, make your selection on what type of custom directory you wish to produce.
**Custom**
The *custom* tab allows you to choose which custom information you want displayed in your directory. If you have created any custom fields, they will be listed here for you to move to the selected side, if you want them in the directory. Press *Next*, when you are done in this area.

**Cover**
The *cover* tab allows you to choose which create your cover page for you directory. If you would like a logo or image on the front page, you can pull it in here. On Mac, go to your Finder and open your graphic. Double click to open the graphic. Go to Edit>Select All, then back up to Edit>copy. Place your cursor in the cover area, and select Paste. Make any adjustments. Make sure this option is turned on under the *output tab* area. Press *Next* when finished.

**Font**
The *font* tab that is displayed allows you to choose your font size and type for your header, footer, family names, and body of the directory. Press *Next* when finished with your selections.

---

Make your selections on the type of information you wish to see in the directory.

Selection the *General* tab to choose general information for your directory.

Select the custom fields you wish to have in your directory.
Output

The output tab allows you to adjust your margin settings, select to use a column separator or cover (put your cover together under the Cover tab), decide if you want to print a booklet, open it in the word processor, or save it to disk.

When you are finished with all of your selections, press GENERATE to send it to the printer.

To pull a graphic into your cover, come to the Covers tab.

Make sure Cover is turned on in the Output tab to use this area as a Cover for your directory.

Select the Fonts tab to choose your font settings for the header, footer, family names, and the body of the directory.
Standard Directory

To create the Standard Directory, expand the Directories menu on the left side. Then click on Standard. You will have six tabs to help you create your Standard Directory: Options, General, Custom, Cover, Fonts, and Output. But, first you must select your people to be printed in your directory.

Select the people using associations
While anchored on Directories>Standard, you can perform a search of your associations by using the Query Editor. To do this, click on the Search icon at the top of the page. Next, click on the Associations tab. Click over all the associations you’d like to include in your directory and press Query. You will come back to the Directory area where your list will be narrowed down to the specific associations you chose. You can now select GENERATE to begin making your selections on what you would like to see in your directory.

Select the people using the query editor
If you would like to determine who is placed in the directory by another criteria, you can use the Query Editor again by selecting the Search icon at the top of the page. For example, let’s say you only want those folks that live in a certain city to be included in the directory. From this window, click the Search icon. The Query Editor will be displayed.
1. Change the Query In field to Address.
2. Select City from the Field Name drop down box.
3. Highlight “is equal to” in the Comparison box.
4. Enter the name of the city in the Value field.
5. Click on the QUERY button.

Options
The options tab allows you to choose if you two or three columns. Make your selection and press Next.
General: Selecting the fields and format that will be displayed

The General tab allows you to customize what information you’d like to include in the directory.

1. The first item asks if you’d like a certain association marked with an asterisk. For example, if you’d like all your members to have an asterisk by their name, select “Member” from the drop down list and click Yes.

2. The next section asks which address you’d like included. You may select Current, Primary or Both addresses to be printed in the directory.

3. Show Birth Dates should be checked if you’d like the family member’s birth dates to be included in the directory.

4. Show Children’s Ages should be checked if you’d like this information listed.

5. Show Wedding Date should be checked to include this information.

6. Show Associations should be checked if you’d like each family member’s association to be displayed.

7. Show Shepherd Area should be checked if you’d like the families “shepherd” to be included in the directory.

8. Show Family Email should be checked if you’d like the family email to be listed.
Custom
This area allows you to choose additional phones or emails for the directory.

Cover
The cover tab allows you to choose which create your cover page for you directory. If you would like a logo or image on the front page, you can pull it in here. On Mac, go to your Finder and open your graphic. Double click to open the graphic. Go to Edit>Select All, then back up to Edit>copy. Place your cursor in the cover area, and select Paste. Make any adjustments. Make sure this option is turned on under the output tab area. Press Next when finished.

Font
The font tab that is displayed allows you to choose your font size and type for your header, footer, family names, and body of the directory. Press Next when finished with your selections.

Output
The output tab allows you to adjust your margin settings, select to use a column separator or cover (put your cover together under the Cover tab), decide if you want to print a booklet, open it in the word processor, or save it to disk.

If you will be sending this directory to your printer, click on the PRINTER button. If you’d like to save this directory as a file, click on the SAVE TO DISK button.

If you opted to send the directory to the Printer, please note this will go directly to your default printer. If you chose to save the directory to disk, you will be asked to provide a file name.

Example of Standard Directory

Church

Conley, Dave & Kim
John
5475 N Woodgate Ln
Bryan, IL 61010-9557
Home: (815) 331-7530

Hartmanberger, Billy
Carly
Gretz

Harvey, John & Madelyn
Johnny
444 West St
Bryan, IL 61010
Home: (220) 331-2971

Martin, Todd & Suzanne
Daniel McInnes
320 Woodgate
Bryan, IL 61010
Home: (212) 910-8947, (220) 993-0000

Mason, George & Karen
2342 N Main Rd
Bryan, IL 61010
Home: (220) 335-3999

Nye, Eile & Clyde
Jenny
377 Morley
1st St
Rockford, IL 61107
Home: (815) 667-0190

Pettigrew, Sam & Linda
345 Juniper Dr
Bryan, IL 61010
Home: (220) 331-2971

Richards, Kevin & Gina
Miles
36 Harston
Bryan, IL 61010
Home: (815) 667-0198, (816) 035-0005
**Classic Directory**

The *Classic Directory* is a most simplified directory, printing one address with the primary phone number. To run this directory, first go to Directories>Classic. Next, select the people you wish to see in your directory by one of the methods below:

**Select the people using associations**

While anchored on Directories>Classic Directory, you can a perform a search of your associations by using the *Query Editor*. To do this, click on the Search icon at the top of the page. Next, click on the Associations tab. Click over all the associations you’d like to include in your directory and press Query. You will come back to the Directory area where your list will be narrowed down to the specific associations you chose. You can now select GENERATE DIRECTORY to begin making your selections on what you would like to see in your directory.

**Select the people using the query editor**

If you would like to determine who is placed in the directory by another criteria, you can use the *Query Editor* again by selecting the Search icon at the top of the page. For example, let’s say you only want those folks that live in a certain city to be included in the directory. From this window, click the Search icon. The *Query Editor* will be displayed.

1. Change the *Query In* field to Address.
2. Select City from the *Field Name* drop down box.
3. Highlight “is equal to” in the *Comparison* box.
4. Enter the name of the city in the *Value* field.
5. Click on the QUERY button.

When you have your selection of people ready, press Generate Directory. This window will ask if you’d like a certain association marked with an asterisk. For example, perhaps you’d like all your members to have an asterisk by them in or to better identify them. If you would like an asterisk by a certain association, select the association then press “Yes”. You may then also decide if you’d like the current or primary address to be printed in the directory. After you’d make your selections, press GENERATE. Your directory will be sent to the printer.

To mark a certain association with an asterisk, click Yes.
Select the association you’d like marked with an asterisk.
Select the address to be included in directory.
<table>
<thead>
<tr>
<th>Name</th>
<th>Address</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alexander, Brad</td>
<td>1122 Gladloe</td>
<td></td>
</tr>
<tr>
<td>Bittenger, Blaine</td>
<td>3893 Baxter</td>
<td></td>
</tr>
<tr>
<td>Condie, Tim &amp; Mimi</td>
<td>Unlisted</td>
<td></td>
</tr>
<tr>
<td>Conley, David</td>
<td>Shaker</td>
<td></td>
</tr>
<tr>
<td>Conkin, Taylor</td>
<td>418 W Blackhawk</td>
<td></td>
</tr>
<tr>
<td>Doe, John</td>
<td>564 Jaybird</td>
<td></td>
</tr>
<tr>
<td>Drudge, Ben</td>
<td>Quinton</td>
<td>(915) 892-3893</td>
</tr>
<tr>
<td>Garcia, Juan &amp; Marie</td>
<td>2390 Nail</td>
<td>(812) 529-0912</td>
</tr>
<tr>
<td>Hamilton, George</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hartenberger, Bill</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Harvey, Gretchen</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hussain, Afshan</td>
<td></td>
<td>555-1212</td>
</tr>
<tr>
<td>Janson, Tim &amp; Jenny</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Klemp, Candy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Madden, Mike</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mallard, Sean</td>
<td></td>
<td>(902) 939-0099</td>
</tr>
<tr>
<td>Mallard, Susan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>McHenry, Payton</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Moore, Evan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pearce, Jared</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Family Picture Directory

To create the picture directory, expand the Directories menu on the left side bar. Click on Family Picture.

Select the people using associations

The next window that is displayed is asking which people you want to include in the directory. To indicate specific associations that should be included in the directory, click over each association, over to the Include box. For example, if you’d like to include members and regular attenders in the directory, click on the association “Member” from the Select List box. It will move over to the Include box. Next, click on “Regular attender” from the Select List box. It will move over to the Include box.

Click the USE ASSOCIATIONS button.

Select the people using the query editor

If you would like to determine who is placed in the directory by another criteria, you can use the Query Editor again by selecting the Query Editor option at the bottom of the page. For example, let’s say you only want those folks that live in a certain city to be included in the directory. From this window, click the Search icon. The Query Editor will be displayed.

1. Change the Query In field to Address.
2. Select City from the Field Name drop down box.
3. Highlight “is equal to” in the Comparison box.
4. Enter the name of the city in the Value field.
5. Click on the QUERY button.

Specify formatting options
The next window allows you to select the Font and Font Size for the text. You may also indicate if you’d like only those families with pictures or all families selected from the above criteria. You may also check if you’d like the Address, Phone and Email included. After you’ve made your selections, press CONTINUE.

Next, your print dialog boxes will be displayed so you can print your directory.
Group Directory

There are two types of group directories. There is a *simple list* with name, address, phone, email and birthdate. Then there is the *detail* directory that can include custom field information.

To create the group directory, expand the *Directories* menu on the left side bar. Click on *Group Directory*. Select your groups on from the right side.

![Group Query Parameters](image)

- **Group Type**: Select all, campus, department, or a specific group type.
- **Department**: Select all, a department, or a specific department.
- **Group Status**: Select active or inactive.
- **Select a group**: Choose the specific group you want to print.

![Directory Options](image)

- **Type of Directory**: Choose simple or detailed.
- **Include Fields**: Select which phones you wish to see in your directory.
- **Print**: Press to send your directory to the printer.

Select the *group* that you are printing the directory for. To reduce the list of groups available, select *campus*, *type*, *department* and *status*. Select which *phones* you wish to see in your directory. Press *print* to send your directory to the printer.
Select the directory format

There are two group directory formats. The Simple List prints the name, phone, birthday, email and address of the group members. The Detail List allows you to select the custom fields you’d like to include in the directory.

Click on Simple List or Detail to determine the type of directory. Then if you selected Detail, mark each of the custom fields you’d like included in the directory. Click PRINT to send the directory to the printer.

Group Detail Directory

<table>
<thead>
<tr>
<th>Name</th>
<th>Phone</th>
<th>Birthday</th>
<th>Email</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rad Alexander</td>
<td>(555) 354-1212</td>
<td>12/12/1970</td>
<td><a href="mailto:rad@alex.com">rad@alex.com</a></td>
<td>123 Main St, Bloomington, IL 61701</td>
</tr>
<tr>
<td>John Smith</td>
<td>(555) 354-1213</td>
<td>01/01/1971</td>
<td><a href="mailto:john@smith.com">john@smith.com</a></td>
<td>456 Oak St, Bloomington, IL 61702</td>
</tr>
<tr>
<td>Jane Doe</td>
<td>(555) 354-1214</td>
<td>02/02/1972</td>
<td><a href="mailto:jane@doe.com">jane@doe.com</a></td>
<td>789 Pine St, Bloomington, IL 61703</td>
</tr>
</tbody>
</table>

Group Simple List Directory

<table>
<thead>
<tr>
<th>Name</th>
<th>Phone</th>
<th>Birthday</th>
<th>Email</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rad Alexander</td>
<td>(555) 354-1212</td>
<td>12/12/1970</td>
<td><a href="mailto:rad@alex.com">rad@alex.com</a></td>
<td>123 Main St, Bloomington, IL 61701</td>
</tr>
<tr>
<td>John Smith</td>
<td>(555) 354-1213</td>
<td>01/01/1971</td>
<td><a href="mailto:john@smith.com">john@smith.com</a></td>
<td>456 Oak St, Bloomington, IL 61702</td>
</tr>
<tr>
<td>Jane Doe</td>
<td>(555) 354-1214</td>
<td>02/02/1972</td>
<td><a href="mailto:jane@doe.com">jane@doe.com</a></td>
<td>789 Pine St, Bloomington, IL 61703</td>
</tr>
</tbody>
</table>
Group Picture Directory

To create the group picture directory, expand the Directories manu and select Group Picture. Select your group from the drop down list. Next, select the information you’d like included in the directory. Click OK to send the directory to your printer.

Select *font* and *size* for the directory.

Select *fields* to be included in the directory.

Example of group picture directory.
Working with Lifetouch

If you decide you want to work alongside Lifetouch to create your directories, there are two options for you to consider:

1. *Export* family and/or individual information in the proper formatting that Lifetouch is looking for so that they can create the directories themselves. They will need a file that can pulled into an Excel format (.lcd), and also a “Sit Report”.
   A Sit Report is a report on each family that includes a barcode of the family, so that when Lifetouch comes to your church or organization to take the photos, they can scan the barcode on the report and immediately have the family information in front of them.

2. *Import* pictures already taken by LifeTouch into Roll Call’s family and individual Picture tab area within each family and individual profile. Individual pictures can then be used in the child check-in area, if you wish; or you can create your own Roll Call picture directories for Families or Groups in booklet or other formats, with your own custom data, etc...

Exporting to Lifetouch

If you plan on exporting information to be sent to Lifetouch, open up People>Export option. Once you are in this area, decide who you wish to run the Export for. The default is set to run for Everyone. If you need to narrow that down, select from the dropdown list and run a query based on who you wish to see in the report. Once you have found the correct list of people, select the Export Type of Lifetouch. Click on the Settings and make selections there based on what information you wish Lifetouch to use in their directory.
Under Settings, you can choose what information you need to export. Here are some options to choose from.

1. **Family Options** - for additional Family Options, you can include an anniversary date in your Lifetouch directory. Roll Call automatically includes the head, spouse, children, address, phone and email information.

2. **Individual Options** - To include individual information in your export, select the option of Include Individuals. You can also choose whether or not to Include birthdays or Include cell phones of individuals.

3. **Church Options** - mark which church info you wish to see on the Lifetouch directory. Your options include: church email, church website. If this email or web address needs editing, that can only be done from under the Home>Organization area of Roll Call.

4. **Output** - Be sure to select Sit Report if Lifetouch is coming to your facility to take pictures of individuals and families. The Sit Report will include the family and individual barcodes so that Lifetouch can easily pull up their information. The second option to select is Create Lifetouch LCD file. This will create the export file in LCD format. Lifetouch uses this to create your directories with the information that you selected. Before generating this file use the BROWSE button to designate where you want this file to pointed. Creating a folder named Lifetouch would be appropriate for this. You can opt to select both the Sit Report and Create Lifetouch LCD file at the same time. Once you have selected from the above options, close the screen using the red X, then select Generate. The file will be sent to your folder. If Print Sit Report was selected, those will be sent to the printer.

When you are ready, you can either open your lcd file in Excel to view it, or attach this file to an email to email it directly to Lifetouch.

Once you have selected from the above options, press CLOSE, then Generate. The file will be sent to your hard drive. Create a folder and name it Lifetouch. Press OPEN and note the location of the file. When you are ready, you can either open this in Excel to view it, or attach this file to an email to email it directly to Lifetouch. When you are through, your Sit Reports will be printed, if you selected that option.
Here is a sample of what your export looks like when Lifetouch receives it.

Notice the first line is Roll Call information and second line is church information.

These folks have family pictures. You can tell because their ID is a Family name plus a number code.

These folks have individual pictures. You can tell because their ID is a number.

Here you can see this family information lists head, spouse, children, address, phone and email info.

This barcode is used for family info.

Here is a copy of Sit Report. Notice the barcode that Lifetouch uses.

These barcodes are used for individual information.
Importing from Lifetouch

If you have been working alongside Lifetouch and wish to pull in the pictures they have taken directly into Roll Call, use Roll Call’s Picture Import/Export function. Go to People>Bulk Changes, and select Pictures. If you already have pictures in Roll Call, you will see them here under the Individual or Family columns. If you are ready to pull in pictures, select IMPORT/EXPORT in the lower right hand corner of the screen. To Import pictures, select the IMPORT button from this page and find the folder with the images in it. Pictures for individuals must be named with a Roll Call person number and the file type (i.e. 1002.jpg). Family pictures must be named with Roll Call’s family info number plus the file type (i.e. HartBud138XX.jpg). Lifetouch’s folder will be all ready for you with this type of format if you have had them taking pictures for your church or organization. You will just need to ask them for the file folder. Once you have that located, select OPEN and the pictures will be matched to appropriate family or individual.

To Import pictures from Lifetouch, select People>Bulk Changes, then select Pictures.

Select Import to find your Lifetouch folder and pull in your pictures to Roll Call.

If you have any interest in exporting your pictures to a folder, select this Export button. They will be named with the person number for individuals, and the family info number for families.

Press Import/Export here to begin your import.

Notice the columns with individual and family photos.
USING THE QUERY EDITOR

Query Editor uses

The Query Editor is used to produce lists of records that have common characteristics. Some examples are:
- A list of all the members.
- A list of the people who visited last Sunday.
- A list of the groups that meet on Wednesday night.
- A list of donations given between two dates.

Table Layouts

Before using the Query Editor it is helpful to understand how information is stored in Roll Call. Roll Call is based on the relational database 4D. The information is stored in tables. Each table contains information about a “thing”. For example: people, addresses, donations, groups and group members. Each table then is related to each other. For example, each donation must be for a person. A more complete listing of tables and all fields is located in Appendix A.

Address

The AddressTable contains the family specific information. Some of the fields in the address table are: Family number, Family email address, Address 1, Address 2, City, State, Zip, Area Code 1, Phone 1, Area Code 2, Phone 2, Alternate Address, Shepherd Area and Wedding Date.

People

The People Table contains the individual’s information. Some of the fields in the people table are: Family ID, Title, First Name, Nick Name, Middle Name, Last Name, Gender, Birthday, Age, Association, email address and envelope number. The individual’s “standard” (work, fax, pager and cell) phone numbers are stored in this table. The values for the custom fields that were defined by your church are stored in the people table. Summary donation information is stored in the people table. There are summary fields for the donation amounts given 4 years ago, 3 years ago, 2 years ago, last year and YTD.

Donations

The Donations Table contains the high level information about a donation. Some of the fields in the donation table are: Person who gave the donation, the donation date, the donation amount, the type of donation, the check number, property gift information and quid pro quo donation amount.

Designation

The Designation Table indicates which fund the donation was assigned to. If the donation was split into multiple funds, there will be multiple designation records for that donation. The designation fields are: the ID of the related donation record, the fund designation, the amount given to that fund, and the pledge ID if the designation was for a pledge fund.

Non-Cash Gift

The Non-cash Gift Table indicates what was given, the donor, and the amount it was sold for.

Recurring Donation

Recurring donations contain information about regularly scheduled donations. It contains
the donor, amount to be donated, and the frequency.

**Pledge**
The *Pledge Table* contains the information about an individual’s pledges. The fields are the ID of the person who made the pledge, the fund that the pledge was made to, the amount of the pledge, and the start and end date of the pledge.

**Groups**
The *Group Table* contains the high level information about a group. The fields are the group type, the department, group name, the campus (if multi-campus is turned on), and the leader of the group. There are also custom group titles and values stored in this table.

**Group Members**
The *Group Members Table* indicates which people are enrolled in a group. The fields include group name, the person’s ID and the custom fields defined by your church.

**Sessions**
The *Sessions Table* contains the day of the week and the times that a group meets.

**Attendance Summary**
The meetings table contains an attendance summary for a group or service for a date.

**Attendance**
The *Attendance Table* contains the specific attendance information for a group or service. Who attended, on what day, and what time.

**Sets**
A *set* is a grouping of records. Each time you execute a query a set of records displayed. Once you have the list or “set” you may save it.

To save a set, press the SAVE SET button. A file dialog box will be displayed allowing you to choose the location and to name the file. After you’ve entered this information press SAVE.

Now this set can be used for multiple tasks. For example, let’s say you are creating a
merge letter to people that have donated to a certain fund. You need to give the pastor a list of those people, you need to create the merge letter and you need to create labels for that group of people. Those are 3 different tasks, but all with the same “set” of people. You could do the query once, save the set, then re-use the set for each of the tasks. PLEASE NOTE: the set is only a snapshot of who has given to a fund at that particular time. The set does not change as more people give to that fund.

To call up the “set”, you may use the GET SET button any time you are at a query editor window with the same Find Records In table name. You may also click on the GET SET icon from the Summary screen. If your set was for people records then the Find Records In must also be for people. If the set you saved was Donation records, the Find Records In must be for Donations.

Current selection
Roll Call stores the results of the last query performed in memory. You can always recall those results by clicking the CURRENT SELECTION button from the query editor.

For this example, let’s say you did a query then accidentally clicked on the CANCEL button from the results screen. You could go back to the query editor and press the CURRENT SELECTION button to retrieve your results.

Basic Query
To query you’ll need to fill in the following information:
1. The table you’ll be querying from. For example, if the criteria is the City, you’ll be querying from the Address table. Enter this in the Query In portion of the query editor.
2. The field name. In that same example, if the criteria is City, you’ll need to select City from the Field Name drop down box.
3. The comparison. In this example the comparison would be “is equal to”. Highlight that in the Comparison box.
4. The value. Enter the name of the city you are interested in, in the Value field.
5. Press the QUERY button. A list of all the people who live in that city will be returned.
Multiple criteria query

Let’s say you want to know all the people that are over 30 years old that are members. We’ll have two lines in this query.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Enter People as the Query In table. (Both association and year to date are stored in the people table)
3. Select “Age” from the Field Name drop down box.
4. Highlight “is greater than” in the Comparison box.
5. Select 30” as the Value.
6. Press the ADD LINE button.
7. Select “Association” from the Field Name drop down box.
8. Highlight “is equal to” from the Comparison box.
9. Enter Member as the Value.
10. Press QUERY. A list of folks over 30 who are members will be displayed.
Associations query
Let’s say you want to know all the people that are Members or Regular Attenders. In this example, we’ll need to use the Associations tab of the query editor.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Click on the Associations tab.
3. Click on each Association you want to include in the query.
4. Press QUERY to execute the query.

Groups query
Let’s say you want to know all the people that are in the Children’s Department classes. In this example, we’ll need to use the Groups tab of the query editor.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Click on the Groups tab.
3. Click on each Group you want to include in the query.
4. Press QUERY to execute the query.
An either/or criteria

In this example, let’s say we need a list of all the people who live in a certain city OR they are assigned to a specific shepherd area.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Enter “Address” as the Query In table. (both city and shepherd area are stored in the address table)
3. Select “City” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Enter “Evergreen” as the Value.
6. Press the ADD LINE button.
7. Press the OR button. Notice the AND is changed to OR on the second line.
8. Select “Shepherd Area” from the Field Name drop down box.
9. Highlight “is equal to” from the Comparison box.
10. Select “Aram’s” as the Value.
11. Press QUERY. A list of people who live in Evergreen OR are in Aram’s shepherd area is displayed.

Date range criteria

For this example, let’s create a query that gives us a list of people who have given a donation between January 1, 2006 and July 31, 2006.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Enter “Donation” as the Query In table. (donation date is stored in the Donations table)
3. Select “Donation Date” from the Field Name drop down box.
4. Highlight “is greater than or equal to” in the Comparison box.
5. Enter 1/1/10 as the Value.
6. Press the ADD LINE button.
7. Select “Donation Date” again from the Field Name drop down box.
8. Highlight “is less than or equal to” from the Comparison box.
9. Enter 01/01/12 as the Value.
10. Press QUERY. A list of people who gave between 1/1/10 and 01/01/12 is displayed.
A partial name criteria

In this example we’ll use a wildcard character. The wildcard in Roll Call is the @ symbol. Let’s say we want to find all the people whose first name begins with KIM.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Enter “People” as the Query In table. (first name is stored in the People table)
3. Select “First Name” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Enter “KIM@” as the Value.
6. Press QUERY. A list of people with the first name of Kim or Kimmy or Kimberly etc...will be returned.
Complex Queries

Association plus other criteria
In this example, let’s find all the people that are members, regular attenders and their zip code is 61010
1. Select People>People Summary from the main menu, then click on the SEARCH icon..
2. Click on the Associations tab and click over Member and Regular Attender.
3. Click on the Editor tab.
4. Select Address as the table.
5. Select City in the Field drop down
6. Highlight “is equal to” in the Comparison box.
7. Enter Evergreen as the Value.
8. Press QUERY. A list of all the people that meet that criteria are listed.
**Multi-Table query**
You may need a list, in which the criteria spans several tables. For example, give me all the people who have donated since 2012 who live in Byron.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Enter “Donation” as the *Query In* table. (donation date is stored in the Donations table)
3. Select “Donation Date” from the *Field Name* drop down box.
4. Highlight “is greater than or equal to” in the *Comparison* box.
5. Enter 1/1/12 as the *Value*.
6. Press the ADD LINE button.
7. Change the *Query In* table from “Donations” to “Addresses”.
8. Select “City” from the *Field Name* drop down box.
9. Highlight “is equal to” in the *Comparison* box.
10. Enter “Byron” in the *Value* field.
11. Press QUERY. A list of people gave after 1/1/12 a who live in Byron is returned.

**Query in Current Selection**
Querying within a current selection allows you to limit your query to only those records that are in the current selection. Let’s say you’ve just done a query of all the people who are Members. Then, you want to know who has given in the last 6 months.

From the results list, press the SEARCH icon. The query editor is displayed again.
1. Select Donation as the “Query In” table.
2. Select “Donation Date” from the *Field Name* drop down box.
3. Highlight “is greater than” from the *Comparison* box.
4. Enter 1/1/12 in the *Value* field.
5. Press QUERY CURRENT SELECTION. This will reduce your first list of Members that have given since 1/1/12.
Some queries require the use of the connector AND as well as the connector OR. When using both And and OR remember to place the OR statements first. An example of this type of query would be, give me a list of all the children or youth who have been baptized. I have Baptized as a custom check box field.

1. Select People>Summary from the main menu and click the SEARCH icon.
2. Leave People as the Query In table.
3. Select “Family Position” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Select “Child” as the Value.
6. Press the ADD LINE button.
7. Press the OR button. Notice the AND is changed to OR on the second line.
8. Select “Family Position” from the Field Name drop down box.
9. Highlight “is equal to” from the Comparison box.
10. Select “Youth” as the Value.
11. Press the ADD LINE button.
12. Select “Baptized” from the Field Name drop down box.
13. Enter ‘is greater than or equal’, for the comparison; then put your date for the value.
14. Press QUERY. A list of all children and youth who have been Baptized since that date are displayed.

To perform additional queries on these results, click SEARCH icon.
Query using Except
For this example let’s say we want to find all people who live in Byron, but not on Staff. In this example Staff is an Association.

1. Select People>Query from the main menu.
2. Leave “People” as the Query In table.
3. Select “City” from the Field Name drop down box.
4. Highlight “is equal to” from the Comparison box.
5. Enter Byron.
6. Click the ADD LINE BUTTON.
7. Click the EXCEPT button. The AND changes to EXCEPT.
8. Select “Association” from the Field Name drop down box.
9. Highlight “is equal to” from the Comparison box.
10. Select “Staff” as the Value.
11. Press QUERY. A list of people that aren’t on staff, who live in Byron is displayed.

Comparing two result sets
There are several ways that you can compare two sets:

An intersection compares the results of two queries and returns the records that were common to both sets. For example, I want a list of all the people who have donated and are enrolled in a group.

A union combines the results of two queries. An example of the union is – give me a list of people who either donated or joined a group.

A difference would subtract out the records that were common to both sets. An example of the difference is – give me all the people who donated but are not in a group.

For these examples, let’s look at all the people in our database that have donated in the last year. Then let’s compare that to the list of people that belong to a small group.

For the first query:
1. Select People>People Summary from the main menu, then click SEARCH icon.
2. Change the *Query In* table to “Donations”.
3. Select “Donation Date” from the *Field Name* drop down box.
4. Highlight “is greater than” from the *Comparison* box.
5. Enter the earliest date of donations to consider, for example 1/1/12.
6. Press QUERY. A list of people who gave to the church on or after 1/1/12 is displayed.

From the results list, press the SELECT button. This brings up the screen that allows you to perform the intersections, unions and differences. In the left box labeled Set A, mark the button for Current Selection then press the button GET SET A. Now SET A contains all the people who have donated since 1/1/12.

Next, let’s move over to the box labeled Set B. Click on the button for Query Editor, and press the button GET SET B. The query editor is displayed.

1. Change the *Query In* table to Group “Membership”.
2. A window is displayed allowing you to select a specific group. Press the CANCEL button here. We want all groups for this example.
3. Select “Group Name” from the *Field Name* drop down box.
4. Highlight “is equal to” in the *Comparison* box.
5. Enter the wild card character @ (this tells Roll Call we want any group).
6. Press QUERY. The people who are in a group are in SET B.
Next, click the button to *Combine Sets*, if you’d like to see the “union” of the two sets. That is, the combination of the people who gave and the people who are in a group. Press the OK button to see the results of the *intersection*.

Click *Subtract B from A*, if you’d like to see the “difference” between the two sets. This would show you all the people that gave but are not enrolled in a group. Press OK to see the results of this *difference*.

Click *Subtract A from B*, if you’d like to see the “difference” between the two sets. This difference would give you the people that are in a group, but have not donated. Press OK to see the results of this *difference*.

Click the button to *Common to A and B*, if you’d like to see the “intersection” of the two sets. That is, the people that have both donated and belong to a group. Press the OK button to see the results of the *intersection*.

### AND, OR and EXCEPT

“Or” increases the possible results by allowing more ways for records to be selected. “And” restricts the possible results by compounding the requirements. “Except” restricts results by introducing exceptions or exemptions. If you need to use more than one of these conjunctions, place the OR statements first, then the AND statements, then the EXCEPT.

### Save a Query

Let’s say you do a query of Members, Regular Attenders and Occasional Attenders on a regular basis. To save the query text, press the *SAVE QUERY* button. A file dialog box asks for the location to save and the name of the file. Enter this information, then press *SAVE*.

To use the *query* later, press the *LOAD QUERY* button from the query editor. A file dialog box is displayed. Navigate to the file you saved previously. The query text is displayed in the *Query Editor*. Press the query button to execute the query.

### Special Query

There are some searches that require more complex algorithms. These searches have been “pre-set” for you to use. From the results list of a query, click on the SPECIAL icon.

Click on the query you’d like to perform. Then click OK.
Change Selection to Heads
This search can only be done from within a results list. It will reduce the list to include only the Heads of Family for each family that was represented in the list. For this example, let’s say we had a list of the children from our first grade class. If we choose to change to the heads of family, the children will not be in the list anymore, only the head of their family will be listed.

Change Selection to Mothers
This search can only be done from within a results list. It will change the list to include the Mothers for each family that was represented in the list. For this example, let’s say we had a list of the children from our first grade class. If we choose to change to the Mothers, the children will not be in the list anymore, only the Moms will be listed.

Change Selection to Fathers
This search can only be done from within a results list. It will change the list to include the fathers for each family that was represented in the list. For this example, let’s say we had a list of the children from our first grade class. If we choose to change to the fathers, the children will not be in the list anymore, only the dads will be listed.

Change Selection to Adult and all Children
This search can only be done from within a results list. It will change the list to include an adult and all the children of each family that was represented in the list. For this example, let’s say we had a list of the children from our first grade class. If we choose to change to the adult and all children, the husband, wife or adult from the family plus all the children in the family will be displayed in the list.

Find Single Parents
This search finds the single parents.

Find Keywords
Keywords allow you to classify people by interests, giftings etc. To search for all the people that have certain interests, talents or gifts – use this special query. Once you click OK from the special search window, a keyword query editor will be displayed.

1. Click on the appropriate Keyword Field.
2. Highlight “is equal to” in the Comparison box.
3. Enter the value of the key word you are searching for, for example “Mechanic”.
4. Press QUERY to get a list of all the people who are categorized as Mechanics.

To specify more than one keyword, use the ADD LINE button and repeat the process. For more information on multi-line queries, see the section in this chapter on creating basic queries.

Find possible blended families
This search looks for families with more than two members, where at least one person has a different last name.

Find people with picture
This search looks for individuals who have a picture in Roll Call.
Find families with a picture
This search looks for families that have a picture in Roll Call.

Find possible uninvolved families
This search allows you to specify the type of “uninvolved”. When you select this search, the uninvolved window is displayed.

You may check one or all of these boxes. If you select multiples, an AND conjunction is used.

If you check the box for “hasn’t given”, you may also specify a since date. For example, I want to know what families have not given since the beginning of the year. I would check “hasn’t given”, then enter 1/1/10 as the date.

If you check the box for “hasn’t attended” – this will tell you what families haven’t attended any event (worship service or group/class) in the last year.

If you check the box for “hasn’t joined group” – this will tell you what families haven’t recently (based on the since date) joined a group.

If you check the box for “haven’t had their record modified” – this will tell you which families have not had any of their demographic information changed since the date you specify.

Check the appropriate criteria for “uninvolved”.

Identify families who:
- Haven't Given
- Haven't attended
- Haven't joined a group/class
- Haven't had record modified

Since: 3/12/12

Cancel  Continue
CREATING CUSTOM REPORTS

If the standard reports in Roll Call do not meet your needs, use the Quick Report writer to create custom reports. The Quick Report editor is a tool provided with the 4D database that Roll Call is written on. This chapter outlines the basic usage of the Quick Report editor within the context of Roll Call.

To create a Quick Report you’ll need to determine several things:
1. What table should the report be based on? That is, what is the report about: people, donations, groups, etc..?
2. What “set” of information should be included in the report?
3. What columns or fields do I want in the report?
4. How do I want the information sorted?
5. Are there any calculations required in the report?

Create a custom report

To create a Quick Report follow these main steps.
1. Select Reports>Quick Reports from the top menu.
2. Click on the Reports tab.
3. Click the ADD icon.
4. Perform the query to determine what data should be included in the report.
5. Format the report.
6. Generate the report.

Click on the Reports tab to create a custom report.

Click the ADD icon.

Highlight your “base” table.
Base Table

Each Quick Report must be based on a table. The report can contain values from multiple tables, however, the table which contains the lowest level of information must be the “base” table. For example, if we want a report with People’s name, Address, Donation and Designation information, Designation would be the “base” table. If we wanted a report with Group information as well as the Members in the group, Group Membership would be the base table.

To begin creating the report, expand the Reports&Labels menu on the left side. Select Quick Reports. Select the base table from the left sidebar. Click on the green plus sign or ADD icon. Next, you’ll be prompted with the query editor to determine what records should be included in the report.

Data for the Report

Once you’ve clicked the ADD icon, the query editor is produced so that you may select the data you’d like included in the report. For a detailed description of using the query editor, see “Using the Query Editor”.

For this example, let’s create a report of all the people who are female.

From the Query Editor, keep the Query In table in People. In the Field drop down, select Gender. In the Comparison box, choose “is equal to”. In the Value field select female. Press the QUERY button.

Select columns for the report

Now that you have the data (the people that will be included), you must determine what information you want to see about each of those people. From the Quick Report editor, you may select a column by double clicking on it. In this example, notice the list of people fields under Master Table.
To create a report with *First Name*, *Last Name*, *Address*, *City*, *State*, and *Zip Code*, double click on the *First Name* field, then the *Last Name* field. Once you double click on the field name, a column will be created in the upper part of the quick report editor for that field.

Next, use the drop down box to change *Master Table* to *Related Tables*. You should see a box to the left of *Family Info* on Windows or an arrow to the left of *Family Info* on the Mac. Click on that box/arrow. The list of *Address fields* will be displayed below. Double click on *Address, City, State, Zip* etc. to include them in the report.

**Calculated columns**

To create a column that uses a *formula*, select Column>Add from the *Quick Report* menu. The *formula editor* is displayed. The *formula editor* allows you to combine the values of multiple fields, return certain values such as YES/NO instead of TRUE/FALSE, perform *mathematical equations* and use *pre-written functions*. 
**Concatenation**

To combine the values of multiple fields into one column, you can use the plus sign in the formula editor. Common examples of combining field values would be to have the last name, a comma, then the first name, or combining the area code and phone number.

For this example, let’s create a name column. Double click on the Last Name field found under the box Related Tables. The name [People]LastName is placed in the formula editor box. Next, click on the plus sign. Next, enter a quote mark, a comma, a space then another quote mark. Next, click on the plus sign again. Now, double click on the First Name in the section below Related Tables. The formula should read:

[People]LastName","+"[People]FirstName

Click the OK button to accept the formula.

**Equations**

You can perform mathematical equations within the formula editor. You can add, subtract, multiply, divide and create percentages. For this example, let’s say we wanted to add a person’s total giving this year and last year’s amount.

Double click on the Year to Date field found under the box Related Tables. The name [People]Year to Date is placed in the formula editor box. Next, click on the plus sign. Now, double click on the Last Year field in the section below Related Tables. The formula should read:

[People]YearToDate+[People]LastYear

Click the OK button to accept the formula.

**NUM function**

The num function allows you to return a constant, based on a field value. This comes in very handy for Boolean or checkbox type fields where the value is either True or False. By using the NUM function you could choose to return an X if the value was True or you could return Yes if it was True and No if it was False.

For this example, let’s assume we have a custom checkbox called Newsletter. In our report, we want to return an X if the person wants to receive the newsletter. The formula is:

(Num([People]Newsletter)*"X")
If you wanted to return a *Yes or No*, the formula would be:

\[(\text{Num}[\text{People}\text{Newsletter}=\text{True}]\times\text{"Yes"})+(\text{Num}[\text{People}\text{Newsletter}=\text{True}]\times\text{"No"})\]

**Roll Call functions**

The following functions can be typed into the *formula editor*, or selected from the *commands by theme* box to the right. Scroll down to reach the functions in *italics*. Double click to select the function you need.

**DoBuild_Label** – this function returns an address block for an individual. It contains the name and current address.

**Jim_Sue_Label** – returns an address block using the first name of the head of family plus the spouse name and the last name, then the address.

**Family_Label** – returns “Mr. & Mrs.” Plus the first and last name of the head of family, then the address.

**Different_Last_Name** – returns an address block with the first and last name of the head of family plus the first and last name of the spouse (if the last name is different).

**Get Many -> People -> Group Membership** – returns a list of all groups that the person is involved in.

**Get Many -> People -> Pledge funds** – returns a list of all the pledge funds this person has pledged to.

**Get Many -> People -> Pledges** – returns a list of all the amounts a person has pledged.

**List_Phones (“All”)** - Produces a list of the “non-standard” individual phone numbers that are stored in the telephone table.

**List_Family(“ ”)** Returns a list of all the family members.

**Get Children(0)** – Returns a list of the children for a family.

**Build_Salutation** – Returns the head of the family’s nickname plus the spouse’s first name.

**Get DES Function(TRUE)** – Returns a list of donations to the current pledge record.

**Get DES Function (FALSE)** – Returns the total of donations to the current pledge record.

**Designation SUM** – Returns the total for the designations.

**Summary Information**

You can use the *sum, average, minimum, maximum* and *count* functions for a column. For this example, let’s say we have a report that lists donation information for a date range and we want the *grand total donated* as well as the *number of donations given*.

1. In the cell where donation amount and grand total intersect, right click to get SUM (backwards E) or select Cells>Sum from the *Quick Report* menu.
2. In the cell where name and grand total intersect, click on the COUNT icon (N) or select Cells>Count from the *Quick Report* menu.

![Icons for the Sum, Average, Min, Max and Count functions.]

Place your cursor in this cell and then right click for SUM or COUNT.

Sort the Report

To sort the report by a specific column, highlight the *field name*. Next, press the green arrow to the right, to move the field to the *sort order* box. For example, let’s say we have a report that lists people information and we want it *sorted by name*. First, highlight *Last Name* and press the green arrow. *Last Name* is now listed in the *sort order* box. Then if you’d like to sort by *First Name* within the same *Last name*, highlight *First Name*, and press the green arrow.

![Highlight a field name, then press this arrow to move to the sort order box.]

Notice the *field name* changed row that is created for each *sort criteria.*

Format the Report

There are several *formatting options* in the report writer. These allow you to EDIT the *titles*, *page breaks*, whether to display *detail lines*, and the *presentation* of the report.

**Titles**

To set up the *title* of your report, select File>Headers and Footers from the *Quick Report* menu. Enter the text you’d like for your *title* in the appropriate text box.
Page breaks
To create a page break, you must have sorted your report on a certain field. Then you can create a page break each time the value of that field changes. For example, let’s say we created a report that lists all donations for a given year. We wanted to sort those donations by the fund that they were designated to. Then we want a new page for the different funds.
When you sorted the report by designation, a new line or row is created in the spreadsheet called Designation changed. Right mouse click on that title and select Totals Spacing. The subtotals properties window is displayed. Click on the button for Generate Page Break.

Hide details
To create a summary report you will need to hide detail lines. For example, let’s say you want a donation report by fund designation. You only want totals for the designation, not every individual donation.
Output presentations
There are several things that can be done to change the appearance of the report.
1. Page Setup
2. Fonts
3. Presentation

To change the orientation of the report from portrait to landscape, select File>Page Setup from the Quick Report menu. Choose the appropriate orientation.

You may change the font or the font size for a row, column or specific cell. Highlight the area you wish to change, then select the font style in size from the drop down boxes in the middle top of the window.

To modify the presentation of the report you can:
1. Select Style>Borders to modify the types of border included in the report.
2. Select Style>Presentation to pick a certain presentation.
3. Select Style>Right/Left Justify to change the justification of a column.

Print the Report

To send the report to the printer, select File>Generate. The print dialog box will be displayed, so you may choose your printer. If you’d like to save the report to a file, select File>Destination. Change the destination to a Disk File. Then select File>Generate from the menu. A file dialog box will be displayed so that you can save this report as a tab delimited text file. These types of files can easily be imported into 3rd party programs, such as a spreadsheet.
Re-use the Report

Once you’ve created the report, you’ll want to save the template so it can be used again. The template is the columns and the formatting options that were selected. Select File>Save from the Quick Report menu. You’ll be asked for a file name and location. Give the report a name that is meaningful to you. Once you close the Quick Report editor window, you’ll see the report listed in the Tables and Templates window.

To run the report again, select Reports>Quick Reports from the top menu. From the Tables and Template window, highlight the report you’d like to run. Then, press the GENERATE icon. The Query Editor will be displayed, so you can select the data you want in the report. A print dialog box will be displayed, so you can send the report to the printer.

Edit a Saved Template

To edit the report, select Reports&Labels>Quick Reports from the main menu. From the Tables and Template window, double click on the template you’d like to modify. The Query Editor will be displayed, so you can select the data you want to see in the report. After you review the raw data, press the EDIT icon. A message will be displayed, telling you the name and location of the template file. Remember this information. Once you are in the Quick Report window, select File>Open from the report writer window. Then, navigate the template file from the message, highlight it and press SAVE. The columns and formatting will be displayed in the Quick Report window.

Make any changes you’d like to the columns or formatting on the report template. To run the report select File>Generate. If you’d like to save the changes, press File>Save.
CREATING CUSTOM LABELS

If the standard labels in Roll Call do not meet your needs, use the custom Label writer to customize your format. The Label writer is a tool provided with the 4D database that Roll Call is written on. This chapter outlines the basic usage of the Label writer within the context of Roll Call.

When creating a custom label you’ll need to determine several things:
1. What “set” of people should have a label?
2. What fields do I want in the label?
3. How do I want the information sorted?

Which People

To begin customizing a label:
1. Expand the Report & Labels menu on the left side of the navigator window.
2. Click on the Quick Reports, then choose the Labels tab.
3. Highlight your base table.
4. Click on the ADD icon.

Once you’ve clicked ADD LABEL the query editor is produced so that you may select the people. For a detailed description of using the query editor, see “Using the Query Editor”.

For this example, let’s create a label for all the people who are Members.

1. Select “People” as the Query In table.
2. Select “Association” as the Field Name.
3. Highlight “is equal to” in the Comparison box.
4. Enter “Member” as the Value.
Place the Fields on the Label

Now that you have the data (the people that will be included), you must determine what information you want on the label. From the list of fields, highlight the field you want, then drag it to the label template to the right.

For this example, let’s create a label with the standard name and address.

1. Highlight First Name and drag it to the template.
2. Highlight Last Name and drag it on top of First Name. This will concatenate the two fields.
3. Click on the plus sign (+) or the arrow in front of Family Info. This will open up the address fields.
4. Highlight Address 1 and drag it to the label template under the first and last name.
5. Highlight City and drag it under the Address1 field.
6. Highlight State and drag it on top of City.
7. Highlight Zip and drag it on top of State.
8. To align the fields on the left, click on each field while holding down the shift key. This should place boxes that indicate the row is selected. When everything is selected press the ALIGN LEFT icon.
9. To evenly space between the rows of information, leave all fields selected and press the SPACING icon.
10. To change the font and font size, leave all the fields selected and change the font from the drop down box in the lower text area.

**Static text**

Enter the text you’d like on the label in the Static Text field underneath the list of fields. Then, click on the arrow above the field to move the text to the label template. Once the text is on the label template you may drag it around, change the font and size.

**Change Label Format and Size**

Click on the Layout tab in the Label editor. This tab allows you to select the number of labels per sheet, the size of the labels, and the horizontal and vertical gap between labels.
Print the Labels
To send the labels to the printer, press the PRINT button. The print dialog box will be displayed, so you may choose your printer.

Re-use the Label Template
Once you’ve created the Label template, you’ll want to save it, so it can be used again. The template is made up of the fields, static text and the formatting options that were selected. Press the SAVE button. A file dialog box is displayed. Give the label a name that is meaningful to you. Once you close the Label editor window, you’ll see it listed in the Tables and Templates window.

To print the labels again, expand the Reports & Labels menu. Click on the Quick Reports and select the Labels tab; highlight the label you’d like to run. Then press the GENERATE icon. The Query Editor will be displayed, so you can select the data you want in the label. A print dialog box will be displayed, so you can send the labels to the printer.

Modify a Label Template
To edit the label, expand the Reports & Labels menu on the left side. Click on the Quick Reports and select the Labels tab. Double click on the template you’d like to edit. The Query Editor will be displayed, so you can select the people you need labels for.

A message will be displayed, telling you the name and location of the template file. Remember this information. Once you are in the Label Editor window, press the LOAD button. A file dialog box is displayed. Navigate to the template file from the previous message, highlight it, then press OPEN. The columns and formatting will be displayed in the Label Editor window.

Make any changes you’d like to the columns or formatting on the label template. To print the labels, press the PRINT button. If you’d like to save the changes, press SAVE.
The export function in Roll Call allows you to define your own exports. You can export people and address information into tab delimited, csv or spreadsheet type of format. There are two types of Export options: Custom and Lifetouch. Custom exports allow you to choose your own people or address information, while Lifetouch is the ability to export data for Lifetouch (a picture directory service) to use in developing directories for your congregation.

**Export**

To create a Custom export file, expand the People menu on the left side bar. Click on Export. Then select Custom Export as the Export type.
Select the file format for the export.

Click GENERATE to create the export.

Click SAVE to save this export format for later use.

Once you’ve identified who will be in the list, click on the Columns tab to select what data is included in the export. On the right side of this window, you can choose the file format.

The View Records tab allows you to see which people will be included in the report based on the criteria you selected.

Click GENERATE to create the export file. You’ll be prompted for a file name and location. Click SAVE to save this export format for later use.

**Lifetouch Export**

If you decide you want to work alongside Lifetouch to create your directories, there are two options for you to consider:

1. Export family and/or individual information in the proper formatting that Lifetouch is looking for that they can create the directories themselves. They will need a file that can pulled into an Excel format (.lcd), and also a “Sit Report”. A Sit Report is a report on each family that includes a barcode of the family, so that when Lifetouch comes to your church or organization to take the photos, they can scan the barcode on the report and immediately have the family information in front of them.

2. Import pictures already taken by LifeTouch into Roll Call’s family and individual Picture tab area within each family and individual profile. Individual pictures can then be used in the child check-in area, if you wish; or you can create your own Roll Call picture directories for Families or Groups in booklet or other formats, with your own custom data, etc...
Exporting to Lifetouch

If you plan on exporting information to be sent to *Lifetouch*, open up People>Export option. Once you are in this area, decide *who* you wish to run the Export for. The default is set to run for *Everyone*. If you need to narrow that down, select from the dropdown list and run a query based on who you wish to see in the report. Once you have found the correct list of people, select the Export Type of *Lifetouch*. If you only need the basic export run with head, spouse, children, address, phone and email information, select Generate. If you need to select additional options or change settings or locations of the where the file is to sent to, click on the *Settings* and make selections there based on what additional information you wish *Lifetouch* to use in their directory.

To export to the *Lifetouch* folder, click *Export* here.

Select *Lifetouch* for your export.

To close the screen select this red X. Your changes will automatically be saved.

Under *Settings*, you can choose what information you need to export. Here are some options to choose from.

Select *Include Individuals* to include information on individuals in this report, not just families.

Select *Generate* to generate your .lcd export or *Sit Reports*.

Select *Settings* to adjust settings or add more info to your *Lifetouch* export.

Choose from your dropdown list to help you run your query.
1. *Family Options*- for additional *Family Options*, you can include an *anniversary date* in your Lifetouch directory. Roll Call automatically includes the head, spouse, children, address, phone and email information.

2. *Individual Options*- To include individual information in your export, select the option of *Include Individuals*. You can also choose whether or not to *Include birthdays* or *Include cell phones* of individuals.

3. *Church Options*- mark which church info you wish to see on the *Lifetouch* directory. your options include: church email, or church website. If this email or web address needs editing, that can only be done from under the Home>Organization area of Roll Call.

4. *Output*- Be sure to select *Sit Report* if *Lifetouch* is coming to your facility to take pictures of individuals and families. The *Sit Report* will include the family and individual barcodes so that Lifetouch can easily pull up their information. The second option to select is *Create Lifetouch LCD* file. This will create the export file in LCD format. Lifetouch uses this to create your directories with the information that you selected. Before generating this file use the BROWSE button to designate where you want this file to pointed. Creating a folder named Lifetouch would be appropriate for this. You can opt to select both the *Sit Report* and *Create Lifetouch LCD* file at the same time. Once you have selected from the above options, close the screen using the red X, then select *Generate*. The file will be sent to your folder. If Print *Sit Report* was selected, those will be sent to the printer.

When you are ready, you can either open your lcd file in Excel to view it, or attach this file to an email to email it directly to *Lifetouch*.

**Print Sit Report**

If *Lifetouch* is coming to your facility, you will want to print a *Sit Report* for all of the families that will be coming in for picture taking. To do this, select *Export* under the *People* menu. Figure out who you wish to run the reports for. You can use the dropdown list to assist you in your query. Once you have narrowed down your list, or chosen to run for *Everyone*, click on *Settings*. From here, checkmark *Sit Report* and choose any other data for your export, if you are generating that as well. Press *Close*, then select *Generate*. Your *export file* will be generated when you press OPEN, then the *Sit Reports* will be sent to your printer afterwards when you select *OK*.

These folks have family pictures. You can tell because their ID is a Family name plus a number code.

These folks have individual pictures. You can tell because their ID is a number.
Exporting pictures from Roll Call

If you have pictures inside of Roll Call you need to export to a folder, use Roll Call’s Picture Import/Export function. Go to People>Bulk Changes, and select Pictures. Since you already have pictures in Roll Call, you will see them here under the Individual or Family columns. If you are ready to export in pictures, select IMPORT/EXPORT in the lower right hand corner of the screen. To Export pictures, select the Export button from this page and find the folder or create the folder you wish to put the copy of the images in. Pictures for individuals will be named with a Roll Call person number and the file type (i.e. 1002.jpg). Family pictures will be named with Roll Call’s family info number plus the file type (i.e. HartBud138XX.jpg). Once you have the folder located, select OPEN and a of the copy pictures will be exported to the folder.
To Import pictures from Lifetouch, select People>Bulk-Changes, then select Pictures. For more information on importing and directories, see the chapter on Directories.

To delete a picture, right click and select Delete.

This Import to find your Lifetouch folder and pull in your pictures to Roll Call. For more information on using this function, go to the chapter on Directories.

If you export your pictures to a folder, select this Export button. They will be named with the person number for individuals, and the family info number for families.

Notice the columns with individual and family photos.

To move your picture to another person, you can drag and drop it in place.

Press Import/Export here to begin your Export.
Family Export

This export file contains the following information for a family:

1. Head of family name
2. Head of family gender
3. Head of family birth date
4. Head of family individual phone numbers
5. Head of family custom field 1 & 2
6. Spouse’s name
7. Spouse’s gender
8. Spouse’s birth date
9. Spouse’s individual phone numbers
10. Children’s names and birth dates
11. Children’s names
12. Children’s names and ages
13. Parents wedding anniversary date
14. Current address
15. Primary/Local address
16. Alternate address.

To create this file, expand the People menu on the left side. Expand the Reports menu under the People menu. Click on Family Export. A window will be displayed allowing you to select the addresses that should be included as well as which phone numbers that should be included in the export. Press OK, when you’ve made your selections.

Select people using associations

The next window allows you to select the families you’d like included in the file. To indicate specific associations that should be included, click over each association to the Include box. For example, if you’d like to include members and regular attenders in the file, click on the association “Member” from the Select List box on the left. It will move over to the Include box on the right. Next click on “Regular attender” from the Select List box. It will move over to the Include box.

Mark this as YES to receive an asterisk by your chosen association.
Click the EXPORT DIRECTORY button. You’ll then be prompted for the file name. Your file will be saved as a text file (.txt) and placed in a folder that you designate it to. You will be able to open from Excel at your convenience.

**Select people using the query editor**

If you would like to determine who is placed in the file by another criteria, you can use the Query Editor. For example, lets say you only want those folks that live in a certain city to be included in the directory. From this window, click the USE QUERY EDITOR button. The Query Editor will be displayed.

1. Change the *Query In* field to Address.
2. Select City from the *Field Name* drop down box.
3. Highlight “is equal to” in the *Comparison* box.
4. Enter the name of the city in the *Value* field.
5. Click on the QUERY button.
CLEANING UP THE DATA – DATA ADMINISTRATION

List of Valid Values
Most lists can be changed. The “lists” are the valid values that you can enter for a field such as Association, Keywords, Custom Fields, City, Telephone Types, etc...

To modify this information, expand the Administration menu and click on Lists. A screen with all the lists will be displayed.

Click on the list you’d like to modify.

List of all the “valid value” lists.

Click the plus sign to add a value, click minus to delete an item.

From this window, click on the type of list you’d like to modify. The current list of values will be displayed on the right. To add a new value, press the plus sign. A line will open up for you to add the value. To delete a value, highlight it, then press the minus sign. To modify a value, double click on the value, then make necessary changes.

Duplicate Check

To identify potential duplicate records, expand the People menu. Click on Find Duplicate Records. The area to the right will allow you to select your duplicate criteria.

To see all the people that have the same first and last name, click the First and Last Name button. To see all the people that have the same address but are in different family units, click on the Same Address option. To see all the folks with the same home number, click on the option for Home Phone.

From the display of potential duplicates, click on a person that appears to be a duplicate record, then click on the next record that appears to be a duplicate with the first. These records will be placed side by side so you can view the information.

From the buttons underneath each record, you may perform several actions:
1. Click the DISPLAY button to view the person’s entire record.
2. Click the TRANSFERS button to transfer the donations from one record to the other.
3. Click the TRANSFER button to transfer other details such as visitations, group membership and comments.
4. Once you’ve viewed and transferred information as required, you may delete the unwanted duplicate record.
Click on Find Duplicate Records.

The list of potential duplications. Click on name to view it on the right side.

Choose how you’d like to find the duplicate records.

Display of a persons’ information.

Use these buttons to transfer information and then delete the empty record.

General Bulk Changes

Many of the people and group fields can be changed “en masse”. For example, if you wanted to change a city name from St. Thomas to Saint Thomas, you can use the bulk changes area.

Global change to people or address information

As an example, let’s say that you want to change all people that have an Association of Member to a new Association of “Partner”. To do this:

1. Expand the People menu.
2. Click on Bulk Changes.
3. Use the “Run For” area to select who you want to make this change to. In this example, select Associations, then click over Member.
4. Next, select the column you will be changing. In this example, it is Association.
5. Enter the new value for the Association; in this case, that is Partner. If Partner is not in your list yet, you will have to add that to your list of valid values under the Administration > Lists menu first.
6. When ready, press Process Change. A log window will appear when you are finished, confirming the changes that were made successfully.
Other Bulk Changes

Roll Call allows *bulk changes* in the following areas, besides General: Envelopes, Barcodes, Badge Numbers, and Pictures.

**Envelopes**

Please see the chapter on *Entering Contributions* for more information on how to set up your envelopes for your church.

**Barcodes**

*Barcodes* are used in Roll Call in the Child Check-in area. This area lists the people and their barcode ID. If you have not assigned this ID yet, you can do it here by getting out your barcode scanner, placing your cursor under the barcode ID column next to the person you are ready to assign an ID to, then scanning your keytag or whatever it is you have that has a barcode on it. For more information on barcode ID’s and Child Check In, see the special Child Check User Manual for Roll Call.
**Badges**

Badges are also normally used in Roll Call solely for Child Check In purposes, and are generated only for children. To view your list of badge numbers you can go here under People->Bulk Changes and select this BadgeNo area.

You can edit your badge numbers here. For more information on how to automatically or manually generate Badge Numbers, see the Child Check In User Manual.

**Pictures-Import**

To get a good look at all your Individual and Family Pictures in Roll Call, go to the Bulk Changes under the People menu, and select Pictures. To Import or Export Pictures, select the Import/Export button in the lower right. To import pictures, select the Import button. You will be prompted to find a file in your computer. In order to use the Import function you will need to make sure your person number in Roll Call matches the picture you have saved. When you find your file, select OPEN. Your pictures will then show in this Bulk Changes area. You can also Drag and Drop pictures into this area as well. To delete a picture, right click on it and select Delete. For more on Pictures and using the picture directory options and Lifetouch see the Chapter on Directories.

**Pictures-Export**

To Export picture information in Roll Call, go to Bulk Changes under the People menu. Select Pictures. Select the Import/Export, then the Export button. To export all pictures from Roll Call, click on the Export button and select the folder for which you’d like the pictures exported to. Individual pictures will be named with the person number followed by .jpg (i.e. 1002.jpg) Family pictures will be named with the family info field followed by .jpg (i.e. HartBud138XX.jpg). For more information on Pictures and using the picture directory options with Lifetouch, see the chapter on Directories.

Note **Bulk Changes** areas here: General, Envelopes, Barcodes, Badge Numbers, and Pictures.

You may drag and drop your pictures, or right click to delete.

Select Import/Export button to import or export your pictures from Roll Call.
Click **Import** to find your folder of pictures and pull them in.

Click **Export** to export all your Roll Call pictures to a specific folder.

---

**Global change to Group information**

As an example, let’s say that you want to change all the groups that have a Department of Children’s to “Kidzu”. To do this:

1. Expand the **Groups** menu.
2. Click on **Bulk Changes**.
3. Use the “Run For” area to select you want to make this change to. In this example, select **Groups** with a Department of **Childrens**.
4. Next, select the column you will be changing. In this example, it is **Department**.
5. Enter the new value **Kidzu**.
6. Press **Process Change** when you are ready. A log window will display your changes, when finished.

---

Select from the drop down list what you wish to update or change.

Enter the new value.

Select who you want to change.

Select **Process Change** to generate your change.
MAINTAINING THE DATABASE

Data File Location
The data file contains all the information that you have entered in Roll Call. Since this file contains all your work, make sure you know the name and location of it and that you back it up regularly.

The data file is comprised of two files: the 4D data file and the 4D resource file. The 4D data file name will end with the extension 4DD. The resource file will end with the extension 4DR. The name and location of your data file is found by selecting Help>About Roll Call in Windows, or Roll Call>About Roll Call on your Mac.

User Security

Activate Security
To activate the security system in Roll Call you will need to give Director a password. Once Director has a password, you will be required to log into Roll Call with a valid user name and password.

To give Director a password, expand the Administration menu. Click on User Security. Click on Director from the list on the left. Click on the CHANGE PASSWORD button. Enter a password.
Preferences

There are password preferences you can set for your system. The preferences allow you to select how often a person needs to change their password, if a password is required, how many characters the password needs to be, etc.

To set the preferences:
1. Expand the Administration menu.
2. Click on User Security.
3. Click on the Prefs icon (right side).
4. Enter the Maximum Password Age. If you do not want passwords to expire, mark the option for “Passwords Never Expire”. If you want the passwords to expire after a certain length of time, mark the option for “Expires In” and indicate how long.
5. Enter the Minimum Password Age. If you don’t care how often the user changes their password, you can mark the option for “Allow Changes Immediately”. If you only want them to be able to change so often, mark the option for “Expires In” then enter the number of days.
6. Enter the Minimum Password Length. If you wish to allow blank passwords, mark the option to “Allow Blank”. Otherwise, enter the “At Least” number of characters.

Create New User

To create a new user:
1. Expand the Administration menu.
2. Click on User Security.
3. Click on the plus sign in the lower left under the user names.
4. Enter the username for this user.
5. Enter a default password.
6. Indicate if this will be a standard user or a check in user. Standard users will see the Navigator window when the sign in. Check-in users will see the check-in screen when they log in.
7. Click OK to save that user.
8. Next, mark the security levels that are appropriate for this user.

**Security Levels**
The following are the security levels for a standard user:

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>If this box is checked, a user will have read only privileges for the areas marked.</td>
</tr>
<tr>
<td>People</td>
<td>If this box is marked, the user can view, enter and delete people information.</td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Groups</td>
<td>This allows the user to view, enter and delete groups.</td>
</tr>
<tr>
<td>Services</td>
<td>This allows the user to view, enter and delete worship services.</td>
</tr>
<tr>
<td>Contributions</td>
<td>This allows the user to view, enter and delete contributions.</td>
</tr>
<tr>
<td>Contributions Plus</td>
<td>This allows the user to post and reverse batches. They can also transfer contributions.</td>
</tr>
<tr>
<td>Pledges</td>
<td>This allows the user to view, enter and delete pledges.</td>
</tr>
<tr>
<td>Letters</td>
<td>Allows this user to access the word processor portion of Roll Call.</td>
</tr>
<tr>
<td>Visitation</td>
<td>Allows this user to view, enter and delete visitation information.</td>
</tr>
<tr>
<td>Background Checks</td>
<td>Allows the user to view, enter and delete background check information.</td>
</tr>
<tr>
<td>Attendance</td>
<td>Allows the user to view, record, modify and delete attendance information.</td>
</tr>
<tr>
<td>Graduation</td>
<td>Allows the user to set up graduation profiles and to do the graduation.</td>
</tr>
<tr>
<td>Expert</td>
<td>Allows the user to do the duplicate check, access preferences, child check-in setup preferences and bulk changes.</td>
</tr>
<tr>
<td>Confidential Comments</td>
<td>Allows the user to view, enter and delete confidential comments.</td>
</tr>
<tr>
<td>Custody Comments</td>
<td>Allows the user to view, enter and delete custody comments.</td>
</tr>
<tr>
<td>Email</td>
<td>Allows the user to email from Roll Call.</td>
</tr>
<tr>
<td>Edit Lists</td>
<td>Allows the user to create, modify and delete list of values. For example, Associations, Cities, and Keywords.</td>
</tr>
<tr>
<td>Assign Id’s</td>
<td>Allows the user to enter family numbers, badge numbers, and envelope numbers.</td>
</tr>
<tr>
<td>People Import</td>
<td>Allows the user to import people into the system.</td>
</tr>
<tr>
<td>People Export</td>
<td>Allows the user to export people information to a tab delimited file.</td>
</tr>
</tbody>
</table>

The security levels for check-in allow the user to get to the check-in screens. The information entered for the check-in user will determine what the check-in screen will look like.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Self Check-in</td>
<td>If the <strong>Self Check-in</strong> is marked, this check in station will only allows check in by scan or by the last four digits of a phone number. This user will not be able to modify any settings or print the check in roster.</td>
</tr>
<tr>
<td>Touch Screen</td>
<td>If the <strong>Touch Screen</strong> option is selected, the virtual keyboard will be displayed on the screen.</td>
</tr>
<tr>
<td>Rapid Check-in</td>
<td>The confirmation screen will not be displayed. The child is automatically checked into the class they are enrolled in and name tags are printed.</td>
</tr>
<tr>
<td>Return by Family or Return by Individual</td>
<td>If you choose “Return by Family” a list of families will be presented for you to choose from. If you choose “Return by Individual” a list of individuals will be returned.</td>
</tr>
<tr>
<td>Add Visitors</td>
<td>If this option is marked, this check-in user will be able to add visitors to the system and check them in.</td>
</tr>
<tr>
<td>Search by Name, Phone, Family Number, or Badge Number</td>
<td>This determines how you will be checking folks in. Will you do a search by name, a family or badge number of the last 4 digits of the phone?</td>
</tr>
<tr>
<td>Check-in Header</td>
<td>Enter the header you’d like for the check-in screen. For example “Wamba Land”.</td>
</tr>
<tr>
<td>Header Font, Size and Color</td>
<td>Choose the font size and color you’d like for the screen’s header.</td>
</tr>
<tr>
<td>Check-in Image</td>
<td>Pull in the logo for your church or ministry to be displayed on the check-in screen. Each user can have a different image.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Set the background color for your check-in screen.</td>
</tr>
<tr>
<td>Check out</td>
<td>This option allows the check-in user to use Roll Call to check out children. This will record their actual check out time.</td>
</tr>
<tr>
<td>List Only Children</td>
<td>With this option marked, the check-in screens will only list people with a family position of child, even if Return by Family is checked.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>If this is selected, the check-in user will be able to see a dashboard tab that allows them to view head counts of how many people are checked into each class.</td>
</tr>
</tbody>
</table>

Mark the options that are applicable for the user you have highlighted on the left. Make sure to click SAVE in the lower right when you are done.

**Locked User**

If a user tries to log in more than 5 times unsuccessfully, they will be locked out. To unlock a user, do the following:
1. Sign into the system as Director.
Backup on single user system

To create a Roll Call backup, select File>Backup. To schedule or redirect your backups, select File>Backup Configuration. You’ll be taken to the Maintenance window. Click on the three dots next to the Backup file destination folder on in the center of the screen and to the right. Choose your new destination. To schedule regular backups, select the Scheduler tab and select your regular backup options.

Click on the BACKUP icon.

Click Schedule to set a backup schedule.

Click Configuration to indicate where to put the backup.

Click to ... to browse your system and select your new backup.

Click here to set your automatic backup schedule.

Recover the database

You can recover from a backup from within the Roll Call menus, or from your operation system.

From Within Roll Call

Double click on the Roll Call icon, then immediately hold down the ALT key. Select the Maintenance and Security Center option. Click on RESTORE. Find the latest backup you wish to restore, highlight and press RESTORE.
From the operating system

If you can not get into Roll Call, you can open a backup file, by double clicking on the Roll Call icon, then immediately holding down the ALT key. The window displayed will allow you to restore a backup.
1. Select the option to “Restore a Backup”
2. Navigate to and highlight your backup file. Click OPEN.
3. From the next window Click RESTORE.

To open that newly restored backup with Roll Call closed, double click on the Roll Call icon and immediately hold down the ALT key. This time choose “Select another datafile”. Navigate to the backup folder that was restored, and open it. In there you will find your newly restored RollCall.4dd datafile. Highlight and select OPEN.

It’s a good idea to close Roll Call again, and make a copy of your newly restored datafile, then replace it back in the default location.
In Windows, the default location is: C://Bythebook/RollCall/Database.
In Mac: HD://Applications/RollCall
Backup a networked system

On the network, the backup can be done on the server or from the client. To backup from the Server, click on Maintenance from the Server dashboard. Next, click START BACKUP. To perform a backup from one of the clients, select Help>Administration window. This will display the Server dashboard and you can do the backup as if you were at the Server.

From the Server dashboard, click on Maintenance.

Click START BACKUP or click on PREFERENCES to set location, scheduling etc.

To set backup preferences, location, and frequency, click on Maintenance and click the PREFERENCES button. When you are anchored on the Configuration link on the left, you may set up the backup location. Make sure you backup both the data file and structure file. Also, if your church imports family or individual pictures make sure to also backup the Images folder under Roll Call Server.
When you are anchored on the Scheduler link on the left, you may set up the backup frequency.

Select your backup frequency and starting time.

To implement transaction log, click here and select location.

To indicate how many backups to retain and how to handle backup failures, click on the Backup link on the left.

Check to backup data and structure files.

Choose location of backups.
Indicate how many backups to retain.

How do you want to handle backup failures?

Indicate how to handle backups if there are active transactions.

Recover database from a backup on a network system

To recover from a backup, open Roll Call Server and immediately hold down the ALT/OPTION key to get the open file dialog box. Choose the option for *Restore from Backup*. Click OK. Navigate to your latest backup file. Highlight it and click OPEN. Your compiled database and data file will be recovered. Next, you can restart Roll Call Server.
Open a Different Datafile

To open a different data file, double click on the Roll Call or Roll Call Server icon, then immediately hold down the ALT key. Choose the option for opening a different data file.

Choose the option for selecting a different data file.

Click Continue.

Highlight the data file you want to open and click OPEN.

Compact the data file

Compacting your data removes any fragmentation within your data file. The process of compacting is slightly different depending on whether or not you use a stand-alone or server system.

Single user system
1. With Roll Call closed, double click Roll Call icon, then immediately hold down ALT.
2. Select Security and Maintenance, then select Compact on left side.
3. Click on the top icon for Compact data and indexes.

Roll Call Server
1. Make sure all clients are disconnected from Roll Call.
2. From the Server dashboard, click on Maintenance.
3. Click COMPACT DATA.
Repair my data file

To repair your data file, follow these steps.
1. Double click on the Roll Call or Roll Call Server icon, then immediately hold down the ALT key.
2. Choose the option for Maintenance window.
3. Click on the REPAIR icon on the left.
4. Click the REPAIR button.
Choose the option for Maintenance.

Click on the REPAIR icon.

Click here to repair the data file.
# Address Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Special Notes or Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Family ID</td>
<td>Unique identifier of a family, assigned by roll call</td>
</tr>
<tr>
<td>Family No</td>
<td>The number you enter as a family number in the people screen</td>
</tr>
<tr>
<td>Address 1</td>
<td></td>
</tr>
<tr>
<td>Address 2</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Zip</td>
<td></td>
</tr>
<tr>
<td>Family Email</td>
<td></td>
</tr>
<tr>
<td>Area Code 1</td>
<td>The area code portion of the home phone number</td>
</tr>
<tr>
<td>Phone 1</td>
<td></td>
</tr>
<tr>
<td>Area Code 2</td>
<td></td>
</tr>
<tr>
<td>Phone 2</td>
<td></td>
</tr>
<tr>
<td>Unlisted</td>
<td>Indicates if this phone number should NOT be included in directories</td>
</tr>
<tr>
<td>Alternate Address fields</td>
<td>The alternate address</td>
</tr>
<tr>
<td>Wedding Date</td>
<td></td>
</tr>
</tbody>
</table>

# People Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Special Notes or Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First, Last, Middle and Nick Names</td>
<td>The Mr., Mrs, Miss titles</td>
</tr>
<tr>
<td>Title</td>
<td></td>
</tr>
<tr>
<td>Gender</td>
<td></td>
</tr>
<tr>
<td>Date of Birth</td>
<td></td>
</tr>
<tr>
<td>Month of Date of Birth</td>
<td>The number indicating the month that the person was born</td>
</tr>
<tr>
<td>Age</td>
<td></td>
</tr>
<tr>
<td>Association</td>
<td>How is this person involved in your church</td>
</tr>
<tr>
<td>Email</td>
<td>Personal email address</td>
</tr>
<tr>
<td>Marital Status</td>
<td></td>
</tr>
<tr>
<td>Spouse Name</td>
<td></td>
</tr>
<tr>
<td>Work Phone</td>
<td></td>
</tr>
<tr>
<td>Cell Phone</td>
<td></td>
</tr>
<tr>
<td>Fax</td>
<td></td>
</tr>
<tr>
<td>Pager</td>
<td></td>
</tr>
<tr>
<td>Head of Family</td>
<td>Value is TRUE if this person is the head of the family</td>
</tr>
<tr>
<td>Person ID</td>
<td>The number roll call assigns as the unique identifier of this person</td>
</tr>
<tr>
<td>All the custom fields</td>
<td>If you assigned labels to the custom fields, you will see them listed. If no labels as assigned you'll see Custom Field 1 etc.</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Last Years Env No</td>
<td>The envelope number that was assigned to this person last year.</td>
</tr>
<tr>
<td>Current Env No</td>
<td>The envelope number for this year. You will see this number in the people screen.</td>
</tr>
<tr>
<td>Next Env No</td>
<td>To get ready for next year, you can assign “next env nos”. During the year end process, these numbers are moved around.</td>
</tr>
<tr>
<td>Attendance</td>
<td>The 52 byte field that indicates if a person attended worship during the corresponding week.</td>
</tr>
<tr>
<td>Badge No.</td>
<td>A number assigned to the badge used for Live check-in.</td>
</tr>
</tbody>
</table>

## Groups

<table>
<thead>
<tr>
<th>Field</th>
<th>Special Notes or Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campus</td>
<td>If you have the mult-campus feature turned on, this field will be used to indicate the campus for which this group is associated with.</td>
</tr>
<tr>
<td>Department</td>
<td>Which department is responsible for this group.</td>
</tr>
<tr>
<td>Type</td>
<td>What type of group is this</td>
</tr>
<tr>
<td>Section</td>
<td>The name of the group</td>
</tr>
<tr>
<td>Group Name</td>
<td>The combination of Department and Section</td>
</tr>
<tr>
<td>Inactive</td>
<td>Indicates if this group is currently active</td>
</tr>
<tr>
<td>Start Date</td>
<td>The beginning date of this group</td>
</tr>
<tr>
<td>End Date</td>
<td>The ending date of this group</td>
</tr>
<tr>
<td>Leader</td>
<td>Who is the primary leader of this group</td>
</tr>
<tr>
<td>Location</td>
<td>Where does this group meet</td>
</tr>
</tbody>
</table>

## Group Membership Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Special Notes or Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Name</td>
<td>Indicates what group this person is involved in.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of that group</td>
</tr>
<tr>
<td>Member name</td>
<td>The name of the member</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Special Notes or Description</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Person No</td>
<td>The identifier of the member</td>
</tr>
<tr>
<td>Inactive</td>
<td>Is this person currently active in this group</td>
</tr>
<tr>
<td>Inactive Date</td>
<td>The date the person became inactive</td>
</tr>
<tr>
<td>Leader</td>
<td>Is this person a leader in the group</td>
</tr>
<tr>
<td>Membership Custom Fields</td>
<td></td>
</tr>
</tbody>
</table>

**Donations Table**

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Special Notes or Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Person No</td>
<td>Identifies the person giving the donation</td>
</tr>
<tr>
<td>Total Amount</td>
<td>The total amount of the gift</td>
</tr>
<tr>
<td>Donation Date</td>
<td>The date of the gift</td>
</tr>
<tr>
<td>QPO Description</td>
<td>What was given in return</td>
</tr>
<tr>
<td>QPO Value</td>
<td>The value of the item given</td>
</tr>
<tr>
<td>Property Gift</td>
<td>Description of in kind gift</td>
</tr>
<tr>
<td>Property Value</td>
<td>The value of the in kind gift</td>
</tr>
<tr>
<td>Check No</td>
<td>If the donation was given by check, the check number</td>
</tr>
<tr>
<td>Check</td>
<td>If the donation was given by check, this is TRUE</td>
</tr>
<tr>
<td>Remark</td>
<td>Comments about the donation</td>
</tr>
</tbody>
</table>

**Designations Table**

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Special Notes or Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Donation No</td>
<td>Ties this to a specific donation</td>
</tr>
<tr>
<td>Designation</td>
<td>The fund that the gift is given to</td>
</tr>
<tr>
<td>Amount</td>
<td>The amount that should be applied to the specific fund</td>
</tr>
<tr>
<td>Pledge ID</td>
<td>Ties this amount to a specific pledge.</td>
</tr>
</tbody>
</table>

**Attendance Table**

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Special Notes or Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The person who attended a group meeting or a service</td>
</tr>
<tr>
<td>Attend Date</td>
<td>The attendance date</td>
</tr>
<tr>
<td>Meeting ID</td>
<td>Indicates which service or group they attended</td>
</tr>
<tr>
<td>Security Code</td>
<td>If a student was checked in via the child check in system and was assigned a security code, it is recorded here.</td>
</tr>
<tr>
<td>Notes</td>
<td>For child check in, any notes recorded.</td>
</tr>
<tr>
<td>Field</td>
<td>Special Notes or Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Head &amp; Spouse</td>
<td>Combines into one column the Head of the Families first name and the spouses first name.</td>
</tr>
<tr>
<td>Head &amp; Spouse Last Name</td>
<td>Combines into one column the Head of the Families first name, the spouses first name and the last name.</td>
</tr>
<tr>
<td>Title Head Last name</td>
<td>Combines into one column the title, plus the first name of the HOF and the last name of the HOF (head of family)</td>
</tr>
<tr>
<td>Title Last Name</td>
<td>Combines into one column, the title and last name of the head of family.</td>
</tr>
<tr>
<td>Children</td>
<td>Lists the names of the children in a family separated by commas.</td>
</tr>
<tr>
<td>Children + ages</td>
<td>Lists the children in a family with their ages behind the name.</td>
</tr>
<tr>
<td>Children + birthdates</td>
<td>Lists the children in a family with their birth dates behind their name.</td>
</tr>
<tr>
<td>Full Address</td>
<td>Combines into one column the address, city state and postal code.</td>
</tr>
<tr>
<td>Years Married</td>
<td>Calculates the number of years that a couple has been married.</td>
</tr>
<tr>
<td>Parents</td>
<td>Lists the parents name for a child.</td>
</tr>
<tr>
<td>Day of Birth</td>
<td>Lists the day of a person's birthday, for example the 15th.</td>
</tr>
<tr>
<td>Involvement</td>
<td>Will list the groups or classes that a person is a member of.</td>
</tr>
<tr>
<td>Times absent</td>
<td>The number of times in the user specified date range that a person was absent.</td>
</tr>
<tr>
<td>Times present</td>
<td>The number of times in the user specified date range that a person was present.</td>
</tr>
</tbody>
</table>
Index

A
Absent Present Report 204
Absent/Present Report 96
ACH Transaction. See also Recurring Contributions
Add next family member 42
Add records 21
Address Validation
   Smarty Streets 24
Add to family 42
Allergy Information 39
Anniversary
   report 72
Association 30, 243
Attendance
   change 85, 87
   find/modify 85, 87
   group 85
   record 83, 86
   reports 88
   service 82
Attendance by Group Report 205
Attendance by Person 90
Attendance by Session 95
Attendance by Session Report 207
Attendance by Type 94
Attendance Roster 208
Attendance Summary Report 202
Attendance tab in person record 41

B
Background Check
   report 77, 215
Background Check tab in person record
   clearance level 40
   enter information 39, 41, 50
   retrieve, find 52
Backup 301
   for networked system 303
   for single user system 301
   recover/restore 301, 305
Base Table 271
Batch 100
   post 109
   reports 110
Batch Detail Report 176
Batches
   reverse 120
Batch Summary Report 176
Birthday 30
   home page 17
   report 71
Blended family 268
Bulk Changes
   badge numbers 294
   barcodes 293
   envelope numbers 293
   general 292
   pictures 294

C
Calculated Columns 272
Canadian Receipts 141
Cash or Check 101
Chart of Accounts
   giving funds 99
Check In Log 212
Check In Roster 208
Check Reader 107
Church Address 22
Church Logo 18
Classes. See also Groups
Classic Directory 244
Clearance Level 40
Clone a Group 194
Comments tab in person record
   allergy 39
   confidential 39
   confidential comments 54
   custody information 39
   general 38
   special needs 39
Compare two sets 265
Concatenation 273
Concatentation 273
Confidential Comments
   enter 54
   find/research 55
Confirm Data Report 73
Connect to different data file 306
Contribution Detail Report 171
Contributions
   add to existing batch 119
   batches 100
   batch reports 110
   check/cash 101
   check reader 107
   connect to pledge 103
   correct 119, 121
   delete 123
   deposit slip 111
   enter new 101
find by batch 115
find by person 112
giving funds 99
import 108
in-kind 106
non-cash 105, 107
post a batch 109
property 105
QPQ, quid pro quo 104
Quickbooks or MYOB 110
reverse batch 120
split 103
transfer 121
Contribution Statements
annual 138
Canadian 141
e-mail 148
for a specific person 145
formats 130
individual gift 142
married, filing separately 150
personal receipt 145
quarterly 133
quarterly tabular 137
Contribution Statistics 173
Creating a dummy record 49
Current Selection 257
Custody Information 39
Custom
dates, people 35
fields, people 33, 34
group fields 190
group member fields 193
labels 279–282
reports 270
Custom Directory
cover 239
font 239
output 240
Customize
mailing labels 235
my reports 80
receipt text 134
search window 20, 57
statement text 134
Custom labels 279
Custom report 270–278
calculated columns 272
concatenation 273
creating 270
edit template 278
equations 273
format 275
hide details 276
NUM function 273
output presentations 277
page break 276
print 277
re-use the report 278
Roll Call functions 274
save as file 277
select columns 271
select data 271
sort 275
titles 275
D
Data file
backup 301
compact 306
location 296
open different 306
repair 307–308
Death in family 47
Delete
custom contributions 123
Delete Records 21
Deleting People
person with donations 49
person without donations 48
Deleting pledge 180
Deleting pledge fund 180
Deposit Slip 111
Designation. See also Giving Fund
Directories 238–254
Classic 244
Custom 238
Family Picture Directory 246
group 248–254, 250–254, 251–254
Lifetouch 251
Standard 241
Directory
group 218
picture 220
Divorce 46
Donation Receipts. See also Contribution Statements
Donation Type 101
non-cash 105
Donor Detail Report 151
Donor Giving Report 158
Donors Given X Times 165
Donors over X Amount 163
Donor Summary Report 154
by fund 157
Dummy record 49
Duplicate check 291–292
Duplicate Class Report 216
E
Edit list of values 291
Email
compose 230
contribution statements 148
html emails 230
log 231
my email 229
record address 30
send 230
settings 229
Envelope number 30
Envelopes
print 236
Equations 272
Export
custom 277
Exporting
Family export 289
Lifetouch 284
People 283

F
Family
deat in 47
divorce 46
marriage 43
new family member 42
Family number 30
Fathers, list of 268
Find by
criteria 56, 58
Find by Criteria 21
First Time Givers Report 174, 176
Functions 273, 274
Fund
giving 99
pledge 177
Fund Giving Report 169
Fund Summary Report 168

G
Given 0 Times 166
Given X Times 165
Giving Funds 99
Global Changes
group information 295
Graduation 198
Group Directory 248, 250, 251
picture 220
Group Picture Directory 220, 250
Group Reports
Absent/Present 204
Attendance by Group 205
Attendance by Session 207
Attendance Roster 209
Attendance Summary 202
Background Checks 213
Check-in Log 212
Check-in Roster 208
Duplicate Class Enrollment 216
Group Directory 218
Group Involvement 216
Group Members 213

Group Picture Directory 220
Sign-in Roster 211
Groups
clone/copy 194
creating new 191
custom fields 190
delete 200
directory 218
graduation 198
group reports 202–220
hierarchy 190
mass enroll 195
members 192
modify 200
preferences 194
sessions 193
transfer members 197
view from people 35
Groups tab in person record 35

H
Head of family 268
Head of Household
change 47
Home menu 17
birthdays 17
To do list 17
visitors 18

I
Icons 19, 56
Import
contributions 108
MYOB 110
people info 26
pictures 31
to Quickbooks 110
In Kind Gifts 106
Insert Data 228
Involvement 35

K
Keywords tab in person record 36

L
Labels
custom 279–282
format and size 281
mailing 234
modify template 282
print 282
re-use template 282
static text 281
Letters 225
add date/subject 227
insert data 228
Letters tab in person record 41
attendance by type 94
attendance summary 88
Background Check report 77
batch 110
Birthday report 71
columns 64
Confirm Data report 75
contribution 151
criteria 63
Envelope Numbers report 69
Family report 70
Group Reports 202
My Reports 80
output window 65
pledge 185
report selection window 62
run for 63
run, generate 65
Significant Dates report 73
special columns 312
Uninvolved Families report 76
view records 65
Visitation History 79
Visitation Log 78
visitor 98
Reverse Batch 120

S
Saved reports 80
Search
find by 56
people 56
Search Window 58
Security 296
Server
install 12
recover 305
repair 306
Service
worship 82
Sessions 193
Sets 256, 265
Shepherd area 30
Significant Dates 35
report 73
Sign in Roster 211
Single parents
find 268
Single user system
backup 301
connect to different data file 306
install 12
recover 301
Smarty Streets
address validation setup 24
Special Columns 312
Special Needs 39
Special queries 267
change selection to adult and all children 268
change selection to fathers 268
change selection to head 268
change selection to mothers 268
find families with pictures 269
find keywords 268
find people with picture 268
find possible blended families 268
find possible uninvolved families 269
find single parents 268
Spiritual Gifts 36
Standalone
backup 301
connect to a different data file 306
install 12
recover 301
Standard Directory 241
Summary Screens 20
customize 20
Sunday School Classes. See also Groups
T
Tables 255
layout 309
Tagged groups 225
Tag People
tag 61
untag 61
view 61
Talents 36
Tax Receipts. See also Contribution Statements
Templateedit a saved template 278
label 282
modify label template 282
report 278
re-use label template 282
Text
send text 232
To Do List 17
Top Donor Report 161
Transfer
donations 47
group members 197

U
Uninvolved families 269
Uninvolved Family Report 76
Unlisted phone 30
Untag People 61
Upgrade
from 10.0.17 or earlier 15
from 10.0.18 or later 13
User Security 296
Activate 296
create new user 297
locked user 300
preferences 297
security levels 298

V

Visitations
  find/research 53
  history 79
  log 78
  record visit 52
  view from people 36
Visitor
  report 98
Visits tab in person record 37
Visitor
  list on home page 18

W

Word Processor 225
Writing Letters 225